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OPR-O119-FA-05 Fall  

Data Acquisition & Processing Report 
Ernest Sound and Eastern Passage, AK 

 

A. INTRODUCTION 
 
This hydrographic project was completed as specified by Hydrographic Survey Letter 
Instructions OPR-O119-FA, signed January 4th, 2005.  This Data Acquisition and 
Processing Report applies to sheet E – H11507, sheet F – H11508, and sheet G – 
H11509.  All sheets have the general locality of Ernest Sound and Eastern Passage in the 
state of Alaska.  The additional H-numbers supplied by the Hydrographic Surveys 
Division for the fall project are included in project correspondence and with the letter 
instructions. 
 
In accordance with the System Certification memorandum dated February 14, 2005, 
FAIRWEATHER personnel conducted system certification procedures and produced the 
NOAA Ship FAIRWEATHER Hydrographic Systems Certification Report 2005 (SCR) 
submitted April 18, 2005.  The System Certification Recommendation memorandum, 
FA_SCR_2005_Rev1, was received on May 23, 2005 and is included in Appendix 1.  A 
System Certification Recommendation Approval memorandum from the Chief of 
Hydrographic Surveys Division Operations Branch, FA_SCR_Approval, was received on 
August 24, 2005 and is included in Appendix 1. 
 
The information contained within the SCR verifies that the hydrographic systems used 
for surveying meet or exceed requirements as defined in the NOS Hydrographic Surveys 
Specifications and Deliverables (NHSSD) dated March 2003.  The Data Acquisition and 
Processing Report (DAPR) describes the procedures used to acquire and process data.   
 
Survey specific details will be listed in Descriptive Reports as needed.  Unless otherwise 
noted, the acquisition and processing procedures used and deliverables produced are in 
accordance with the Standing Instructions (July 19th, 2005), the NHSSD, and the Field 
Procedures Manual v1.1 (March 2005).  Hydrographic Surveys Technical Directives 
2004-1 through 4 and 2005-1 were followed during the course of this project. 

B. EQUIPMENT 
 
Detailed descriptions of the equipment and systems used for bathymetric data acquisition, 
horizontal and vertical control operations, and shoreline acquisition are included in the 
NOAA Ship FAIRWEATHER Hydrographic Systems Certification Report 2005 (SCR) 
submitted under separate cover.  The SCR also contains the determination of correctors, 
dates and documentation of calibration and testing information.  The hardware and 
software used for data acquisition and processing are listed in the SCR. 
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I. Updates, Additions, and Deviations from the SCR 
 
a. System Tracking 
The updated system tracking documents, Survey Software which includes software 
versions and dates of installation; Personnel Inventory; and FA Hardware, are included 
in Appendix 1. 
 
b. Addendums to Vessel Reports 
 
The NOAA Ship FAIRWEATHER (S220) RESON 8111ER Vessel Report 2005 
submitted with the SCR did not contain the results of the Dynamic Draft Settlement and 
Squat (DDSSM) testing that was conducted on April 14, 2005.  The report, included in 
Appendix 1, is being resubmitted with the addition of Addendum 1 which lists and 
explains the DDSSM results. 
 
The NOAA Ship FAIRWEATHER (S220) configurations were upgraded since 
documentation was submitted in the SCR.  Junction boxes were added to the S220_8111 
and S220_8160 system setups, to allow for simultaneous acquisition and recording of 
data by both systems.  The addition of the junction boxes did not affect the latency values 
used in the HIPS Vessel File.  In addition, NEMA data was output from ISIS in order to 
facilitate the auto deploy feature in the Moving Vessel Profiler. These updates are 
depicted in the updated vessel diagram which is included in Appendix 1. 
 
On May 12th, after 1600 GMT, and August 6th, from 1726 through 2359 GMT, an error 
occurred with the dropdown transducer mount for Launch 1018 while acquiring data on 
surveys H11469 from OPR-O167-FA and H11474 from OPR-P183-FA respectively.  
Debris was trapped between the transducer arm and the stop.  This changed the Roll Bias, 
which remained steady, for the remainder of each day only.  Refer to the NOAA 
Hydrographic Survey Launch 1018 Vessel Report – 2005 Addendum 2 for further 
information. 
 
The transducer on Launch 1018 was sheered off the vessel.  The mount was 
reconstructed, the arm was outfitted with grease zirks.  Patch testing and a POS M/V 
GAMS Calibration was conducted once the new transducer was reinstalled, testing 
occurred on October 21, 2005 (DN 294) and October 26, 2005 (DN 299), values for this 
testing were entered under DN 293 to cover all data acquired with the new transducer. 
Refer to the NOAA Hydrographic Survey Launch 1018 Vessel Report – 2005 Addendum 
3 for further information. 
 
On August 27th (DN 239), an error occurred with the dropdown transducer mount for 
Launch 1010 while acquiring data on survey H11498 from OPR-OP158-FA.  Debris was 
trapped between the transducer arm and the stop.  This changed the Roll Bias, which 
remained steady, for the remainder of the day only.  Refer to the NOAA Hydrographic 
Survey Launch 1010 Vessel Report – 2005 Addendum 2 for further information. 
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The transducer on Launch 1010 was removed in order to strengthen welds on the mount.  
Additional patch testing was conducted once the transducer was reinstalled on October 
4th and 5th, 2005 (DNs 277 & 278). Refer to the NOAA Hydrographic Survey Launch 
1010 Vessel Report – 2005 Addendum 3 for further information. 
 
On October 24, 2005 (DN 297), during multibeam acquisition on project OPR-O119-FA-
05, survey H11507, the key way on the transducer arm, which connects the swing arm to 
the transducer mount, gave way.  This failure caused severe roll bias in the data, and 
resulted in the transducer not being able to be raised.  Manual examination of the data in 
CARIS subset mode allowed the exact time of the key way failure to be determined.  The 
data on DN 297 following the failure was rejected and recollected.  The key way was 
repaired on board the FAIRWEATHER.  Although Launch 1010 was patch tested on 
October 26, 2005 (DN 299), it was determined that no additional data would be collected 
until a permanent stable repair of the keyway was attained.  Refer to the NOAA 
Hydrographic Survey Launch 1010 Vessel Report – 2005 Addendum 4 for further 
information. 
 
c. Noise Analysis 
 
The FAIRWEATHER sonar systems RESON 8111ER underwent noise analysis testing 
on October 11, 2004.  The results are utilized during acquisition to enhance data quality 
and are included Appendix 1.  The Standard Operating Procedure for Survey Speeds to 
be run while acquiring data with the RESON 8111ER is included in Appendix 3. 
 
d. Moving Vessel Profiler (MVP) 
 
The MVP system consists of a winch, cable, fish (the towed unit with the sound velocity 
sensor), support assembly, and controlling hardware and software. During ship 
acquisition, the fish was deployed using the on-deck controller and towed with enough 
cable out to keep the fish 3-5 m below the water surface. A “messenger” (a short cable-
thickening sleeve) was set on the cable to allow the system to keep the appropriate 
amount of cable out and reset as needed when the ship acquisition speed was altered. 
 
During SVP acquisition, the controlling computer application, Brooke Ocean Technology 
MVP version 2.24, was used to control the MVP system and to acquire SVP data. MVP 
allows for three acquisition modes: 1) automatic continuous multiple cast freefall casting 
while at speed, 2) single cast freefall casting while at speed, and 3) single cast winch 
speed casting while stationary. The user limits the depth to which the fish will fall by 
setting 1) the depth-off-bottom and 2) the maximum depth.  Either single, individually 
initiated casts can be performed, at the discretion of the Hydrographer or auto deploy can 
be enabled and set with varying frequency (every 2 minutes for example) for deployment. 
 
e. Maintenance and Periodic Testing 
 
The maintenance and periodic testing that was conducted on the CTD equipment by the 
FAIRWEATHER personnel is documented in CTD_Maintenance and Periodic Testing 
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and included in Appendix 2.  Also included with the spreadsheet of maintenance and 
testing is a report conducted and written in October, outlining additional testing 
conducted between the Moving Vessel Profiler (MVP) 200 and the Seabird SBe19+.  
This testing was conducted to investigate whether the MVP was the source of the sound 
velocity error affecting various surveys with ship data throughout the season.  Although 
the results were not entirely conclusive, the casts generated by each instrument for three 
different cast sites were in good agreement and sound velocity error is not readily 
apparent in the MBES data. 
 
II. Data Acquisition 

 
a. Multibeam Echosounder Acquisition and Monitoring Procedures 
 
Methods of acquisition took into consideration system performance limitations, the 
bottom topography, water depth, and the ability of the vessel to safely navigate the area. 
 
All multibeam data were acquired in Triton Elic’s extended transfer format (XTF) and 
monitored in real-time using the 2-D and 3-D data display windows and the on-screen 
displays for the RESON SeaBat 8101ER, and 8111ER sonar processors. Adjustable 
parameters that were used to control the RESON from the ISIS software include range 
scale, power, gain, and pulse width. These parameters were adjusted as necessary to 
ensure best data quality.  Additionally, vessel speed was adjusted as necessary to ensure 
the required along-track coverage for object detection in accordance with the NOS 
Specifications and Deliverables and Standing Project Instructions.  The RESON 81XX 
SOP (standard operating procedure) and the TEI Real Time Bathy SOP detail the settings 
and procedures utilized during acquisition of data on the Reson systems  and in Isis 
aboard the FAIRWEATHER.  Both are included in Appendix 3. 
 
Mainscheme multibeam sounding lines using the RESON Seabat 8101ER and 8111ER 
were generally run parallel to the contours at a line spacing approximately three to four 
times the water depth.  For discrete item developments, line spacing was reduced to 2 
times water depth to ensure least-depth determination by multibeam near-nadir beams.  
Triton Elic’s DelphMap Real Time Bathy was utilized in lieu of planned line files.  The 
Real Time Bathy displayed the acquired multibeam swath during acquisition and was 
monitored to ensure overlap and full bottom coverage.  If coverage was not adequate, 
additional lines were run while still in the area. 
 
b. Shoreline Verification 
 
FAIRWEATHER personnel conducted field shoreline verification at times near predicted 
low water, in accordance with the Standing Project Instructions and the Field Procedures 
Manual v1.1 (March 2005), section 2.4.  Pertinent standard operating procedures such as 
Shoreline_Presurvey, Importing Shapefiles in Notebook, Trimble_Pathfinder_Setup, and 
Shoreline_Acquisition_SOP are included in Appendix 3.  
 
Mapinfo was used to consolidate and review shoreline sources.  Remote Sensing Division 
source shoreline (CFF) was opened and viewed by line and feature type in Mapinfo.  
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Charted shoreline, when needed for reference purposes or when source data were not 
available or adequate, was digitized into separate Mapinfo tables classified by S-57 
object type.  AWOIS and CEF investigation items were also opened in Mapinfo.  Boat 
sheets were produced and geo-referenced images (tif/tfw) were created for use in Trimble 
TerraSync during shoreline verification. 
 
Detached positions (DPs) and generic positions (GPs) acquired during shoreline 
verification indicate revisions to features, or features not found in the field.  They were 
recorded in the shoreline acquisition software TerraSync using a Trimble Backpack and 
on DP forms, and then processed through GPS Pathfinder.  Scanned copies of the DP 
forms are included in the digital Separates folder and hard copies are submitted with the 
Separates to be included with Survey Data.  In addition, annotations describing shoreline 
were recorded on hard copy plots of the digital shoreline, referred to as boat sheets which 
are also submitted with the individual survey as Separates. 
 
Terminology used during shoreline verification is as follows. The term “Noted” indicates 
that the feature is correctly located within the scale of the chart or source, as confirmed 
from a distance. The term “Verified” is used when the existence of the feature is 
confirmed in close proximity and the feature is correctly located within the scale of the 
survey. 
 
c. Bottom Sample Acquisition 
 
Bottom samples were conducted according to section 7.1 of the NOS Hydrographic 
Surveys Specifications and Deliverables (March, 2003). 
 
d. Horizontal Control 
 
A complete description of horizontal control for the project can be found in the OPR-
O119-FA-05 Fall Horizontal and Vertical Control Report (HVCR), submitted under 
separate cover. 
 
The horizontal datum for this project is the North American Datum of 1983 (NAD83).  
Differential GPS (DGPS) was the sole method of positioning.  Differential corrections 
from the U.S. Coast Guard beacon at Gustavus (288 kHz) and Level Island (295 kHz). 
 
System Checks were not performed during this project.  Based on correspondence 
between personnel from the Hydrographic Systems and Technology Program and 
FAIRWEATHER, system checks were deemed unnecessary at this time.  Refer to 
correspondence included in Appendix 1. 
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C. QUALITY CONTROL 
 
I. Data Processing 
 
The FAIRWEATHER has numerous standard operating procedures (SOPs) that are 
followed by personnel throughout the survey to ensure consistent high quality data and 
products.  A detailed data processing flowchart and several key SOPs, that differ from the 
Field Procedures Manual v1.1 (March 2005) and/or are specific only to the 
FAIRWEATHER, are included for reference in Appendix 3. 
 
a. Multibeam Echosounder Data Processing 
 
Raw XTF multibeam data were converted to HDCS format in Caris HIPS & SIPS 5.4.  
After conversion, TrueHeave™ was loaded prior to sound velocity correction in HIPS. 
Tide corrections, dynamic draft correctors, sensor lever arm information, bias 
information and timing errors, and attitude correctors were applied to the data during 
“Merge”.  Once lines are merged, the Total Propagated Error (TPE) was computed in 
HIPS to determine the quality of the multibeam data.   
 
The TPE takes into account uncertainties in the measurements coming from each sensor 
(Heave, Pitch, Roll, Position, Heading, Sound Velocity, and Tide) and uncertainties in 
static measurements (Draft and Latency) to calculate the total uncertainty associated with 
each sounding.  Caris HIPS & SIPS 5.4 uses the vertical uncertainty from TPE to produce 
a Bathymetry Associated with Statistical Error (BASE) surface.  These BASE surfaces 
and child layers (Depth,Uncertainty, Density, Standard Deviation, Mean, Shoal, Deep) 
were used for directed data editing, to demonstrate coverage, and to check for systematic 
errors such as tide, sound velocity, or attitude and timing errors.   
 
Vessel heading, attitude, and navigation data were only reviewed and/or edited in 
navigation editor and attitude editor as deemed necessary by the Hydrographer.  When 
necessary, fliers or gaps in heading, attitude, or navigation data were manually rejected or 
interpolated for small periods of time.  The data were reviewed and edited in swath editor 
as needed.  All multibeam data were edited and reviewed in HIPS subset mode.   
 
The BASE surfaces, produced as deliverables, have resolutions and depth ranges that are 
at or below 8 percent of the depth.  Overlap is adjusted as necessary for the survey 
topography.  A table listing the resolution and depth ranges used will be provided in the 
descriptive reports for each survey.  Correspondence outlining the FAIRWEATHER use 
of the above BASE surface resolution guidelines is included in Appendix 1. 
 
In areas of navigational significance where the BASE surface did not depict the desired 
depth for the given area, a designated sounding was selected.  Designated soundings 
were selected based on the difference between the BASE surface and reliable shoaler 
sounding(s) being  more than half to two thirds of the allowable IHO error budget in 
depths less than 20m. 
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1. Data Standards and Processing Guidelines 
 
Bathymetry processing followed section 4.2 of the Field Procedures Manual v1.1 
(March 2005) unless otherwise noted.  BASE surface processing was in accordance 
with Hydrographic Surveys Technical Directive 2004-3. 
 
Initial processing (conversion, tide application, sound velocity correction, merge and 
compute TPE ) of the data was conducted in CARIS 6.0.  This was to facilitate the 
testing of CARIS 6.0 for major issues in those processes prior to the end of the 2005 
field season.  All other processing of was conducted in CARIS 5.4 unless otherwise 
noted in the Descriptive Report of specific surveys. 
 
The bathymetric data acquired during this project has been examined and it meets or 
exceeds the specifications defined in the NOS Hydrographic Surveys Specifications 
and Deliverables (NHSSD), dated March 2003. In accordance with the NHSSD the 
vertical accuracy standards are S-44 IHO Order 1 for water 100 meters or less in 
depth and IHO Order 2 for depths greater than 100 meters.  Data quality issues, 
specific to individual surveys, are noted in the descriptive reports.   

 
2. System Certification Report Clarifications 

 
Hips Vessel File: 
 
The HVFs for each vessel used for this project and the Devicemodel.xml utilized 
during data processing in CARIS HIPS are located in the Separates to be included 
with this report.   
 
Initial entry dates in each vessel HVF do not correspond with the dates noted in each 
vessel report.  The dates entered precede the dates of the patch tests to accommodate 
other testing and preliminary data collected.  As no project data was collected before 
the initial patch tests by any of the FAIRWEATHER’s vessels data quality is not 
affected.   
 
The sensor latency value noted in the vessel reports can either be entered into each 
sensor (Navigation, Gyro, Heave, Pitch and Roll) Time Error field or the inverse 
value can be entered once into the Swath Time Error field.  The Swath Time Error 
value for all vessels is entered as the inverse value of the Navigation Time Error 
reported in the vessel reports.  See correspondence between the Pacific Hydrographic 
Branch and FAIRWEATHER (PHB and FA Correspondence) included in Appendix 
1. 
 
Error estimates (TPE values) were entered into the HVF file for each vessel.  In the 
HVFs for 1010_8101, 1018_8101 and S220_8111, the “MRU Align StdDev Gyro” 
and “MRU Align StdDev Roll/Pitch” values were unknown, and these fields were 
initially defined as 0.000. The meaning of the values and how to calculate them were 
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unknown at the time of testing and, moreover, undocumented in Caris’ Vessel Editor 
Help Manual. 
 
The question of the meaning of these values was posed to Dr. Brian Calder from 
UNH, who was aboard the FAIRWEATHER. Dr. Calder is the creator of the total 
propagated error concept which was implemented by CARIS.  He explained that 
these error values are defined as the standard deviation of the error estimates for the 
“gyro” and “roll/ pitch” patch test values, as calculated from the compilation of these 
values from all of the individuals evaluating the patch test data.  These standard 
deviations were documented when processing the patch tests used for this project.  
Documentation and reporting of the standard deviation of the error estimates for the 
“gyro” and “roll/ pitch” patch test values were included in the HVFs for launches 
1010_8101 and 1018_8101.   The ship system S220_8101 was not re-patched prior to 
this project and therefore standard deviations were not available.  See correspondence 
between the Pacific Hydrographic Branch and FAIRWEATHER (PHB and FA 
Correspondence) included in Appendix 1. 

 
Dropdown Transducer Securing Mechanism: 
 
In the SCR problems with the transducer securing mechanism were noted.  It was 
stated in the SCR that a permanent solution would be installed during the April 29th 
through May 2nd import in Ketchikan.  This was not done since the short term 
solutions which stabilized the mount proved to be adequate. 

 
b. Shoreline Data Processing 
 
During shoreline verification, detached (DP) and generic (GP) positions were acquired 
with TerraSync 2.4.1. Data were reviewed, edited and exported as ESRI shape files(shp) 
in GPS Pathfinder 3.00.  The exported shape files include the S-57 field attributed 
positions and are organized by object type. 
 
Pydro and CARIS Notebook 2.2 are used exclusively in the shoreline processing pipeline 
from the field to the processing branch. 
 
The source shoreline shape files were imported into CARIS Notebook 2.2 into the .hob 
file format and called H#####_Edited_CFF_Shoreline.hob using the Object Import 
Utility (OIU).  The charted shoreline Mapinfo tables produced for shoreline verification, 
were imported into Notebook using the OIU and attributed according to S-57 into the 
H#####_Charted_Shoreline.hob file.  These files are annotated with Hydrographer 
remarks and submitted with the field products as deliverables.  An unedited 
O119_CFF_Shoreline.hob file is also included with the Separates to be included with this 
report for reference purposes. 
 
Positions acquired during shoreline verification operations are in shape file format from 
GPS Pathfinder.  The Generic GPs/DPs Import tool in Pydro is utilized to retain the S-57 
attribution during import into Pydro.  The DPs and GPs indicate revisions to features, or 
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features not found during shoreline verification.  Once the features are in Pydro, short 
descriptive comments along with investigation or survey methods are listed under the 
Remarks tab in Pydro.  Features are flagged as Primary, unless there are multiple 
detached (DPs) or generic (GPs) positions taken on the same feature.  In that case, the 
most important DP is marked Primary and the associated DPs/GPs were flagged 
Secondary.  A Carto Action of Add, Modify, Delete, or None is assigned to each item in 
Pydro, and all features are S57 attributed.  Items for particular surveys, that were 
associated with a DP or GP that needed further discussion, are flagged Report in Pydro.  
Along with the investigation methods provided in the Remarks tab, the hydrographer 
included recommendations to the cartographer in the Recommendations tab when 
warranted. All features were flagged according to Pydro Processing Flow Diagram 
section 4.4.2.4 of the Preliminary Field Procedures Manual dated March 2005.   
 
Photos labeled and associated with a DP/GP number are included in the Pydro PSS 
session and stored in with the PSS.  Photos not associated with a DP/GP are given a 
descriptive label, are included in the PICREP S-57 attribution column of the associated 
feature, and stored with the Field Product Notebook files. 
 
The HDCS_DATA lines associated with DPs require further processing in CARIS HIPS 
& SIPS to correct for tide and sound velocity when necessary.  GPs do not have heights 
associated with them and require no additional processing. 
  
All primary and accepted DPs and GPs are imported from Pydro as an .xml to CARIS 
Notebook 2.2.  Three separate stand alone .hob files are based on the Carto Action 
assigned in Pydro.  The separated files are named H#####_Add_Pydro.hob, 
H#####_Modify_Pydro.hob, H#####_Delete_Pydro.hob and H#####_None_Pydro.hob.  
UserID, remarks and recommendations from Pydro are imported to the userID”, “remrks” 
and “recomd” fields associated with each feature in CARIS Notebook.  
 
New HW/MLLW features and any changes to the source shoreline, such as ledges or 
reefs, were digitized with S57 attribution to the H#####_Add_Ntbk.hob or 
H#####_Modify_Ntbk.hob files.  Any comments or annotations made on the boat sheets 
from observations made in the field, including field notes made by the Hydrographer 
regarding verification of features, were added directly to the “remrks” field of the feature 
in the .hob file.  Marker text is used to add comments to features when necessary for 
display purposes, such as when the “remrks” field does not display correctly or to 
highlight an item that was not verified.  Source items from the Cartographic Feature File 
(CFF) or charted items that were disproved have been moved to the 
H#####_Delete_Ntbk.hob.  Due to CARIS Notebook 2.2 limitations, the similar tables 
(ie H#####_Add_Pydro.hob and H#####_Add_Ntbk.hob) cannot be combined in the 
field.  The H#####_Edited_CFF_Shoreline.hob and H#####_Charted_Shoreline.hob files 
only contain features with no modifications and include Hydrographer remarks.   
 
The CARIS Notebook session along with CARIS HIPS BASE surface(s) were viewed to 
compare soundings and features simultaneously.  For detailed descriptions of procedures, 
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see the standard operating procedures included in Appendix 3, Pydro Shoreline 
Processing, CartoAction Flagging, and Notebook Shoreline Processing. 
 
b. Reference Surface 
 
Due to mechanical issues and time constraints a reference surface was not completed in 
the OPR-O119-FA-05 Fall project area.  Initial lines were run by the NOAA Ship 
FAIRWEATHER (S220) RESON 8111ER, lines were unable to be completed by NOAA 
Hydrographic Survey Launch 1010 or NOAA Hydrographic Survey Launch 1018. 
  
II. Data Review 
 
Specific procedures were used on the FAIRWEATHER to ensure quality control of data 
throughout acquisition, processing, and submission.  These procedures are outlined in the 
FA QC Checksheets, FA_Data_Query, and the Survey Management SOP located in 
Appendix 3.  As detailed in FA QC Checksheets, the QC Check is preformed by the 
survey manager.  The QC Review is conducted by qualified survey personnel other than 
the survey manager, as an outside review of the survey data and deliverables.  The Data 
Submission and Analog Submission checklists are used to ensure that all data and 
deliverables are complete and included upon submission.  These documents are 
completed for every survey but are not submitted with the data. 
 

D. CORRECTIONS TO ECHO SOUNDINGS 
 
I. POS/MV Correctors  
 
a. Position Computation 
 
On all FAIRWEATHER vessels the POS/MV is used for positioning multibeam data.  
The POS/MV controller software was used to monitor position accuracy and quality 
during data acquisition.  This ensured that positioning accuracy requirements were met, 
as outlined in the NOS Hydrographic Surveys Specifications and Deliverables.  The 
POS/MV controller software provides clear visual indications whenever accuracy 
thresholds are exceeded.   
 
The CSI Wireless MBX-3S DGPS Receivers are used in conjunction with TSS POS/MV 
to provide vessel positioning during data acquisition.  The DGPS receivers are configured 
in manual mode to allow reception of only one U.S. Coast Guard (USCG) differential 
GPS beacon station.  
 
b. Heading Computation 
 
On all vessels, the heading computed by the POS/MV, was used as a corrector for 
multibeam data.  
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c. Pitch and Roll Computation 
 
On all vessels, the POS/MV was used for pitch and roll values.  
 
d. Heave Computation 
 
The POS/MV’s on FAIRWEATHER and her launches are equipped with the 
TrueHeave™ option.  Stored TrueHeave™ data contains time stamps with attitude, 
position, acceleration, and rotation information.  TrueHeave™ data were acquired in 
accordance with section 6.0 of the POS/MV Version 3 Installation and Operation 
Manual, dated October 2003. These data were loaded, in CARIS HIPS & SIPS  
5.4, into the simultaneously collected multibeam data to determine the vessel heave 
correctors. 
 
In cases where TrueHeave™ could not be applied, real time heave correctors were used.  
Real time heave data were recorded in Triton Elic’s Isis software, stored in the .XTF 
format and applied as the heave corrector for multibeam data.  
 
Data, that does not have TrueHeave™ applied, will be listed in the individual Descriptive 
Report for the survey.  
 
II. Sound Velocity 
 
Within CARIS HIPS there are four different algorithms used to automatically apply 
sound velocity information to a profile using information stored in the concatenated 
sound velocity file.  They are: Previous in time, Nearest in time, Nearest in distance and 
Nearest in distance within time.  The method used for applying sound velocity 
information to a line is included in the processing logs that are submitted with the data. 
 
a. SBE 19plus SEACAT Profiler 
 
Sound Velocity Profile (SVP) casts from the SBE 19plus were processed with Velocwin 
and the correctors were applied to echosounder data in CARIS HIPS during post 
processing. 
 
b. Moving Vessel Profiler (MVP) 
 
Sound velocity correction data were acquired using the Brooke Ocean Technology 
Moving Vessel Profiler 200 (MVP) sound velocity profile (SVP) acquisition system and 
subsequently converted to .svp format using Velocwin for application to multibeam data 
in CARIS HIPS during post processing. 
 
MVP records cast data into files of type .001, .001c, .001d, and .001e (collectively called 
BOT files) where the number increments by one with each subsequent cast. The .001c 
file for each cast was opened with Velocwin and converted into CARIS .svp file format.  
The individually taken casts were compiled into a daily .svp file which were in turn 
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concatenated to the ship .svp file for the project and applied to multibeam data in CARIS 
HIPS during data processing.  No individual .svp files exist for each cast taken by the 
MVP due to the large number of casts acquired.   
 
III. Water Level 
 
Predicted and unverified observed water level correctors were downloaded from the CO-
OPS website when internet was available.  When internet was unavailable, the ship 
enabled the automated Tidebot program, which would send daily observed water level 
correctors for selected tide stations to the ship via email.  The daily water level correctors 
arrived in .dat file format.  The files for the relevant days were collated into a tide station 
master file which was converted to .tid file format in Mapinfo using HydroMI.  The .tid 
files were applied to data along with the zone definition file (.zdf) in CARIS HIPS & 
SIPS.   The Pacific Hydrographic Branch will apply final approved (smooth) tides to the 
survey data during final processing. 
 
The vertical datum for this project is Mean Lower-Low Water (MLLW).  The operating 
National Water Level Observation Network (NWLON) primary tide station at Ketchikan, 
AK (945-0460) served as control for datum determination and as the primary source for 
water level reducers for this project. 
  
FAIRWEATHER personnel installed one Sutron 8210 “bubbler” tide gauges at the 
tertiary station listed below.  Gauge #12 (S/N 023512) was the gauge used. The gauge 
was installed in order to provide information to Center for Operational Oceanographic 
Products and Services (CO-OPS N/OPS1) for the determination of time and height 
correctors, in accordance with the Project Instructions.   
 

Station Name Station Number Type of Gauge Date of Installation Date of Removal 

Bradfield Canal, AK 945-1012 Tertiary 30 Day October 8, 2005 November 7, 2005 
 
CO-OPS does not provide calibration or quality assurance documentation to the 
FAIRWEATHER.  FAIRWEATHER personnel are responsible for installation and 
removal of the water level gauges.  Although not required in the Letter Instructions, CO-
OPS delivered final approved vertical correctors to the FAIRWEATHER for application 
to the hydrographic data set on December 22, 2005.  See the Descriptive Report of 
specific surveys for tide application details.  It will not be necessary for the Pacific 
Hydrographic Branch to apply the verified water level data (smooth tides) to the survey 
data during final processing for the fall surveys for project OPR-O119-FA-05 - H11507, 
H11508, and H11509.  
 
A complete description of vertical control for the project can be found in the OPR-O119-
FA-05 Fall Horizontal and Vertical Control Report (HVCR), submitted under separate 
cover. 
 



Software Systems
Acquisition Processing Miscellaneous

ISIS Sonar v6.9 CARIS HIPS & SIPS v5.4 Microsoft Office

Delph Map v2.13 CARIS HIPS & SIPS v6.0 Adobe Acrobat

Delph Nav CARIS Notebook v2.2 Dreamweaver

BathyPro v1.9 CARIS EASY-ENC Corel Word Perfect Office 2002

Applanix POS/MV CARIS GIS v4.4a iPAQ Navigation System

Controller 2.1 PYDRO v5.9.1 Internet Explorer



Caris License # On GIS HIPS Notebook Expires Type
CW9604043 FADC2 5 5 5 10/31/05 Red USB
CW9604041 roving 1 1 12/31/05 Purple USB
CW9604403 roving 1 1 Purple USB
CW9604042 roving 1 12/31/05 Purple USB
CW9603454 1 1 White Serial
CW9603120 1 1 White Serial
CW9604366 FADC2 7 7 5 10/31/06 Red USB

         

ISIS Dongle # On Processor Isis DelphMap DelphNav BathyPro RT Bathy 81XX Server Mission Monitor
TEI 03-1525 1010_ACQ 1 1
TEI 03-15250 1010_ACQ 1 1 1 1 1 1
TEI 03-1526 220_ACQ 1 1
TEI 03-15260 220_ACQ 1 1 1 1 1
TEI 03-1527 1018_ACQ 1 1
TEI 03-15270 1018_ACQ 1 1 1 1 1

Processor Expires
FA_Process_1 01/31/06
FA_Process_2 01/31/06
FA_Process_3 01/31/06
FA_Process_4 01/31/06
FA_Process_5 01/31/06
FA_Process_6 01/31/06
FA_Process_7 01/31/06
FA_Process_8 01/31/06
FA_Process_8B 01/31/06
FA_Process_9 01/31/06
FA_Process_10 01/31/06
FA_CST 01/31/06
FA_FOO 01/31/06

00-01-02-69-5A-45

00-0B-DB-56-68-2B
00-01-02-69-56-43
00-11-11-06-A1-B5

00-0A-5E-42-0B-34

LICENSES

00-0B-DB-5A-62-2B
00-11-11-0F-84-44
00-11-11-06-9D-42

Comments
returned 10/31/05
corrupt:returned 10/31/05

returned 10/31/05
returned 10/31/05

00-11-11-06-A4-68

04730c79142d3c99d4
17ff4798ab42d6b8e8

ddbd88e5e31a2eb007
ddfeb19d320a9b8aa7
17ff4798a69248559b

00-0B-DB-C5-F5-ED ddfeb19d3ec82f7b90

Physical # Pydro License #

00-0B-DB-56-68-8C

ddbd88e5e2add37c62
17ff4798a45f2e18e0
17ff4798a43184cb81
04730c79144aa2e73d

ddbd88e5e2a5818feb

00-0B-DB-56-68-30
00-0B-DB-5A-D1-21

ddbd88e5e8d45ef885

new key inst. 10/31/05

58cd056e835465e329

replaces CW9604041



Fledermaus FLEXid License #
9-45953CB6 2518891E2E69
9-65012FEB B18BA0DE2D3F
9-6153BBA5 21DE819F1F03

Processor MapInfo v7.5
FA_Process_3 MUIWEU0750026833
FA_Process_7 MIUWEU0750026834
FA_CST MIUWEU0750025574
FA_FOO
FA_Process_8
FA_Process_6
FA_Process_2

MapBasic v8.0
MBUWEU0800012230

Comments

Comments
Key was destroyed
local

Processor
FA_Process_8 
FA_Process_3

MIUWEU0800038723
MIUWEU0800038722

MapInfo v8.0 & U
MIUWEU0800038720

GPS Pathfinder S/N

network

MIUWEU0800038725

   7.8 Upgrade
MIUWEU0780026833

MIUWEU0780034111

FADC1

MIUWEU0800038724

FA_Process_8 back in service 10/27/05, 8b taken out

FA_Process_7 added & configured 5/6/05
Processors

FA_Process_10 added & configured 8/28/05

MIUWEU0800038721
MIUWEU0800038726

MIUWEU0780026834

FA_Process_8b configured 10/12/05, temp replacement

MIUWEU0750025574

FA_Process_8 down for maint. 10/8/05-10/27/05
FA_Process_5 added & configured 10/11/05

498295-00110-05068-EBD4EA8B

011746-00300-04309-3BAD03D2
024156-00300-05068-0E94DA58

TerraSync Pro S/N
498295-00110-04309-7073A4A7



1010_ACQ 1018_ACQ 220_ACQ FA_Process_4 FA_Process_5
v.6.5.0 d.u d.u d.u d.u
v6.5.1 d.u d.u d.u d.u
v6.6.0 d.u d.u d.u d.u
v6.7.0 10/01/04 10/01/04 09/20/04 10/01/04

v6.7.193.0
v6.8 02/10/05 02/28/05 02/14/05 N/A
v6.9 09/10/05 09/10/05 08/05/05 N/A 10/07/05
v7.0 01/11/06 N/A

d.u.=date unknown; exact intall date not documented

ISIS SONAR
Comments

ISIS removed 2/14/05

FA_Process_4 No longer back-up computer



1010_NAV 1018_NAV 220_NAV FA_Process_5
v2.10 d.u d.u d.u
v2.11 d.u d.u 09/20/04

v2.00.193.0
1010_ACQ 1018_ACQ 220_ACQ

v2.12 02/10/05 02/28/05 02/14/05
v2.13 09/10/05 09/10/05 08/05/05 10/07/05

d.u.=date unknown; exact intall date not documented

Comments
ISIS DELPHNAV-DELPHMAP



ToughBook1 ToughTab1 TSCe FA-Mobile1 ToughBook2 Comments
v2.40 d.u d.u d.u
v2.41 10/5/2004 10/5/2004 10/5/2004 10/6/2004 10/13/2004
d.u.=date unknown; exact intall date not documented

TerraSync



ToughBook1 ToughTab1 FA-Mobile1 ToughBook2 Olab Process1 Comments
v3.00 9/30/2004 10/4/2004 d.u 10/13/2004 d.u. 3/22/2005
d.u.=date unknown; exact intall date not documented

Pathfinder



FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_5 FA_Process_6 FA_Process_7 FA_Process_8 FA_Process_8b FA_Process_9 FA_Process_10 FA_CST FA_FOO Comments
v5.4 full 05/05/04 08/02/04 08/02/04 08/02/04 10/11/05 09/11/04 05/06/05 08/02/04 10/12/05 08/02/04 08/28/05 08/04/04 08/11/04
v5.4 HF1 06/14/04
v5.4 HF2 06/14/04
v5.4 HF3 06/14/04
v5.4 HF4 06/14/04
v5.4 HF5 06/14/04
v5.4 HF6 06/14/04
v5.4 HF7 06/14/04
v5.4 HF8 06/14/04
v5.4 HF9 06/14/04
v5.4 HF10 06/14/04
v5.4 HF11 06/14/04
v5.4 HF12 06/14/04
v5.4 HF13 06/17/04
v5.4 HF14 06/18/04
v5.4 HF15
v5.4 SP1 07/27/04 08/02/04 08/03/04 08/02/04 10/11/05 09/11/04 05/06/05 08/02/04 10/12/05 08/02/04 08/28/05 08/04/04 08/26/04
v5.4 SP1+HF1 07/27/04 08/02/04 08/03/04 08/02/04 10/11/05 09/11/04 05/06/05 08/02/04 10/12/05 08/02/04 08/28/05 08/04/04 08/26/04
v5.4 SP1+HF2 08/03/04 08/02/04 08/03/04 08/02/04 10/11/05 09/11/04 05/06/05 08/02/04 10/12/05 08/02/04 08/28/05 08/04/04 08/26/04
v5.4 SP1+HF3 08/04/04 08/04/04 08/05/04 08/04/04 10/11/05 09/11/04 05/06/05 08/04/04 10/12/05 08/06/04 08/28/05 08/04/04 08/26/04
v5.4 SP1+HF4 08/26/04 08/26/04 08/26/04 08/26/04 10/11/05 09/11/04 05/06/05 08/26/04 10/12/05 08/26/04 08/28/05 08/26/04 08/26/04
v5.4 SP1+HF5 08/26/04 08/26/04 08/26/04 08/26/04 10/11/05 09/11/04 05/06/05 08/26/04 10/12/05 08/26/04 08/28/05 08/26/04 08/26/04
v5.4 SP1+HF6 08/26/04 08/26/04 08/26/04 08/26/04 10/11/05 09/11/04 05/06/05 08/26/04 10/12/05 08/26/04 08/28/05 08/26/04 08/26/04
v5.4 SP1+HF7 08/26/04 08/26/04 08/26/04 08/26/04 10/11/05 09/11/04 05/06/05 08/26/04 10/12/05 08/26/04 08/28/05 08/26/04 08/26/04
v5.4 SP1+HF8 10/06/04 10/07/04 09/26/04 10/08/04 10/11/05 09/23/04 05/06/05 09/22/04 10/12/05 09/23/04 08/28/05 10/07/04 10/07/04
v5.4 SP1+HF9 10/06/04 10/07/04 09/26/04 10/08/04 10/11/05 09/23/04 05/06/05 09/22/04 10/12/05 09/23/04 08/28/05 10/07/04 10/07/04
v5.4 SP1+HF10 10/06/04 10/07/04 10/07/04 10/08/04 10/11/05 10/07/04 05/06/05 10/05/04 10/12/05 10/07/04 08/28/05 10/07/04 10/07/04
v5.4 SP1+HF11 10/06/04 10/07/04 10/07/04 10/08/04 10/11/05 10/07/04 05/06/05 10/05/04 10/12/05 10/07/04 08/28/05 10/07/04 10/07/04
v5.4 SP1+HF12 10/06/04 10/07/04 10/07/04 10/08/04 10/11/05 10/07/04 05/06/05 10/05/04 10/12/05 10/07/04 08/28/05 10/07/04 10/07/04
v5.4 SP1+HF14 11/05/04 11/05/04 11/04/04 11/06/04 10/11/05 11/06/04 05/06/05 11/06/04 10/12/05 11/06/04 08/28/05 11/06/04 11/06/04
v5.4 SP1+HF15 01/10/05 01/10/05 01/13/05 01/12/04 10/11/05 01/12/04 05/06/05 01/04/05 10/12/05 01/06/05 08/28/05 01/14/05 01/12/05
v5.4 SP1+HF16 01/10/05 01/10/05 01/13/05 01/12/04 10/11/05 01/12/04 05/06/05 01/04/05 10/12/05 01/06/05 08/28/05 01/14/05 01/12/05
v5.4 SP1+HF17 01/10/05 01/10/05 01/13/05 01/12/04 10/11/05 01/12/04 05/06/05 01/04/05 10/12/05 01/06/05 08/28/05 01/14/05 01/12/05
v5.4 SP1+HF18 01/10/05 01/10/05 01/13/05 01/12/04 10/11/05 01/12/04 05/06/05 01/04/05 10/12/05 01/06/05 08/28/05 01/14/05 01/12/05
v5.4 SP1+HF19 01/10/05 01/10/05 01/13/05 01/12/04 10/11/05 01/12/04 05/06/05 01/04/05 10/12/05 01/06/05 08/28/05 01/14/05 01/12/05
v5.4 SP1+HF20 01/10/05 01/10/05 01/13/05 01/12/04 10/11/05 01/12/04 05/06/05 01/04/05 10/12/05 01/06/05 08/28/05 01/14/05 01/12/05
v5.4 SP1+HF21 01/16/05 01/16/05 01/16/05 01/16/05 10/11/05 01/16/05 05/06/05 01/16/05 10/12/05 01/16/05 08/28/05 01/16/05 01/16/05
v5.4 SP1+HF22 03/16/05 02/14/05 02/15/05 02/14/05 10/11/05 02/15/05 05/06/05 02/11/05 10/12/05 02/14/05 08/28/05 02/14/05 02/15/05
v5.4 SP1+HF23 03/16/05 03/12/05 03/16/05 03/16/05 10/11/05 03/23/05 05/06/05 03/12/05 10/12/05 03/12/05 08/28/05 03/29/05 03/29/05
v5.4 SP1+HF24 05/24/05 05/18/05 04/25/05 04/25/05 10/11/05 05/24/05 05/06/05 05/23/05 10/12/05 05/23/05 08/28/05 05/24/05 05/24/05
v5.4 SP1+HF25 05/24/05 05/18/05 05/06/05 05/24/05 10/11/05 05/24/05 05/06/05 05/23/05 10/12/05 05/23/05 08/28/05 05/24/05 05/24/05
v5.4 SP1+HF26 05/24/05 05/18/05 05/06/05 05/24/05 10/11/05 05/24/05 05/06/05 05/23/05 10/12/05 05/23/05 08/28/05 05/24/05 05/24/05

v5.4 SP1+HF27 06/29/05 10/12/05
causes 
problems, 
don't install

v5.4 SP1+HF28 09/02/05 09/02/05 09/02/05 09/02/05 10/11/05 09/02/05 09/02/05 08/10/05 10/12/05 08/02/05 08/28/05 09/06/05 09/06/05
v5.4 SP1+HF29 10/11/05 10/06/05 10/12/05

FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_5 FA_Process_6 FA_Process_7 FA_Process_8 FA_Process_8b FA_Process_9 FA_Process_10 FA_CST FA_FOO FA_Mobile1 Comments
v6.0 full 10/04/05 10/04/05 1/17/2006
v6.0 HF1 10/04/05 10/04/05
v6.0 HF2 10/04/05 10/04/05
v6.0 SP1 12/14/05 01/17/06
SP1 HF1 12/14/05 01/17/06
SP1 HF2 12/14/05 01/17/06
SP1 HF3 12/14/05 01/17/06
SP1 HF4 12/14/05 01/17/06
SP1 HF5 01/11/06 01/17/06
SP1 HF6 01/11/06 01/17/06
SP1 HF7 01/17/06 01/17/06

CARIS HIPS & SIPS v6.0

CARIS HIPS & SIPS v5.4



LUv2.1.0 CPCR v2.0 EasyENCv3.0 ConvUtilityv2.0.0.2 Comments
FA_Process_1 05/05/04 06/14/04 11/05/04 2/9/2005

FA_Process_2 08/02/04 08/02/04 10/07/04 2/14/2005

FA_Process_3 05/05/04 08/02/04 10/07/04 2/9/2005

FA_Process_4 08/02/04 08/02/04 10/08/04 2/9/2005

FA_Process_5 10/11/05 10/11/05 10/11/05 10/11/05

FA_Process_6 09/11/04 09/11/04 09/23/04 2/10/2005

FA_Process_7 05/06/05 05/06/05 05/06/05 05/06/05

FA_Process_8 08/02/04 08/02/04 10/08/04 2/9/2005

FA_Process_8b 10/12/05 10/12/05 10/12/05 10/12/05

FA_Process_9 08/02/04 08/02/04 09/23/04 2/9/2005

FA_Process_10 08/28/05 08/28/05 08/28/05 08/28/05

FA_CST 08/04/04 08/04/04 10/07/04 2/14/2005

FA_FOO 08/13/04 08/11/04 10/07/04 2/15/2005

CARIS Utililties



FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_5 FA_Process_6 FA_Process_7 FA_Process_8 FA_Process_8b FA_Process_9 FA_Process_10 FA_CST FA_FOO Comments
v4.4a 05/05/04 08/02/04 05/05/04 08/02/04 10/11/05 09/11/04 05/06/05 08/02/04 10/12/05 08/02/04 08/28/05 08/04/04 08/13/04

SP4 05/05/04 08/02/04 05/05/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF1 06/14/04 08/02/04 05/05/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF2 06/14/04 08/02/04 05/05/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF3 06/14/04 08/02/04 05/05/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF4 06/17/04 08/02/04 05/05/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF5 06/17/04 08/02/04 08/03/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF6 08/03/04 08/02/04 08/03/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF7 08/03/04 08/02/04 08/03/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF8 08/03/04 08/02/04 08/03/04 08/02/04 09/11/04 05/06/05 08/02/04 08/02/04 08/04/04 08/13/04

SP4+HF9 08/26/04 08/26/04 08/26/04 08/26/04 09/11/04 05/06/05 08/26/04 08/26/04 08/26/04 08/26/04

SP4+HF10 08/31/04 08/31/04 08/31/04 08/31/04 09/11/04 05/06/05 08/31/04 09/01/04 08/31/04 09/01/04

SP4+HF11 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 05/06/05 11/06/04 11/06/04 11/06/04 11/06/04

SP4+HF12 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 05/06/05 11/06/04 11/06/04 11/06/04 11/06/04

SP4+HF13 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 05/06/05 11/06/04 11/06/04 11/06/04 11/06/04

SP4+HF14 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 05/06/05 11/06/04 11/06/04 11/06/04 11/06/04

SP4+HF15 11/05/04 11/05/04 11/04/04 11/06/04 11/06/04 05/06/05 11/06/04 11/06/04 11/06/04 11/06/04

SP4+HF16 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05

SP4+HF17 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05

SP4+HF18 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05

SP4+HF19 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05

SP4+HF20 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05

SP4+HF21 01/10/05 01/10/05 01/13/05 01/12/05 01/12/05 05/06/05 01/04/05 01/06/05 01/14/05 01/12/05

SP4+HF22 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 02/01/05 02/15/05

SP4+HF23 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 02/01/05 02/15/05

SP4+HF24 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 02/01/05 02/15/05

SP4+HF25 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 2/14/2005 02/15/05

SP4+HF26 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 2/14/2005 02/15/05

SP4+HF27 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 2/14/2005 02/15/05

SP4+HF28 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/09/05 02/09/05 2/14/2005 02/15/05

SP4+HF29 2/9/2005 2/14/2005 02/09/05 02/09/05 2/9/2005 05/06/05 02/10/05 02/09/05 2/14/2005 02/15/05

SP4+HF30 03/16/05 05/18/05 03/16/05 03/16/05 03/23/05 05/06/05 03/16/05 03/16/05 03/29/05 03/29/05

SP4+HF31 05/24/05 05/18/05 04/25/05 04/25/05 05/24/05 05/06/05 05/23/05 05/23/05 05/24/05 05/24/05

SP4+HF32 05/24/05 05/18/05 04/25/05 04/25/05 05/24/05 05/06/05 05/23/05 05/23/05 05/24/05 05/24/05

SP4+HF33 05/24/05 05/18/05 05/06/05 05/24/05 05/24/05 05/06/05 05/23/05 05/23/05 05/24/05 05/24/05

SP5 10/11/05 10/12/05 08/02/05 08/28/05

SP5+HF1 10/11/05 10/12/05 08/02/05 08/28/05

SP5+HF2 10/11/05 10/12/05 08/02/05 08/28/05

SP5+HF3 10/11/05 10/12/05 08/02/05 08/28/05

CARIS GIS



FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_5 FA_Process_6 FA_Process_7 FA_Process_8 FA_Process_8b FA_Process_9 FA_Process_10 FA_CST FA_FOO FA_Mobile1 Comments
v2.1 05/14/04 08/06/04 08/09/04 08/06/04 09/11/04 05/06/05 08/02/04 08/06/04 08/06/04 08/13/04
SP1 06/23/04 08/06/04 08/09/04 08/06/04 09/11/04 05/06/05 08/02/04 08/06/04 08/06/04 08/13/04
SP1+HF1 08/06/04 08/06/04 08/09/04 08/06/04 09/11/04 05/06/05 08/06/04 08/06/04 08/06/04 08/13/04
v2.2BETA 2/9/2005 02/14/05 2/9/2005 2/14/2005 01/31/05 05/06/05 2/9/2005 2/9/2005 02/01/05 02/15/05
v2.2BETA2 03/25/05 03/25/05
v2.2 07/11/05 07/12/05 07/12/05 07/12/05 10/11/05 07/11/05 07/12/05 07/12/05 10/12/05 07/12/05 08/28/05 07/11/05 07/12/05 01/17/06
v2.2+HF1 09/02/05 09/02/05 09/02/05 09/02/05 10/11/05 09/02/05 09/02/05 09/02/05 10/12/05 09/02/05 08/28/05 08/01/05 09/06/05
SP1 01/18/06 01/20/06 01/18/06 01/20/06 01/18/06 01/20/06 01/20/06 01/20/06 01/18/06 01/20/06 01/17/06
SP1+HF1 01/18/06 01/20/06 01/18/06 01/20/06 01/18/06 01/20/06 01/20/06 01/20/06 01/18/06 01/20/06 01/17/06

CARIS NOTEBOOK



FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_5 FA_Process_6 FA_Process_7 FA_Process_8 FA_Process_9
MAC 00-0B-DB-5A-62-2B 00-11-11-0F-84-44 00-11-11-06-9D-42 00-01-02-69-5A-45 00-0A-5E-42-0B-34 00-0B-DB-56-68-2B 00-11-11-06-A1-B5 00-0B-DB-56-68-30
v4.5.1 06/14/04
v4.6.1 08/03/04 08/05/04 08/05/04 08/05/04 08/05/04 08/05/04
v4.6.1patches 08/03/04 08/05/04 08/05/04 08/05/04 08/05/04 08/05/04
v4.7.1 08/05/04 08/05/04 08/05/04 08/05/04 08/05/04 08/05/04
v4.8.2 08/26/04 08/26/04 08/25/04 08/26/04 08/26/04 08/26/04
v4.8.3 08/31/04 08/31/04 08/31/04 08/31/04 08/31/04 09/01/04
v4.9.0 09/12/04 09/12/04 09/12/04 09/12/04 09/12/04 09/12/04 n/a
v4.9.1 09/30/04 10/04/04 10/04/04 10/08/04 10/07/04 10/5/2004 10/07/04

v4.9.1a 10/04/04 10/04/04 10/04/04 10/08/04 10/07/04 10/05/04 10/07/04

v4.9.3 11/27/04 11/27/04 11/19/04 11/27/04 11/27/04 11/27/04 11/27/04
v5.2.0 02/24/05 n/a 02/24/05 02/24/05 02/24/05 n/a 02/24/05
v5.2.1 n/a n/a n/a n/a 02/28/05 02/28/05 n/a
v5.3.0 03/12/05 03/12/05 03/12/05 03/12/05 03/11/05 03/12/05 03/12/05
v5.3.1 3/16/2005 3/16/2005 3/16/2005 3/16/2005 03/29/05 03/16/05 03/16/05
v5.3.2 05/24/05 05/18/05 05/06/05 05/06/05 05/06/05 05/18/05 05/06/05 03/23/05
v5.3.3rc3 06/29/05 06/29/05 07/10/05 06/29/05 06/15/05 06/29/05 06/29/05 06/29/05

v5.3.3rc3HF1 07/21/05 07/21/05 07/21/05 07/21/05 07/22/05 07/22/05 07/21/05 07/21/05

v5.8.0 10/06/05 10/04/05 10/05/05 10/04/05 10/13/05 10/03/05 10/06/05 10/03/05 10/03/05
v5.9.1 10/06/05 10/04/05 10/05/05 10/04/05 10/13/05 10/03/05 10/06/05 10/03/05 10/03/05

FA_Process_10 FA_CST FA_FOO
MAC 00-0B-DB-5A-D1-21 00-11-11-06-A4-68 00-0B-DB-56-68-8C
v4.5.1
v4.6.1 08/06/04 08/13/04
v4.6.1patches 08/06/04 08/13/04
v4.7.1 08/06/04 08/13/04
v4.8.2 08/26/04 08/26/04
v4.8.3 08/31/04 09/01/04
v4.9.0 09/12/04
v4.9.1 10/07/04 10/07/04
v4.9.1a 10/07/04 10/07/04
v4.9.3 11/27/04 11/27/04
v5.2.0 02/24/05 02/24/05
v5.2.1 02/28/05 n/a
v5.3.0 03/12/05 03/12/05
v5.3.1 03/29/05 03/29/05
v5.3.2 05/24/05 05/06/05
v5.3.3rc3 08/30/05 06/15/05 06/29/05
v5.3.3rc3HF1 08/30/05 07/22/05 07/28/05
v5.8.0 10/12/05 10/03/05
v5.9.1 10/12/05 10/05/05

You can import GP's w/ this version

Fixes Windows permissions issue

patch update

Comments

PYDRO



OLAB 1010_NAV 1018_NAV Fa-Process 1 Comments
v8.5.2 07/31/04 8/10/2004 8/12/2004
v8.6.0 n/a n/a n/a doesn't really apply directly to us

1010_ACQ 1010_ACQ
v8.7.2 2/9/2005 2/11/2005 2/28/2005
v8.7.3
v8.7.5 4/5/2005
v8.7.6 5/6/2005 For mvp .bot file processing
v8.7.7 10/6/2005

Velocwin



FA_Process_1 FA_Process_2 FA_Process_3 FA_Process_4 FA_Process_5 FA_Process_6 FA_Process_7 FA_Process_8 FA_Process_8b FA_Process_9 FA_Process_10 FA_FOO FA_CST
v6.1.0 07/28/04 07/28/04

V6.1.1 08/03/04 08/03/04 08/13/04

v6.1.2c 10/05/04 10/07/04 10/07/04

v6.1.3 01/10/05 01/04/05 01/12/05

v6.1.3i 03/07/05 03/29/05

v6.1.4a 04/18/05

v6.1.4d 8/15/2005 08/13/05 08/13/05 08/15/05 08/13/05 08/13/05 08/13/05 08/13/05

v6.1.5 d.u. 10/11/05 10/12/05

Fledermaus

1 local key on Proc 3 and 
1 Network key on FADC1

2 roving keys

What does this do?  We 
don't know.

Comments



FA_Process_1 FA_Process_2 FA_CST FA_Process_3 FA_FOO FA_Process_6 FA_Process_7 FA_Process_8 FA_Process_8b

v7.5 (4) 06/15/04 08/04/04 07/30/04 09/01/04 10/07/04

v7.8 05/24/05 05/06/05 05/24/05 05/18/05
v8.0 10/12/05 10/20/05 10/05/05 10/05/05 10/11/05 10/06/05 10/4/2005 10/12/2005

MapInfo

New (3) and Upgrade (4)

Comments

Removed from FA_Process_1, 
FA_Process_6

Upgrade



Unit S/N Software/Firmware Version Date of Installation Service Calibration Comment
POS/MV PCS 846 2.16 Apr-04
POS/MV IMU 292 N/A Apr-04
POS/MV Port Ant. SGN 98490013 N/A Apr-04
POS/MV Stbd Ant. CGN 96200099 N/A Apr-04
DGPS Receiver 0426-16627-0001 N/A 7/2004
DGPS Ant. N/A Apr-04
Reson 81-P Processor (8111) 35652 N/A May-04
Reson 81-P Processor (8160) 35385 N/A May-04

Reson 8111 Transducer Dry:8111-E209-6114          
Wet: 8111-E101-AFAA Apr-04

Reson 8160 Transducer Dry:8160-2.09-7C6D           
Wet:8160-1.00-E9E1 Apr-04

S220 Hardware 



Unit S/N Software/Firmware Version Date of Installation Service Calibration Comment
POS/MV PCS 788 2.16 Jul-04
POS/MV IMU 294 N/A Jul-04
POS/MV Port Ant. SGN 00160051 N/A Jul-04
POS/MV Stbd Ant. SGN 00120116 N/A Jul-04
DGPS Receiver 0331-12579-0008 N/A Jul-04
DGPS Ant. N/A Jul-04
Reson 81-P Processor 34497 N/A Jul-04

Reson 8101 Transducer 2701011
Dry:                        
Wet: Jul-04

removed 10/6/04 for repair, removed 10/1/05 
for welding 

1010 Hardware Serial Numbers



Unit S/N Software/Firmware Version Date of Installation Service Calibration Comment
POS/MV PCS 786 2.16 Jul-04
POS/MV IMU 323 N/A Jul-04
POS/MV Port Ant. SGN 99330009 N/A Jul-04
POS/MV Stbd Ant. SGN 98370085 N/A Jul-04
DGPS Receiver 0328-12352-0001 N/A Jul-04
DGPS Ant. N/A Jul-04
Reson 81-P Processor 35737 N/A Jul-04

Reson 8101 Transducer 3102026
Dry:                        
Wet: Jul-04

1018 Hardware Serial Numbers



Unit S/N
Software/Firmware 

Version
Date of 

Installation Service Calibration Comment
Pro XRS 0224078543
Antenna 0220341062

Unit S/N
Software/Firmware 

Version
Date of 

Installation Service Calibration Comment
Pro XRS 0224090101
Antenna 0220321059

TSCe handheld data 
collector P/N45268-50

Field Laptop/Tougbooks can be used instead of 
the TSCe handheld data collector

Addl Parts P/N
Antenna cable 22628
Camcorder Batteries 17466
NMEA/RTCM cable 30232-00
data/power cable 30231-00
dual battery cable 24333
GPS Pathfinder field 
device cable 45052

Trimble Backpack 1 Hardware Serial Numbers

Trimble Backpack 2 Hardware Serial Numbers



Unit S/N Software/Firmware Version Date of Installation Service Calibration Comment
Carl Zeiss NI2 333 100056 calibrated 03/2004
Carl Zeiss NI2 333 103567
Leica NA2 100 5332739
Leica NA2 100 5332747

Levels



Unit S/N Software/Firmware Version Date of Installation Service Calibration Comment
Ashtech Z-Xtreme Receiver ZE1200339016 ZE00 3/7/2005
Ashtech Geodetic 4 GPS Antenna 8365 3/7/2005
Pacfic Crest Position Data Link High Powered Base Unit 3/7/2005
Pacfic Crest Position Data Link Rover 3/7/2005
Marine Deep Cycle Battery 3/7/2005
Solar Panel 3/7/2005

HORIZONTAL CONTROL



Unit S/N Software/Firmware Version Date of Installation Service Calibration Comment
SBE 19plus SEACAT Profiler 19P36026-4585 on S220 n/a based on use, not returned for cal in '05
SBE 19plus SEACAT Profiler 19P36026-4617 n/a based on use, not returned for cal in '05
SBE 19plus SEACAT Profiler 19P36026-4616 n/a based on use, not returned for cal in '05

SBE 45 Micro Thermosalinograph (TSG)

SEACATs



Name CDR John E. Lowell LDCR Van Den Ameele LT(jg) Abigail Higgins ENS Mike Gonsalves ENS Jon French ENS Wendy Lewis ENS Allison Martin
Rate CO XO FOO NAV ENS ENS ENS

1 years 1 years 1 years 1 years 0 years 0 years
9 months 6 months 0 months 0 months 5 months 5 months
21 years 1 years 1 years 1 years 0 years 0 years
8 months 11 months 0 months 0 months 5 months 5 months

Fast Rescue Boat July 2004 July 2004 Nov 2004 Nov 2004 May 2005 May 2005
Basic Hydro 2004 2005 2005
Hydro presenter
SWMB Course 2005
CARIS HIPS 
RESON Training Oct 2004
COOPS Tide
Launch PIC Qualified
Survey PIC Qualified
Launch Cox'n Qualified
OOD Qualified
Other Education, Training, 
and Qualifications

STCW Advanced 
Fire

STCW Advanced 
Fire

Authorized Actual Percentage
Mission 6 5 83%
Support 2 2 100%

Sevice on Fairweather

Hydrographic Experience

OFFICERS



Name William Ness Kim Parker Marcus Humphreys Vincent Nguyen Gregory Bryant Dale Graham
Rate CME 1AE 2AE 3AE W Junior Engineer

1 years 0 years 0 years 0 years 0 years 0 years
9 months 4 months 3 months 2 months 7 months 3 months
11 years 35 years 5 years 2 years 0 years 23 years
6 months 10 months 10 months 4 months 7 months 1 months

Fast Rescue Boat
Basic Hydro
Launch Cox'n Qual.
Other Education, 
Training, and 
Qualifications

Chief Engineer-
Diesel License

Third Engineer 
License

Air condition 
/refrigeration 
universal (EPA) 
Navy Training

Service on Fairweather

Engineering Experience

ENGINEERING



Name Lynnette Morgan Jessica Abrams Grant Froelich Jennifer Keene Verena Kellner Michael Castle
Rate CST SST SST ST ST AST

1 years 1 years 1 years 1 years 1 years 1 years
8 months 5 months 5 months 1 months 3 months 2 months
5 years 3 years 3 years 1 years 1 years 1 years
10 months 9 months 3 months 8 months 3 months 2 months

Fast Rescue Boat July 2004 July 2004 July 2004 Jan 2005 Jan 2005
Basic Hydro 2000 & 2001 2002 2003 2004 2005 2005
Hydro presenter 2003-present
SWMB Course Dec 2001 2004 Jan 2005 Jan 2005
CARIS HIPS 2001-2005 Jan 2005 Jan 2005 Jan 2005 March 2005 Jan 2005
RESON Training Oct 2004 Oct 2004 Oct 2004 Oct 2004 Oct 2004 Oct 2004
COOPS Tide 2001 March 2005 December 2003 March 2005 March 2005 March 2005
Launch PIC Qualified 2001 2004 2004 2004 2005 2005
Survey PIC Qualified 2001 2004 2004 2005 2005 2005
Launch Cox'n Qualified
Other Education, Training, 
and Qualifications

Authorized Actual Percentage
Mission 6 6 100%
Support

Sevice on Fairweather

Hydrographic Experience

SURVEY



Name Garry Guice Eric Heiner Ronald Walker John Lawless Leroy Jordan David Grayeagle Jim Klapchuck
Rate CB BGL DU AB BGL GVA GVA

1 years 1 years 1 years 1 years 1 years 0 years
7 months 8 months 5 months 2 months 9 months 8 months
23 years 12 years 21 years 20 years 1 years 0 years
7 months 7 months 5 months 10 months 9 months 8 months

Fast Rescue Boat July 2004 July 2004 July 2004 Jan 2005
Basic Hydro 2001
Launch Cox'n Qual. 2000 2005 2005 2005
Other Education, Training, 
and Qualifications

Inland masters 
license-           
AB unlimited

STCW 95, Survival 
Craft, AB Unlimited

Authorized Actual Percentage
Mission 4 3 75%
Support 6 4 67%

Sevice on Fairweather

Deck Experience

DECK



Name Kathy Brandts Joe Edgar
Rate CS CC 2C

1 years 0 years 0 years
6 months 4 months 4 months
9 years 6 years 2 years
7 months 10 months 10 months

Fast Rescue Boat
Basic Hydro
Launch Cox'n Qual.
Other Education, Training, 
and Qualifications

Authorized Actual Percentage
Mission
Support 3 3 100%

Sevice on Fairweather

Stewards Experience

STEWARDS



Name Jim Lynn Richard Conway
Rate LET ET

1 years 1 years
5 months 5 months
19 years 1 years
5 months 8 months

Fast Rescue Boat
Basic Hydro
Launch Cox'n Qual.
Other Education, Training, 

Authorized Actual Percentage
Mission
Support 1 1 100%

Sevice on Fairweather

ET Experience

ETs



Name John E. Lowell E.J. Van Den Ameele Eric Heiner William Ness Grant Froelich Lynnette Morgan Jon French Allison Martin
Rate CO XO BGL CME SST CST ENS ENS
Type Master Diver Dive Master Dive Master, DMT Working Diver Dive Master, DMT Working Diver Working Diver Working Diver

30 years 6 years 10 years 14 years 4 years 10 years 10 years
10 months 10 months 6 months 2 months 2 months 3 months 8 months
21 years 6 years 10 years 2 years 4 years 0 years 0 years
8 months 10 months 6 months 10 months 2 months 2 months 2 months

Total Diving Experience

Years as NOAA diver

NOAA DIVERs



- 1 - 

NNOOAAAA  SSHHIIPP  FFAAIIRRWWEEAATTHHEERR  ((SS222200))  
RREESSOONN  88111111EERR  VVEESSSSEELL  RREEPPOORRTT  22000055 

 

Background 
NOAA Ship FAIRWEATHER, Hull Registration Number S220, is a 231 foot 
hydrographic survey vessel built by Aerojet-General Shipyards in Jacksonville Florida.  
In 2004, the ship underwent a reactivation and modernization program including hull, 
mechanical, electrical and mission upgrades.  The ship underwent conversion to meet 
American Bureau of Shipping (ABS) Subchapter L classification.  Included in this 
upgrade, an integrated Reson 8111ER multibeam echo sounder (MBES) installed 39.5” 
starboard of centerline at approximately frame 29.  The installation was designed by 
Seaworthy Systems Inc. 
 
Tests were performed to determine the residual biases of the sensors and sonar system 
alignment.  Data were assessed in CARIS HIPS & SIPS v5.4 (SP 1, Hot Fixes 1-23) 
calibration mode and applied to the HIPS Vessel File (HVF), S220_8111.HVF. 

Patch Test 
Patch tests were performed with NOAA Ship FAIRWEATHER in Eastern Passage, AK 
on April 7 and 8, 2005 (DN 097 and 103).  The patch test data were collected by SST 
Froelich (DN 097) and AST Kellner and ECO Rheinheimer (DN 103). 
 
Raw ISIS XTF data was converted to CARIS HDCS format.  True heave, sound 
velocity, and predicted tides were applied upon conversion and the lines were “lightly” 
cleaned in CARIS swath mode to remove major data fliers.  The patch test data were 
then reviewed in CARIS calibration mode independently by SST Froelich, CST Morgan, 
LT Wetzler and ECO Rheinheimer and other survey personnel to determine the biases. 

Navigation Time Error 
A Navigation Time Error test has not yet been performed.   
 
A Time Error of -0.01 was inserted into the S220_8111.HVF under Swath 1.  This value 
is justified since the Navigation Time Error is physically the time difference between the 
time stamps that the POS/MV and the Reson 81-P Sonar Processor place with their 
data.  Given that the configuration of the POS/MV and the Reson 81-P Sonar Processor 
have not changed since last year, the Navigation Time Error should not have changed.  
Secondly, the Navigation Time Error for both launches, using an identical configuration, 
are both 0.01. 
 
As a data quality analysis check a time latency test will be conducted at the earliest 
possible opportunity. 
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Heading and Pitch 
The heading and pitch bias patch tests were conducted in Eastern Passage over a 
pinnacle with a radius of 45 m, in an area with an average depth of 90 m and a least 
depth of 76 m.  The rock is located at 56°26’00”N, 132°12’45”W (See Figure 1). On DN 
097 one set of heading and pitch lines oriented East-West was run.  On DN 103 two 
sets of heading and pitch lines were run, one oriented East-West and the other North-
South, as shown in Figure 1. 
 
Heading 
The heading bias was determined by acquiring data on one or two sets of parallel lines 
run in opposite directions.  On DN 097, the pair of lines were offset from the rock 175 m 
and 185 m, respectively.  Vessel speed was 5 knots.  On DN 103 the East-West 
heading lines were offset 180 m on either side of the rock.  The east and west North-
South lines on DN 103 were offset 170 m and 150 m, respectively, from the rock. 
 
Pitch 
The procedure used to determine the pitch bias was to run one or two pair of coincident 
lines over the rock at the same speed in different directions. The lines were run at 
approximately 6 knots.  The only difference between DN 097 and 103 was the addition 
of pitch lines run in the North-South direction. 

Roll 
The procedures for acquiring roll biases included running one pair of coincident lines 
over a locally flat area with an approximate depth of 110 m at approximately 6 knots 
(see Figure 1).  Data was acquired for four lines on each of DN 097 and 103. 
 

 
Figure 1. Location of Pitch, Heading, and Roll Lines and GAMS Calibration. 

GAMS 
Calibration Area 

Pitch and Heading Lines

Roll Lines

Dynamic Draft test 
site (See Figure: 5) 
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Figure 2. Pinnacle used for Pitch and Heading Patch Tests. 

Patch Test Results 
The results of the patch tests for each of DN 097 and 103 are given in Table 1, below. 
 

Patch Bias DN 097 
Biases 

DN 103 
Biases 

HVF Bias Values 

Time Error N/A N/A -0.01 
Pitch -0.35° -0.1 -0.1 
Roll 0.0° 0.01 0.01 

Heading -0.25° -0.37 -0.35 

Table 1: S220 Patch Test Bias Values 

Dynamic Draft Settlement and Squat Method (DDSSM) 
The DDSSM test was conducted April 14, 2005 (DN 104) in Zimovia Strait near 
Wrangell, AK.  Lines were run at location 56°25’54”N, 132°25’40”W in approximately 25 
m of water (see Figure 3).  The dynamic draft data were collected by AST Kellner and 
ECO Rheinheimer. 
 
One line was run ten (10) times in the same direction at speeds ranging from 3.5 to 13.3 
knots.  At three points along the line, data were collected with the engine in idle (dead in 
water or DIW, see Figure 3). 
 
SVP and predicted tides (single station) were applied in CARIS HIPS and lines were 
“lightly” cleaned in CARIS swath mode to remove major data fliers and filtered to 40° 
from nadir to remove outer beams.  The data were then processed by LT Wetzler using 
DDSSM as documented in the Draft Field Procedures Manual (January 2005).  DDSSM 
results were saved to S220_DDSSM Settlement and Squat.xls located in Appendix III-
S220-4. 
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Figure 3. Dynamic Draft test site for S220. 

Results of the DDSSM test have not been calculated at this time.  
FAIRWEATHER personnel are waiting to process the test until observed tides 
and possibly a zone definition file can be downloaded.   

POS/MV GAMS Calibration 
POS/MV GPS Azimuth Measurement Subsystem (GAMS) calibration occurred on April 
7 (DN 097) near Eastern Passage (see Figure 1).  GAMS calibration was performed by 
SST Froelich. 
 
The GAMS heading calibration threshold was initially set to 0.300°.  FAIRWEATHER 
was maneuvered in figure-eights to lower the heading accuracy as much as possible.  
The best heading accuracy value achieved during this process was 0.721°.  The vessel 
steadied up on a constant heading and GAMS calibration was requested.  When the 
calibration was complete, the POS/MV settings were saved to the file 
S220_040705_posmv.nvm and are listed below in Table 2. 
 
The detailed POS/MV Calibration Report, S220_POS_Calibration_Dn087.xls, is located 
in Appendix III. 
 

Component DN 097 Value 
Number of Satellites 

PDOP 
Baseline Vector X 
Baseline Vector Y 
Baseline Vector Z 

Two Antenna Separation 
Heading Correction 

9 
2.024 

-0.031 m 
4.067 m 
0.026 m 
4.067 m 
0.000 ° 

Table 2: POS/MV GAMS Calibration Results 

DDSSM Lines

DIW1

DIW2

DIW3 
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Recommendations 
The patch test calibration results are based on averages from DN 097 and DN 103.  
The HVF values listed in table 1 should be used until such a time or event warrants a 
new calibration. 
 
The POS/MV GAMS calibration results from April 7 (DN 097) should be used until such 
a time or event warrants a new calibration. 
 
Dynamic Draft Settlement and Squat results will be calculated and utilized at the earliest 
opportunity.    
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AADDDDEENNDDUUMM  11 
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RREESSOONN  88111111EERR  VVEESSSSEELL  RREEPPOORRTT  22000055  
 

Background 
The Dynamic Draft and Settlement and Squat Method DDSSM test was conducted April 
14, 2005 (DN 104) in Zimovia Strait near Wrangell, AK. However, the test was not 
processed immediately, pending availability of Verified Tides.   
 
This Addendum 1 of the NOAA Ship FAIRWEATHER Reson 8111ER Vessel Report 
2005 documents the results of the DDSSM test and provides a recommendation 
regarding their use. 

Dynamic Draft Settlement and Squat Method (DDSSM) 
One line was run ten (10) times in the same direction at speeds ranging from 3.5 to 13.3 
knots.  At three points along the line, data were collected with the engine in idle (dead in 
water or DIW, see Figure 3 in the initial report). 
 
Sound velocity information and verified tides from the primary National Water Level 
NLOWN tide gauge 945-0460 were applied in CARIS HIPS and lines were “lightly” 
cleaned in CARIS swath mode to remove major data fliers and filtered to 40° from nadir 
to remove outer beams.  The data were then processed by LT Wetzler using DDSSM as 
documented in the Draft Field Procedures Manual (January 2005), with the exception of 
the idle positions.  DDSSM results were saved to the spreadsheet 
S220_DDSSM_Results.xls and are attached.  
 
Upon processing the data it was determined that the idle positions were unusable.  Due 
to a strong set the nadir beams of the idle positions were 10’s of meters off from the 
nadir beams of the speed lines.  The settlement and squat value of the 0 knot run was 
extrapolated, and found to be 4.7 cm, by using the slope of the 3.5 knot and 5.5 knot 
runs.  The settlement and squat value for the 0 knot run was then set to 0 cm and the 
remaining settlement and squat values were reduced by 4.7 cm. 
 
Since the 3 idle positions were not usable six locations in the last 500 m of the line were 
examined.  The use of more locations allowed a better determination of the standard 
deviation within the results.  An average standard deviation of 0.043 m was determined.  
From the RESON 8111ER documentation the range resolution of the system is 0.037 
m.  These values show good agreement. 
 
 The average change in depth from dead in water for each speed is shown below in 
Table 3. 
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Speed (kts) Average Delta Draft (m) 
0 0 

3.5 -0.047 
5.5 -0.074 
7.5 -0.074 
8.1 -0.026 
9.5 -0.015 
11.3 0.021 
13.2 0.162 

Table 3: DDSSM Test Results 

Recommendations 
The DDSSM results obtained from April 14 (DN 104) and included in Table 3 should be 
used until such a time or event warrants a new calibration.  These values can be used 
for both the RESON 8111ER and the RESON 8160. 
  
The patch test calibration results are based on averages from DN 097 and DN 103.  
The HVF values listed in table 1 should be used until such a time or event warrants a 
new calibration. 
 
The POS/MV GAMS calibration results from April 7 (DN 097) should be used until such 
a time or event warrants a new calibration. 
 
A Navigation Time Error latency test should be conducted at the earliest opportunity.   
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Ship: Fairweather Vessel: 1018
Date: 10/21/2005 Dn: 294

Personnel: Abrams, Martin, Walker

PCS Serial # IMU Serial # 323

IP Address: 129.100.1.231

POS controller Version (Use Menu Help > About) 2.1

POS Version (Use Menu View > Statistics) 2.16
GPS Receivers

Primary Receiver OEM-2 3151R SGN99330009 HW 1 SW 3.36/1.02 Mar 18/99

Secondary Receiver OEM-2 3151R SGN98370085 HW 1 SW 3.36/1.02 Mar 18/99

Calibration area
Location:
Approximate Position: Lat 56 11 30.84

Lon 131 34 39.25
DGPS Beacon Station: Gustavus, AK
Frequency: 288 kHz

Satellite Constellation (Use View> GPS Data)

NOAA POS/MV Calibration Report

Duck Point, Bradfield Canal, AK

786



GAMS Solution (Use View> GAMS Solution)

POS/MV Configuration
Settings

Configuration Notes:

POS/MV Calibration

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 17:56
End time: 17:58
Heading accuracy achieved for calibration: 0.028

Calibration Results:

GAMS Status Online X
Save Settings X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: 1018_294_POSMV.nvm



General Notes:
The POS/MV uses a Right-Hand Orthogonal Reference System
The right-hand orthogonal system defines the following:
• The x-axis is in the fore-aft direction in the appropriate reference frame.
• The y-axis is perpendicular to the x-axis and points towards the

right (starboard) side in the appropriate reference frame.
• The z-axis points downwards in the appropriate reference frame.

The POS/MV uses a Tate-Bryant Rotation Sequence
Apply the rotation in the following order to bring the two frames of reference 

into complete alignment:
a) Heading rotation - apply a right-hand screw rotation θz about the

z-axis to align one frame with the other.
b) Pitch rotation - apply a right-hand screw rotation θy about the

once-rotated y-axis to align one frame with the other.
c) Roll rotation - apply a right-hand screw rotation θx about the

twice-rotated x-axis to align one frame with the other.



SETTINGS



SETTINGS Continued

Events Use Settings > Events)

Time Sync (Use Settings > Time Sync)



INSTALLATION (Use Settings > Installation)

Lever Arms and Mounting Angles (Use Settings > Installation > Lever Arms and Offsets)

Tags, Multipath and Auto Start (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting (Use Settings > Installation > Sensor Mounting)



User Parameter Accuracy (Use Settings > Installation > User Accuracy)

Frame Control (Use Tools > Config)

GPS  Receiver Configuration (Use Settings> Installation> GPS Receiver Configuration)

1

Secondary GPS Receiver
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Background 
NOAA Hydrographic Survey Launch 1018 (Hull Registration Number 1018) is a 28 foot 
10 inch aluminum survey launch designed by B. F. Jensen & Associates in 1973.  
Various vendors built a series of “Jensen” launches for NOAA in the mid 1970’s to this 
general design and 1018 was the 18th in the series.  It is considered a Qualified Class II 
Motorboat within the NOAA classification system and is operated within the parameters 
required for a vessel of this type.   
 
In 2004, the hull, mechanical, electrical and mission systems underwent a 
modernization program that increased the performance and utility of the vessel.  These 
upgrades include hull strengthening, increased scantlings to accommodate a larger 
engine and propeller, hard top, new electrical systems including a 6kW hydraulic 
generator, a flush deck, hydraulic A frame and dive platform.  Also added at this time 
was a new swing arm transducer mount for the Reson 8101ER multibeam echo 
sounder (MBES), designed by The Glosten Associates, Inc.  All modifications were 
conducted within the constraints as defined by the NAO 217-103, Management of Small 
Boats, Section 6.03, Significant Alterations. 
 
The opening portion of this report discusses problems identified during initial testing of 
launch 1018.   

Review of initial Patch Testing 
Patch tests were performed with NOAA Launch 1018 in the vicinity of Ketchikan, AK on 
March 12 & 13 (DN 071 and DN 072).  Data from both days were compared for system 
consistency by acquiring data on the same lines and comparing the results in CARIS 
HIPS Calibration.  The patch test data were collected by SST Froelich, ST Kellner, AST 
Castle, ENS French, and ECO Rheinheimer. 
 
Raw ISIS XTF data was converted to CARIS HDCS format.  Sound velocity and 
observed tides were applied upon conversion and the lines were “lightly” cleaned in 
CARIS swath mode to remove major data fliers.  The patch test data were then 
reviewed in CARIS calibration mode independently by CST Morgan, ST Keene, LT 
Wetzler, and PS Palmer to determine the biases.  During this process, problems were 
identified as described below. 

Roll 
The procedure for determining roll biases included running one pair of coincident lines 
over a locally flat area at approximately 8 knots.  Patch test bias results were consistent 
among reviewers.  The biases were applied to the HVF and the data was reviewed in 
CARIS Subset mode.  DN 071 results had approximately a 0.4 meter vertical offset 
between lines that were collected within 10 minutes of each other (see Figure 1).  When 
comparing roll lines from DN 071 to DN 072 there was approximately a 4.7 meter 
vertical offset (see Figure 2), which is likely attributable to tidal variations, as preliminary 
tides were used. 
 
 



 
Figure 1: Across-track view of Roll patch lines from DN 071, with a vertical offset of approximately 0.4 m 

 

 
Figure 2: Across-track view of Roll patch lines from DN 071 and DN 072, with a vertical offset of 

approximately 4.7 m between days 

 
 

Patch Test Results 
 



Table 1, below, shows the bias values for the patch tests performed on each of DN 071 
and 072.  Note the difference between the roll bias on the respective days. 
 

Patch Bias DN 071 Bias value DN 072 Bias value 
Navigation Time Error 0.01 sec 0.01 sec 

Pitch 0.00° -0.2° 
Roll 2.13° 2.61° 

Heading 0.4° -0.1° 
Table 1: Patch Test Bias Results 

Initial Review of Dynamic Draft Settlement and Squat Method (DDSSM) Test 
The DDSSM test consisted of acquiring data for multiple coincident lines in the same 
direction but at different speeds.  The swing arm mount was also tested, by raising and 
lowering the transducer at the end of each line.  In addition, three crosslines were 
acquired to check for data consistency. 
 
The resulting DDSSM data were reviewed in CARIS Subset mode.  There was 
approximately a 0.4 m maximum vertical offset among lines on DN 071 (see Figure 3).  
There was approximately a 1.5 meter maximum vertical offset among lines on DN 072 
(see Figure 4).  There were very large vertical offsets of approximately 4 m between 
lines collected on DN 071 and lines collected on DN 072 (see Figure 5).  DN 072 data 
appears to be vertically offset 2 meters deeper than that of DN 071.  It should be noted 
that preliminary tide data was used to process the DDSSM test lines, accounting for at 
least some of the noted day-to-day (and possibly intraday) offset. 
 
The DDSSM data collected on DN 071 and DN 072 is not usable. 
 

 
Figure 3: Across-track view of DDSSM patch test lines from DN 071, with a maximum vertical offset of 

approximately 0.4 m 

 



 
Figure 4: Across-track view of DDSSM patch test lines from DN 072, with a maximum vertical offset of 

approximately 1.5 m 

 
 

 
Figure 5: Across-track view of DDSSM patch test lines from DN 071 and DN 072, with a vertical offset of 

approximately 4 m 

Transducer mount issues 
We believe the roll inconsistencies are a result of instability in the swing mount arm.  
The mount was designed to be held in place against the under hull stop, but due to 



fabrication and assembly issues, this did not happen.  The arm was locked into position 
inside the cabin by a stainless steel pin sliding through two aluminum brackets (see 
Figures 6, 7, and 8).  One of the holes in the brackets has worn away because of the 
stainless steal pin against a softer aluminum leaving approximately 3 mm of freeplay in 
the lever arm.  Several field modifications were made over a two week period at the 
start of the 2005 field season that solved this problem (see addendum 1). 
 
 

 
Figure 6: Overview of Launch 1018 swing arm inside of cabin  

 

  
Figure 7: Aluminum bracket for locking        Figure 8: Stainless steel pin locked in to 

position transducer down       with transducer up 
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Background: 
During testing of Launch 1018 it was noticed that the mount was not stable from day to 
day.  Testing originally occurred on DN 071 and then DN 072 in order to determine if the 
mechanical corrections to the swing arm mount were functional.  The HVF values for 
DN 071 and DN 072 did not match.  Specifically, there were significant differences in 
the roll bias and the inconsistencies with the DDSSM data.  A third patch test was 
performed on March 28 (DN 087) in Madan Bay to see which of the earlier days were 
correct.  The HVF values for DN 087 closely matched DN 071, but were different from 
DN 072. 
 
Those three patch tests showed that the multibeam mount was unstable.  Because of 
the drift in the HVF values over such a short period of time, the mechanics of the swing 
arm mount were inspected.  It was found that the aluminum mounting bracket that held 
the deployment lever arm in place was worn.  Further, when pinned in it was noticed 
that the deployed position the swing arm mount did not rest on its under hull stop.  The 
worn mounting bracket allowed the transducer to move over time. 
 
Another method of locking the deployment lever arm was proposed in order to keep the 
transducer in place against the under hull stop.  On DN 088, a ratcheting tie-down strap 
was used to hold the deployment lever arm mount in position.  Figure 9 shows the 
deployment lever arm and the set pin with the temporary fix of the ratcheting tie-down 
strap. 
 

 
Figure 9: The deployment lever arm, set pin and ratcheting tie–down strap. The pin was eventually removed 

to allow the arm to reach the under hull stop. 



The HVF values for DN 088 were calculated and showed intraday stability.  In order to 
determine if the locking ratchet strap provided the needed consistency two patch tests 
were run on DN 089.  One test was run in the morning prior to acquisition and the other 
in the evening after acquisition.  There was again intraday consistency from the start of 
DN 089 through to the end of DN 089, but the interday roll and heading values between 
DN 088 and DN 089 were not close enough for the acquired data to meet IHO S-44 
Order 1 specifications.  That is to say, if the HVF for DN 088 were used on DN 089 
data, the resulting processed data would not meet IHO S-44 Order 1 specifications.   
 
During this process the swing arm transducer mount was repeatedly examined.  It was 
found that with the set pin in place the mount did not touch the transducer mount stop 
on the bottom of the boat.  There was a gap of approximately 2 mm.   
 
On DN 095 another set of patch tests were run, this time without the set pin, and 
removing any obstructions to the arm.  The ratcheting tie down strap was the sole 
device to hold the mount in place.  This allowed the transducer mount to rest on the 
under hull stop and eliminate any instability issues. 
 
The roll bias values on DN 095, due to the change in the angular positioning of the 
system from removing the set pin, do not match DN 089.  This is to be expected.   
 
The procedure was to conduct a patch test before survey operations, collect data, and 
then patch test in the evening.  After processing the patch tests for the morning and 
evening, the HVF was then updated if necessary.  Sounding data was merged using the 
updated HVF and then examined for internal consistency.  Using this procedure, data 
meets IHO S-44 Order 1 specifications. 
 
Tests were performed to determine the residual biases of the sensors and sonar system 
alignment and settlement and squat.  Data were assessed in CARIS HIPS & SIPS v5.4 
(SP 1, Hot Fixes 1-23) calibration and subset modes and applied to the HIPS Vessel 
File (HVF), 1018_8101.HVF. 

Patch Test 
Patch tests were performed with Launch 1018 in the vicinity of Wrangell Island, AK (see 
Figure 10) on March 28 (DN 087).  The patch test data were collected by ST Keene, 
AST Castle, and ECO Rheinheimer. 
 
Raw ISIS XTF data were converted to CARIS HDCS format.  Sound velocity and 
predicted tides were applied upon conversion and the lines were “lightly” cleaned in 
CARIS swath mode to remove major data fliers.  The patch test data were then 
reviewed in CARIS calibration mode independently by CST Morgan, ST Keene, LT 
Wetzler, and PS Palmer to determine the biases. 
 
Subsequent to using a the ratcheting tie-down strap, as described above, additional 
patch tests were conducted by FAIRWEATHER personnel on DN 088, DN 089 (AM & 
PM), and DN 095 (AM & PM) utilizing the method as describe for DN 087. 
 
 
 
 



 
Figure 10: Test Sites for Launch 1018 

Heading and Pitch 
The heading and pitch bias patch tests were conducted in The Narrows over a rock with 
a radius of 35 m, in an area with an average depth of 40 m and a least depth of 25 m. 
The rock is located at 56°21’52”N, 132°06’53”W (see Figures 11 & 12). 
 
Heading 
The heading bias was determined by acquiring data on two sets of parallel lines run in 
opposite directions.  The pairs of lines were offset from the rock 25 m and 35 m, 
respectively.  Vessel speed was 6-7 knots.  
 
Pitch 
The procedure used to determine the pitch bias was to run two pair of coincident lines 
over the rock in approximately 40 m of water at the same speed in different directions. 
The lines were run between 6-7 knots.  
 
 
 
 
 

Pitch and Heading 
Patch test site (See 
Figures: 2&3) 

Roll Patch test site 
(See Figure: 4) 



 
 

 
Figure 13: Roll patch test site for Launch 1018. 

Roll 
The roll bias patch was conducted in Madan Bay over a flat area in approximately 90 m 
of water at location 56°23’00”N, 132°09’21”W (see Figure 13).  Roll bias was 
determined by running three pair of coincident lines over the area at 7-8 knots in 
different directions. 

Navigation Time Error 
There was no Navigation Time Error test performed on March 28 (DN 087).  Final 
values entered into 1018_8101.HVF were based on previous test results. 
 
Vertical offsets were not noticed in the roll lines from DN 087. However, pitch and 
heading data shows there is an approximate 0.4° offset from lines collected on the 
same day.  There is approximately a 0.5-1.0m vertical offset from lines run within 15 
minutes of each other (see Figure 6). 
 

 
 
 

Figure 12:  Rock used for Heading and Pitch patch test for 
launch 1018 

Figure 11:  Heading and Pitch patch test site 
for launch 1018 



 
Figure 14: Pitch & heading patch test lines from DN 087 with approximately a 0.5-1.0 meter vertical offset 

Patch Test Results 
The bias results from these second set of patch tests are shown in Table 2, below.  The 
bias values applied during processing in the HVF are given for DN 089 and 095 in  
Table 3. 
 
 

Patch Bias DN 087  
Bias 

DN 088  
Bias 

DN 089 
AM Bias 

DN 089 
PM Bias 

DN 095 
AM Bias 

  DN 095 
PM Bias 

Nav Time Error 
Pitch 
Roll 

Heading 

0.01 sec 
0.04° 
2.64° 
0.25° 

0.20° 
2.50° 
-0.95° 

0.0° 
2.68° 
0.35° 

0.10° 
2.68° 
0.45° 

0.0° 
2.96° 
0.1° 

0.0° 
3.03° 
0.3° 

Table 2: Patch Test Bias Results 

 
HVF Patch Bias DN 089  

HVF Bias values 
DN 095  

HVF Bias values 
Time Error 

Pitch 
Roll 

Heading 

-0.01 sec 
0.05° 
2.68° 
0.4° 

-0.01 sec 
0.0° 

3.00° 
0.2° 

Table 3: Patch Test HVF Bias Values 

Modifications and Additional Patch Testing 
Data was continued to be acquired on project OPR-O119-FA and was used because 
the system was proving to be consistent over the course of a day.  Further modifications 
continued to remedy the day to day fluctuations in biases.  Launch 1018 modifications 
consisted of the pin no longer being used as a stop for the arm, a portion of the wood 
decking being removed, and the arm being ground down to eliminate any possibility of 
the arm resting anywhere but the under hull stop (see Figure 15 for under hull stop). 
 



 
Figure 6: Launch 1010 swing arm mount against hull stop. 

Patch testing on DN 097 was conducted as described and in the same locations as 
discussed on DN 087.  The patch test data were collected by SST Abrams and AST 
Castle.  Additional roll lines were conducted along with a tension test to examine 
whether variations in ratcheting of the strap would show up in the data.  The patch test 
data were reviewed in CARIS calibration mode independently by CST Morgan, SST 
Froelich, ECO Rheinheimer, and ENS Higgins to determine biases.  No data was 
collected on DN 097, due to additional testing being done after modifications. 
 
A new mount with a drilled hole for the tie-down strap to anchor to was bolted to the 
frame of Launch 1010 on DN 101. 
 
Patch testing on DN 098, DN 099, and DN 101 through DN 102, was conducted in the 
morning and evening as described and in the same locations as discussed on DN 087.  
The patch test data were collected and reviewed in CARIS calibration mode to 
determine biases by FAIRWEATHER personnel.   
 
 
 
 
 
 

Under Hull 
Stop 



Patch Test Results 
The results of five days of morning and evening patch testing are reported in Table 5, 
below. 
 

 

 

Table 4: Patch Test Bias Results 
 
Patch Test Biases used for data processing 
 
The bias values in the HVF file, used for daily data processing on lines run on and after 
Dn 098, are shown in Table 5.  The DN 098 values are based on averages of values 
from DN 097 through DN 101. 
 
 
 
 

 
 
 
 
 

Table 5: Patch Test HVF Bias Values 
 
Patch test acquisition and processing logs are located in Appendix III-1018-3. 
 
Optical Settlement and Squat 
Settlement and Squat were performed on March 13th (DN 072) in Blank Inlet at location 
55°14’45.80”N, 131°40’58.58”W in approximately 40m of water (see Figure: 5). Data 
were collected by CST Morgan, SST Froelich, AST Castle, ENS French and PS Palmer.  
 
 
 
 
 

Patch Bias DN 097 
First Bias 

DN 097 
Roll2 Bias 

DN 097 
Roll3 Bias 

DN 097 
Roll4 Bias 

DN 097 
Final Bias 

Pitch 
Roll 

Heading 

-0.4° 
3.01° 
0.0° 

3.01° 
 

3.02° 
 

 
3.02° 

 

-0.4° 
3.01° 
0.0° 

Patch Bias DN 098 
AM Bias 

DN 098 
PM Bias 

DN 099 
AM Bias 

DN 099 
AM2Bias 

DN 099 
PM Bias 

Pitch 
Roll 

Heading 

-0.42° 
3.06° 
0.1° 

-0.4° 
3.04° 
N/A 

0.2° 
3.03° 
0.1° 

 
3.05° 

 

0.2° 
3.03° 
-0.15° 

Patch Bias DN 101 
AM Bias 

DN 101 
PM1Bias 

DN 101 
PM2Bias 

DN 102 
AM Bias 

DN 102 
PM Bias 

Pitch 
Roll 

Heading 

-0.10° 
3.03° 
0.0° 

-0.10° 
2.99° 
-0.15° 

-0.15° 
3.01° 
N/A 

0.2° 
3.06° 
0.0° 

0.0° 
3.05° 
-0.1° 

HVF Patch Bias DN 098 - 
HVF Bias values 

Time Error 
Pitch 
Roll 

Heading 

-0.01 sec 
-0.17° 
3.02° 
0.0° 



Optical levels were used to determine settlement and squat biases. The procedure 
included setting up on shore a Leica NA2 352036 stadia level and placing a graduated 
metric staff on top of launch 1018’s port side gas cap (see Figures 16 & 17).  The 
settlement and squat data were acquired at seven different speeds: 5,6,7,8,9,10, and 11 
knots. Readings were taken for all seven speeds: four “at rest” before and after each 
direction, ten readings as the launch is moving away “at speed”, and ten as the launch 
is moving toward the shore team “at speed”. This procedure was repeated for all seven 
speeds. 

 

 
Figure 15: Settlement and Squat test site for Launch 1018. 

The computations and table of results are included in 1018_DDSSM Settlement and 
Squat located in Appendix III-1018-4.  The results are summarized in the table below: 
 
 
 
 
 
 
 
 
 
 

Table 6: Settlement and Squat Results 
 

Average Speed (knots) Delta Draft (m) 
0.0 
5.2 
6.2 

7.15 
7.95 
8.95 
9.9 

11.05 

0.000 
0.0255 
0.027 

0.03795 
0.0545 
1.0025 
0.052 

0.0425 



 

        
Figure 16: Settlement and Squat shore team               Figure17: Graduated metric staff on port side gas cap. 

 using optical level. 
 
Dynamic Draft Settlement & Squat Method (DDSSM) 
Due to the swing arm mount problem, the DDSSM lines run on DN 071 & 072 could not 
be utilized.  The DDSSM was not re-run.  After analysis of Launch 1010 DDSSM and 
Optical Settlement and Squat values, FAIRWEATHER personnel decided the Optical 
values were adequate to be utilized as the Delta Draft correctors.  
 
POS MV GAMS Calibration 
POS MV GPS Azimuth Measurement Subsystem (GAMS) calibration occurred on 
March 28th (DN 087) near Madan Bay (see Figure 8). GAMS calibration was performed 
by ST Keene, AST Castle and ECO Rheinheimer.   
 
The GAMS heading calibration threshold was initially set to 0.300°. 1018 was 
maneuvered in “figure 8’s” to lower the heading accuracy as much as possible.  The 
best heading accuracy value achieved during this process was 0.05°.  The vessel 
steadied up on a constant heading and GAMS calibration was requested. When the 
calibration was complete, the POS MV settings were saved to the file 
1010_085_posmv.nvm (see Table 3).  The file name has the wrong vessel number and 
the wrong day number, due to confusion in the field. 
 
The detailed POS/MV Calibration Report, 1018_POS_Calibration_Dn087.xls, is located 
in Appendix III-1018-5. 
 
 
 
 
 
 
 

 



Component DN 087 Value 
Number of Satellites 

PDOP 
Baseline Vector X 
Baseline Vector Y 
Baseline Vector Z 

Two Antenna Separation 
Heading Correction 

8 
1.789 

0.009 m 
1.831 m 
0.031 m 
1.831 m 
0.000 ° 

Table 7: POS MV GAMS Calibration Results 
 

 

 
Figure 18: POS/MV GAMS Calibration test area. 

 
 
Recommendations: 
The patch test calibration results, HVF Bias values for March 30th (DN 089) & April 5th 
(DN 095) in table 3 above, should be used for processing data for those respective 
days.   
 
The patch test calibration results listed in table 5 for DN 098 should be used for launch 
1018 until such a time or event warrants a new calibration. 
 
The Optical Settlement and Squat delta draft values from March 13th, 2005 (DN 072) 
should be used until such a time or event warrants a new test. 
 
The POS MV GAMS calibration results from March 28th (DN 087) should be used until 
such a time or event warrants a new calibration.  
 
Future Modifications Planned: 
At the present time, installation of a dog-type latching mechanism is planned for launch 
1018.  The latch will be installed to permanently replace the ratcheting tie down strap 
and ensure the swing arm mount is stable and firmly up against the under hull stop.    
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Background: 
 
Launch 1018’s swing arm mount was stabilized by utilizing a ratcheting tie down strap to 
ensure that the swing arm was stable and firmly up against the under hull stop.  From 
testing discussed in Addendum 1 of this report and examination of data through August 
15, 2005 (DN 225) it is apparent that this solution works.   
 
A drawback of the swing arm mount occurs when the mount is lowered and debris can 
be caught between the swing arm and the under hull stop.  This changes the roll bias 
for the system and it is apparent in the data. 

Roll: 
 
On two occasions the roll value for Launch 1018 was affected by debris trapped 
between the swing arm and the under hull stop.  During evening processing the data 
was found to exhibit a roll which was not consistent with the current HVF value. 
 
On May 12th (DN 132), from 1600 through 2220 GMT, and August 6th (DN 218), from 
1726 though 2359 GMT roll bias issues were detected.  In each case data were 
examined by the Field Operations Officer and a roll bias was determined utilizing the 
acquired data in the CARIS HIPS/SIPS 5.4 Calibration routine.  The calculated roll 
biases were then entered into the .HVF for launch 1018.  Roll biases were then returned 
to the base value of 3.020 following the time of data acquisition.  Figure 1 shows the 
values in the HVF for Swath 1 on Launch 1018. 
 

 
Figure 1:  Screen grab of HVF Swath 1 settings on Launch 1018 

  
Data from May 12th and August 6th were remerged using the updated .HVF and were 
examined by the Field Operations Officer.  Data were found to meet or exceed the 
requirements in NOS Hydrographic Surveys Specifications and Deliverables, as 
updated for March, 2003. 
 
Recommendations: 
 
Roll bias results for May 12th and August 6th should be used for processing data on 
those respective days only. 
 
The patch test calibration results, HVF Bias values for March 30th (DN 089) & April 5th 
(DN 095) in table 3 of Addendum 1, should be used for processing data for those 
respective days only.   
 



The patch test calibration results listed in table 5 of Addendum 1 for DN 098 should be 
used for launch 1018 until such a time or event warrants a new calibration. 
 
The Optical Settlement and Squat delta draft values from March 13th, 2005 (DN 072) 
should be used until such a time or event warrants a new test. 
 
The POS MV GAMS calibration results from March 28th (DN 087) should be used until 
such a time or event warrants a new calibration. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



ADDENDUM 3 
NNOOAAAA  HHYYDDRROOGGRRAAPPHHIICC  SSUURRVVEEYY  LLAAUUNNCCHH  11001188  

VVEESSSSEELL  RREEPPOORRTT  22000055 
 

Background: 
 
On September 22, 2005, Launch 1018 ran aground while conducting shallow water 
multibeam.  The welds connecting the transducer to the swing arm sheared, and the 
transducer was lost. 
 
The launch was taken to Alaska Shipping and Drydock for repair work to the swing arm.  
Because the repair work involved welding, the IMU was also removed from Launch 
1018. 
 
The IMU and a new Reson 8101 transducer were reinstalled on the launch.  The offsets 
on the launch were measured, and a GAMS calibration and patch test were performed. 

Offsets: 
 
Launch 1018 was initially leveled and a full survey was conducted by NOAA personnel 
in 2004.  The full survey included several benchmarks welded to the launch, the GPS 
antennas, the phase center of the transducer, and the IMU.  Coordinates for all of these 
items were determined and recorded in the 1018 Offsets and Measurements 
Spreadsheets as an appendix in the NOAA Ship FAIRWEATHER Hydrographic 
Systems Certification Report 2005.  The grounding was not sufficient in nature to warp 
the frame of the boat, so the coordinates of the benchmarks welded to the launch did 
not change. 
 
In order to determine if the positions of the IMU and transducer had changed when the 
equipment was removed and reinstalled, the distances from the IMU and the phase 
center of the transducer to the nearest benchmark were measured in three dimensions.  
From these measurements, the xyz coordinates of the IMU and phase center were 
calculated. 
 
The measurements were taken with a steel tape to the nearest millimeter while Launch 
1018 was secured in its davit.  Though the Launch does not sit level in the davit cradle, 
the distance between the equipment and the benchmarks is sufficiently small that a 
slight incline of the vessel will not cause a significant error in the measurement.   
 
Additionally, the Applanix POS M/V, version 3, on the vessel only requires offsets to be 
measured within 3 cm.  Our measurements, as shown below in Table 1 and Table 2, 
indicate the equipment was measured within millimeters, and differed at most 1.8 cm, 
from its original position. 
 
 



Table 1: Calculating measured coordinates of the IMU
BM J 

Coordinates
Measured Distance from J 

to IMU (m)
IMU Measured Coordinates 

(2005)
IMU 2004 Survey 

Coordinates
Difference (m)

x 3.290 0.255 3.545 3.546 -0.001
y 0.004 -0.016 -0.012 -0.015 0.003
z -0.810 -0.043 -0.853 -0.859 0.006

Table 2: Calculating measured coordinates of the phase center of the transducer
BM H 

Coordinates
Measured Distance from H 

to Phase Center (m)
Phase Center Measured 

Coordinates (2005)
Phase Center 2004 Survey 

Coordinates Difference (m)

x 3.302 0.098 3.400 3.382 0.018
y 0.431 -0.161 0.270 0.287 -0.017
z -1.048 -0.357 -1.405 -1.409 0.004  

 
 
The “Benchmark Coordinates” column is the surveyed position of the benchmarks 
closest to the IMU and the phase center of the transducer.  The “Measured Distance” 
column is the distances measured with steel tape between the benchmarks and the 
equipment.  The “Measured Coordinates” column describes the coordinates of the 
equipment as determined by the measurements from the positioned benchmarks.  The 
“2004 Survey Coordinates” were the originally surveyed coordinates, based on the 
complete survey conducted in 2004.  Finally, the “Difference” column is the difference in 
coordinates between the 2004 surveyed coordinates, and the 2005 measured 
coordinates.   
 
The coordinates are in the theodolite coordinate system, as described in the 1018 2005 
Offsets and Measurements Document. 
 
Because the differences in the 2004 surveyed position and the 2005 measured position 
were smaller than the required 3 cm position and the differences were likely due to the 
launch not being level, the 2004 surveyed positions were retained as the best positions 
in the CARIS Hips Vessel File for Launch 1018. 
 
Patch Test: 
 
Following the reinstallation of the transducer and the IMU, a patch test was conducted 
for Launch 1018.  The first patch test was conducted on October 21, 2005 (DN 294), in 
the vicinity of Bradfield Canal, AK.  The patch test data were collected by SST Abrams 
and ENS Martin, following the patch test procedures outlined in the main body of the 
2005 1018 Vessel Report. 
 
Raw ISIS XTF data was converted to CARIS HDCS format.  Sound velocity and 
observed tides were applied upon conversion and the lines were “lightly” cleaned in 
CARIS swath mode to remove major data fliers.  The patch test data were then 
reviewed in CARIS calibration mode independently by LT(jg) Higgins, SST Abrams, 
SST Froelich, and ST Keene to determine the biases.   
 
During the processing, it became apparent that the patch test target was insufficient to 
determine pitch and heading biases.  Only the roll bias could be determined from the 
patch test.  The average of the roll values was retained as the best roll bias value. 
 
In order to resolve the pitch and heading biases, another patch test was conducted on 
Launch 1018 on October 26, 2005 (DN 299) in the vicinity of Madan Bay in Eastern 
Passage, AK.  The data were collected by ENS Gonsalves and SST Abrams.   



 
The patch test data were processed in the same manner as on DN 294.  ST Keene, 
SST Abrams, LT(jg) Higgins, and CST Morgan independently reviewed the data and 
determined pitch and heading biases.  The average of the pitch values and the average 
of the heading values were used as the best bias values available. 
 
Navigation timing latency was not tested, as the system configuration had not changed.  
Values from previous testing were retained.  Table 3 indicates the values applied to the 
CARIS Hips Vessel File and their sources. 
 
Table 3: Bias values

Timing Roll Pitch Heading
Value -0.01 3.39 -0.16 0.36

Source previous tests DN 294 Test DN 299 Test DN 299 Test  
 
The CARIS Hips Vessel File was updated with the values from Table 3 and dated to DN 
293.  The HVF was back dated because project data had been collected in the interim 
before the bias values were determined with finality. 
 
POS MV GAMS Calibration: 
 
POS MV GPS Azimuth Measurement Subsystem (GAMS) calibration occurred on 
October 21, 2005 (DN 294) In Bradfield Canal, AK. GAMS calibration was performed by 
SST Abrams and ENS Martin. 
 
The GAMS heading calibration threshold was set to 0.300°. Launch 1018 was 
maneuvered in “figure 8’s” to lower the heading accuracy as much as possible.  The 
best heading accuracy value achieved during this process was 0.028°.  The vessel 
steadied up on a constant heading and GAMS calibration was requested. When the 
calibration was complete, the POS MV settings were saved to the file 
1018_294_POSMV.nvm. 
 
The detailed POS/MV Calibration Report, POS_cal_report_1018_294.xls, is located in 
Appendix III-1018-5. 
 
Table 4 shows a summary of the calibration results. 
 
 

 

Component DN 294 Value 
Number of Satellites 

PDOP 
Baseline Vector X 
Baseline Vector Y 
Baseline Vector Z 

Two Antenna Separation 
Heading Correction 

7 
2.041 

0.009 m 
1.831 m 
0.031 m 
1.831 m 
0.000 ° 

Table 4: POS MV GAMS Calibration Results 
 
 
 
 
 



Recommendations: 
 
The patch test calibration results listed in table 3 of Addendum 3 dated on DN 293 
should be used for launch 1018 until such a time or event warrants a new calibration. 
 
The Optical Settlement and Squat delta draft values from March 13th, 2005 (DN 072) 
should be used until such a time or event warrants a new test. 
 
The POS MV GAMS calibration results from October 21, 2005 (DN 294) should be used 
until such a time or event warrants a new calibration. 
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NNOOAAAA  HHYYDDRROOGGRRAAPPHHIICC  SSUURRVVEEYY  LLAAUUNNCCHH  11001100  
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Background 
NOAA Hydrographic Survey Launch 1010 (Hull Registration Number 1010) is a 28 foot 10 inch 
aluminum survey launch designed by B. F. Jensen & Associates in 1973.  Various vendors built 
a series of “Jensen” launches for NOAA in the mid 1970’s to this general design and 1010 was 
the 10th in the series.  It is considered a Qualified Class II Motorboat within the NOAA 
classification system and is operated within the parameters required for a vessel of this type.   
 
In 2004, the hull, mechanical, electrical and mission systems underwent a modernization 
program that increased the performance and utility of the vessel.  These upgrades include hull 
strengthening, increased scantlings to accommodate a larger engine and propeller, hard top, 
new electrical systems including a 6kW hydraulic generator and dive platform.  Also added at 
this time was a new swing arm transducer mount for the Reson 8101ER multibeam echo 
sounder (MBES), designed by The Glosten Associates, Inc.  All modifications were conducted 
within the constraints as defined by the NAO 217-103, Management of Small Boats, Section 
6.03, Significant Alterations. 
 
Tests were performed to determine the residual biases of the sensors and sonar system 
alignment and settlement and squat.  Data were assessed in CARIS HIPS & SIPS v5.4 (SP 1, 
Hot Fixes 1-23) calibration and subset modes and applied to the HIPS Vessel File (HVF), 
1010_8101.HVF. 

Patch Test 
Patch tests were performed with NOAA Launch 1010 in the vicinity of Ketchikan, AK (See 
Figure 1) on March 12 & 13 (DN 071 and DN 072).  Data from both days were compared for 
system consistency by acquiring data on the same lines and comparing the results in CARIS 
HIPS Calibration.  The patch test data was collected by ST Keene, ST Kellner, ENS French, PS 
Palmer, and ECO Rheinheimer.  
 
Raw ISIS XTF data was converted to CARIS HDCS format.  Sound velocity and observed tides 
were applied upon conversion and the lines were “lightly” cleaned in CARIS swath mode to 
remove major data fliers.  The patch test data were then reviewed in CARIS calibration mode 
independently by CST Morgan, ST Keene, LT Wetzler, and PS Palmer to determine the biases.   
 
The patch test acquisition and processing logs are located in Appendix III-1010-3. 

Heading and Pitch 
The heading and pitch bias patch tests were conducted in Tongass Narrows over a 50 meter by 
10 meter wreck lying in an average depth of 42m and a least depth of 24m.  The wreck is 
located at 55°19’56.21”N, 131°37’52.09”W (see Figures 2 & 3). 
 
Heading 
The heading bias was determined by acquiring data on two sets of parallel lines run in opposite 
directions.  The pairs of lines were offset from the wreck 120m and 85m, respectively.  Vessel 
speeds was 4-6 knots.  Final values entered into the HVF were based on an average value 
between those involved. 
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Pitch 
The procedure used to determine the pitch bias was to run one pair of coincident lines over the 
wreck in approximately 42m of water at the same speed in opposite directions.  The lines were 
run between 4-6 knots. Final values entered into the HVF were based on a consensus value 
between those involved.  
 

 
Figure 1: Test sites for Launch 1010. 

Roll 
The roll bias patch was conducted in Blank Inlet over a locally flat area in approximately 60m of 
water at location 55°16’45.46”N, 131°39’37.03”W (see Figure 4).  Roll bias was determined by 
running one pair of coincident lines over the area at 6 knots in opposite directions.  Final values 
entered into the HVF were based on a consensus value between those involved. 
 

Pitch and Heading 
Patch test site (See 
Figures: 2&3) 

Roll Patch test site 
(See Figure: 4)

Settlement and Squat test 
site (See Figure: 6) 

Dynamic Draft test 
site (See Figure: 5) 

Navigation Time 
Error test site (See 
Figure: 5) 
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 Figure 2: Heading and Pitch patch test site for  Figure 3: Wreck used for Heading and Pitch patch 
 Launch 1010. test site for Launch 1010. 
 
 

 
Figure 4: Roll patch test site for Launch 1010. 
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Navigation Time Error 
The Navigation Time Error test was conducted on March 12, 2005 (DN 072) in Blank Inlet over a 
locally flat area at 55°17’11.72”N, 131°39’17.84”W (see Figure 5) in approximately 15 meters of 
water.  The data were acquired using a different form of the Roll patch test method.  Launch 
1010 traveled at a constant speed and then quickly reduced speed and turned parallel to its own 
wake, thus forcing a roll.  Final values entered into the HVF were based on a consensus value 
between those involved. 
 

 
Figure 5: Navigation Time Error test site. 

Patch Test Results 
The results of the patch test for Launch 1010 are summarized in Table 1, below. 
 

Patch Bias Bias value 
Navigation Time Error 0.01 sec 

Pitch 0.00° 
Roll 0.60° 

Heading 0.40° 
 

Table 1: Patch Test Bias Result 
 

Optical Settlement and Squat Test 
The Settlement and Squat test using the optical method was performed on March 13 (DN 072) 
in Blank Inlet at location 55°14’45.80”N, 131°40’58.58”W in approximately 40 m of water (see 
Figure 6).  Data were collected by CST Morgan, ST Keene, AST Kellner, PS Palmer, and ECO 
Rheinheimer. 
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Figure 6: Settlement and Squat test site for Launch 1010. 

 
Optical levels were used to determine settlement and squat biases.  The procedure included 
setting up on shore a Zeiss NI2 333 stadia level and placing a graduated metric staff on top of 
Launch 1010’s port side gas cap (see Figures 7 & 8).  The settlement and squat data were 
acquired at seven different speeds: 5, 6, 7, 8, 9, 10, and 11 knots.  Three different readings 
were taken for each of the seven speeds: one “at rest”, one as the launch was moving away “at 
speed”, and one as the launch was moving toward the shore team “at speed”. 
 
The computations and table of results are included in 1010_DDSSM Settlement and Squat 
located in Appendix III-1010-4.  The results are summarized in Table 2, below: 
 

Average Speed (knots) Delta Draft (m) 
0.0 0.000 

5.35 -0.01075 
6.25 0.021 
7.3 0.047 
8.2 0.064 

9.35 0.074 
10.4 0.045 
11.65 0.027 

 
Table 2: Settlement and Squat Results 
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 Figure 7: Settlement and Squat shore team Figure 8: Graduated metric staff on port side gas cap. 
 using optical level. 

Dynamic Draft Settlement and Squat Method (DDSSM) 
Due to an engine malfunction, the dynamic draft test was only partially collected on March 12 
(DN 071).  This data was not utilized for calibration.  The full dynamic draft test was run on 
March 13 (DN 072).  Lines were collected at location 55°13’11.17”N, 131°43’21.24”W in 
approximately 25m of water (see Figure 9).  The dynamic draft data was collected by ST Keene, 
ST Kellner, ENS French, PS Palmer, and ECO Rheinheimer. 
 
The procedure used to acquire data consisted of running one line four times in the same 
direction but at different speeds ranging from 5-11 knots.  At three points along the line, data 
were collected with the engine in idle (referred to as dead in the water, DIW, in the dynamic draft 
acquisition and processing spreadsheet).  However, line DIW1 was not used in processing 
because it was too far from the “at speed” lines to make a good comparison.   
 
SVP and observed tides were applied in CARIS HIPS and lines were “lightly” cleaned in CARIS 
swath mode to remove major data fliers. The data were then processed by LT Wetzler, CST 
Morgan, ST Keene, and PS Palmer using the Dynamic Draft Settlement and Squat Method 
(DDSSM) as documented in the Draft Field Procedures Manual (January 2005). 
 
Diversions from the FPM included also reviewing the lines in CARIS BASE Surface. These data 
were then processed in the same manner as the CARIS Subsets and compared to the Optical 
Settlement and Squat results by creating a scatter line chart in Microsoft Excel. Results were 
inconclusive because of too much variability and therefore the final delta draft values from the 
optical method were used.  DDSSM results were saved to 1010_DDSSM Settlement and 
Squat.xls located in Appendix III-1010-4. 
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Figure 9: Dynamic Draft test site for Launch 1010. 

 

POS/MV GAMS Calibration 
POS/MV GPS Azimuth Measurement Subsystem (GAMS) calibration was performed on March 
11 (DN 070) in Tongass Narrows (see Figure 1) by SST Froelich, ST Keene, and PS Palmer.   
 
The GAMS heading calibration threshold was initially set to 0.300°.  1010 was maneuvered in 
figure eights to lower the heading accuracy as much as possible.  The lowest heading accuracy 
value achieved during this process was 0.293°.  The vessel steadied up on a constant heading 
and GAMS calibration was requested.  The vessel failed to calibrate the first time for unknown 
reasons so a “forced calibration” was performed while the vessel was still steadied up.  This 
worked and the calibration completed successfully.  The POS/MV settings were then saved to 
the file 1010_070_posmv.nvm (see Table 3).   
 
A second calibration was performed on March 27 (DN 086) in Madan Bay (see Figure10) after 
re-calculation of physical measurements and after replacing the POS/MV antennas and a 
connecting wire that had malfunctioned for unknown reasons.  The GAMS calibration was 
performed by SST Abrams and ENS Gonsalves.  The POS/MV settings were then saved to the 
file 1010_086_posmv.nvm (see Table 3).  
 
 
 
 
 

 

Dead in the Water  
(DIW) 

DIW2 

DIW3 
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Figure 10: POS/MV GAMS Calibration test site DN 086 

 
The detailed POS/MV Calibration Reports, 1010_070_POS_Calibration.xls and 
1010_086_POS_Calibration.xls, are located in Appendix III-1010-5. 
 
 

Component DN 070 Value DN 086 Value 
Number of Satellites 8 9 

PDOP 2.430 Unknown 
Baseline Vector X 0.002 m 0.002 
Baseline Vector Y 1.833 m 1.833 
Baseline Vector Z 0.034 m 0.034 

Two Antenna Separation 1.833 m 1.839 
Heading Correction 0.000 ° 0.000 

Table 4: POS MV GAMS Calibration Results 

Recommendations: 
The patch test calibration results from March 12 & 13, 2005 (DN 071 & 072) should supersede 
prior bias determination values and should be used until such a time or event warrants a new 
calibration.   
 
The Optical Settlement and Squat delta draft values from March 13, 2005 (DN 072) should be 
used until such a time or event warrants a new test. 
 
The POS/MV GAMS calibration results from March 27, 2005 (DN 086) should be used until such 
a time or event warrants a new calibration. 
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ADDENDUM 1 
NNOOAAAA  HHYYDDRROOGGRRAAPPHHIICC  SSUURRVVEEYY  LLAAUUNNCCHH  11001100  

VVEESSSSEELL  RREEPPOORRTT  22000055 
 

Background 
Within a week of commencing acquisition, data from launch 1010 started to display signs of roll 
error.  It is believed that, similar to launch 1018, the swing arm mount is not stable from day to 
day.  Additional patch testing was conducted with NOAA launch 1010 in the vicinity of Wrangell 
Island, AK (see Figure 11) on numerous days by FAIRWEATHER personnel in the morning and 
evening. 
 
The procedure was to conduct a patch test before survey operations, collect data, and then 
patch test in the evening.  After processing the patch tests for the morning and evening, the 
HVF was then updated if necessary.  Sounding data was merged using the updated HVF and 
then examined for internal consistency.  Using this procedure, data meets IHO S-44 Order 1 
specifications. 
 
Tests were performed and data assessed as previously described, with differences noted below. 

Additional Patch Test 

Heading and Pitch 
The heading and pitch bias patch tests were conducted in The Narrows (Eastern Passage) over 
a rock with a radius of 35 m, in an area with an average depth of 40 m, with a least depth of 25 
m.  The rock is located at 56°21’52”N, 132°06’53”W (as in Figures 1 & 2). 
 
Heading 
The heading bias was determined by acquiring data on two sets of parallel lines run in opposite 
directions. 
 
Pitch 
Pitch bias was determined by acquiring data on two pair of coincident lines directly over the rock 
at the same speed but in opposite directions. 

Roll 
The roll bias test was conducted in Madan Bay over a flat area in approximately 90 m of water 
at location 56°23’00”N, 132°09’21”W (see Figure 4).  Roll bias was determined by running pairs 
of coincident lines over the area in opposite directions.  On some testing days, the roll lines 
were not acquired and the pitch lines were extended to include a flat area and used to 
determine the roll biases. 

Navigation Time Error 
No additional Navigation Time Error testing was performed.  Final values entered into the HVF 
are based on previous test results. 
 
For all tests raw Reson XTF data were converted to CARIS HDCS format.  Sound velocity and 
predicted tides were applied upon conversion and the lines were not cleaned or only “lightly” 
cleaned in CARIS swath mode to remove major data fliers. 



NOAA SHIP FAIRWEATHER 

 - 10 - 

 

 
Figure 11: Test Sites for launch 1010. 

Patch Test Results 
The results of three days of morning and evening patch testing are reported in Table 5, below. 
 

Patch 
Bias 

DN 096  
AM Bias 

DN 096  
PM Bias 

DN 097 
AM Bias 

DN 097 
PM Bias 

DN 098 
AM Bias 

DN 098 
PM1Bias 

DN 098 
PM2Bias

Pitch 
Roll 

Heading 

-0.76° 
0.54° 
0.42° 

-0.72° 
0.71° 
0.40° 

-0.17° 
0.74° 
0.51° 

-0.76° 
0.76° 
0.6° 

-0.34° 
0.72° 
0.45° 

 
0.74° 

 
0.78° 

 
Table 5: Patch Test Bias Results 

Patch Test Bias values used for data processing 
The bias values used in the HVF file for daily data processing during the three days of testing 
(corresponding with the days included in Table 5) are shown in Table 6. 
 

HVF Patch  
Bias Values 

DN 096  
HVF Bias  

DN 097  
HVF Bias 

DN 098 – DN099 AM 
HVF Bias 

Time Error 
Pitch 
Roll 

Heading 

-0.01 sec 
-0.7° 
0.7° 
0.4° 

-0.01 sec 
-0.17° 
0.75° 
0.56° 

-0.01 sec 
-0.34° 
0.74° 
0.45° 

Table 6: Bias Values Used in HVF for Data Processing 

Pitch and Heading 
Patch test site  
(See Figure: 2) 

Roll Patch test site 
(See Figure: 4) 
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Modifications and Additional Testing 
Modifications continued, in order to remedy the day to day fluctuations in biases.  On DN 098, 
launch 1010 modifications consisted of the pin no longer being used as the locking mechanism 
for the arm, the arm being ground down, and a ratcheting tie down strap employed to hold the 
deployment lever arm in position.  These modifications were made to ensure that the swing arm 
mount would rest on the stop under the hull when fully deployed (see Figure 12). 

 
Figure 12: Launch 1010 swing arm mount against hull stop. 

 
A new drill hole, for the tie down strap to anchor to, was bolted to the frame of launch 1010 on 
DN 101 (See Figure 13 & 14). 
 

     
 Figure 13: Rachet strap attachment point to arm.          Figure 14: Rachet strap attachment point to hull. 

Under Hull 
Stop 
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Patch Test Results 
The results of four days of morning and evening patch testing are reported in Table 7, below. 

 
Patch  
Bias 

DN 099  
AM Bias 

DN 099  
PM Bias 

DN 100 
AM1 
Bias 

DN 100 
AM2 
Bias 

DN 101 
AM Bias

DN 101 
PM Bias

DN 102 
AM Bias 

DN 102 
PM Bias

Pitch 
Roll 

Heading 

0.0° 
0.74° 
0.45° 

-0.30° 
1.06° 
0.45° 

-0.40° 
1.06° 
0.55° 

-0.35° 
1.05° 
0.48° 

-0.35° 
1.09° 
0.35° 

-0.35° 
1.11° 
0.35° 

-0.33° 
1.06° 
0.30° 

-0.2° 
1.08° 
0.30° 

Table 7: Patch Test Bias Results 
 
 
Patch Test Bias values used for data processing 
 
The bias values in the HVF file, used for daily data processing afternoon lines run on  
Dn 099 and the values used for data on and after DN 100, are shown in Table 6. 
 

Table 8: Patch Test HVF Bias Values 
 

Patch test processing logs are located in Appendix III-1018-3. 
 
Recommendations: 
The patch test calibration results, which should be used for processing the data on various days 
prior to DN 100, are listed in tables 6 and 8.    
 
The patch test calibration results listed in table 8 for DN 100 should be used for launch 1010 
until such a time or event warrants a new calibration.  
 
The Optical Settlement and Squat delta draft values from March 13th, 2005 (DN 072) should be 
used until such a time or event warrants a new test. 
 
The POS MV GAMS calibration results from March 27th (DN 086) should be used until such a 
time or event warrants a new calibration. 
 
Future Modifications Planned: 
At the present time, installation of a dog-type latching mechanism is planned for launch 1010.  
The latch will be installed to permanently replace the ratcheting tie down strap and ensure the 
swing arm mount is stable and firmly up against the under hull stop.   
 
 
 
 
 

HVF Patch  
Bias Values 

DN 099 PM  
HVF Biases  

DN 100 -  
HVF Biases 

Time Error 
Pitch 
Roll 

Heading 

-0.01 sec 
-0.30° 
1.06° 
0.45° 

-0.01 sec 
-0.35° 
1.09° 
0.4° 
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ADDENDUM 2 
NNOOAAAA  HHYYDDRROOGGRRAAPPHHIICC  SSUURRVVEEYY  LLAAUUNNCCHH  11001100  

VVEESSSSEELL  RREEPPOORRTT  22000055 
 

Background: 
 
Launch 1010’s swing arm mount was stabilized by utilizing a ratcheting tie down strap to ensure 
that the swing arm was stable and firmly up against the under hull stop.  From testing discussed 
in Addendum 1 of this report and examination of data through October 4, 2005 (DN 277) it is 
apparent that this solution works in most instances.  Future modifications of a swing arm 
placement indicator are under development. 
 
A drawback of the swing arm mount occurs when the mount is lowered and debris can be 
caught between the swing arm and the under hull stop.  This changes the roll bias for the 
system and it is apparent in the data. 

Roll: 
 
The roll value for Launch 1010 was affected by debris trapped between the swing arm and the 
under hull stop.  During final processing the data was found to exhibit a roll which was not 
consistent with the current HVF value. 
 
On August 27th (DN 239) roll bias issues were detected and affected all lines for the day.  The 
data were examined by the Chief Survey Technician and a roll bias was determined utilizing the 
acquired data in the CARIS HIPS/SIPS 5.4 Calibration routine.  The calculated roll biases were 
then entered into the .HVF for launch 1010.  Roll biases were then returned to the base value of 
1.090 from DN100 in a DN 240 entry.  Figure 1 shows the values in the HVF for Swath 1 on 
Launch 1010. 
 

 
Figure 1:  Screen grab of HVF Swath 1 settings on Launch 1010 

  
Data from August 27th were remerged using the updated .HVF and were examined by the 
Survey manager and Chief Survey Technician.  Data were found to meet or exceed the 
requirements in NOS Hydrographic Surveys Specifications and Deliverables, as updated for 
March, 2003. 
 

Recommendations: 
 
Roll bias results for August 27th DN 239 should be used for processing data on that respective 
day only.  Only sheet H11498 is affected by this issue. 
 
The patch test calibration results listed in table 8 for DN 100 should be used for launch 1010 
from DN 240 on, until such a time or event warrants a new calibration.  
 
The Optical Settlement and Squat delta draft values from March 13th, 2005 (DN 072) should be 
used until such a time or event warrants a new test. 
 
The POS MV GAMS calibration results from March 27th (DN 086) should be used until such a 
time or event warrants a new calibration. 
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ADDENDUM 3 
NNOOAAAA  HHYYDDRROOGGRRAAPPHHIICC  SSUURRVVEEYY  LLAAUUNNCCHH  11001100  

VVEESSSSEELL  RREEPPOORRTT  22000055 
 

Background 
After completion of project OPR-P158-FA in Orca Bay, AK, the hull mounted Reson 8101 was 
removed from Launch 1010 in order to strengthen the welds to the mount.  Once the transducer 
was reinstalled, a patch test was performed near Ketchikan, AK on October 4, 2005 (DN 277), 
with additional heading lines acquired on October 5, 2005 (DN 278).  Refer to Figures 1 through 
4 in the main report for patch testing sites. 
 
Raw Reson XTF data were converted to CARIS HDCS format.  Sound velocity correctors and 
zero tides were applied upon conversion and the lines were only “lightly” cleaned in CARIS 
swath mode to remove major data fliers. 
 
Additionally, because the transducer was removed and reinstalled, it was necessary to measure 
the offsets to the transducer to ensure its position hadn’t changed. 

Additional Patch Test 

Heading and Pitch 
The heading and pitch bias patch tests were conducted in Tongass Narrows over a 50 meter by 
10 meter wreck lying in an average depth of 42m and a least depth of 24m.  The wreck is 
located at 55°19’56.21”N, 131°37’52.09”W (see Figures 2 & 3). 
 
Heading 
The heading bias was determined by acquiring data in two sets of parallel lines run in opposite 
directions.  One set of lines was acquired on DN 277, with an additional pair run on DN 278.  
The pairs of lines were offset from the wreck 115m and 80m, respectively.  Vessel speed was 
approximately 7.0 knots.  Final values entered into the HVF were based on an average value 
between those involved, with the exception of SST Froelich, who was unable to determine a 
heading offset value in CARIS Calibration Editor. 
 
Pitch 
The procedure used to determine the pitch bias was to run one pair of coincident lines over the 
wreck in approximately 42m of water at the same speed in opposite directions.  The lines were 
run at approximately 7.5 knots. Final values entered into the HVF were based on an average 
value between those involved.  

Roll 
The roll bias patch was conducted in Blank Inlet over a locally flat area in approximately 60m of 
water at location 55°16’45.46”N, 131°39’37.03”W (see Figure 4).  Roll bias was determined by 
running one pair of coincident lines over the area at 7.2 knots in opposite directions.  Final 
values entered into the HVF were based on an average value between those involved. 

Navigation Time Error 
No additional Navigation Time Error testing was performed.  Final values entered into the HVF 
are based on previous test results. 
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Standard Deviations 
In the Launch 1010 .hvf, the “MRU Align StdDev Gyro” and “MRU Align StdDev Roll/Pitch” were 
previously defined as 0.000, because these values were unknown and undocumented in the 
CARIS Vessel Editor Help Manual.  According to Brian Calder of UNH, these error values are 
defined as the standard deviation of the bias values from all individuals evaluating the patch test 
data. 
 
The value entered in the .hvf for the “MRU Align StdDev Gyro” field was calculated from the 
standard deviation of all Heading bias estimates. 
 
The standard deviation of the roll bias estimates was averaged with the standard deviation of 
the pitch bias estimates to obtain a single value to be entered in the .hvf “MRU Align StdDev 
Roll/Pitch” field. 

Patch Test Results 
The results of the patch test for Launch 1010 are summarized in Table 1, below. 
 

Patch Bias Bias value 
Pitch -0.80° 
Roll 0.91° 

Heading 0.65° 
MRU Align StdDev Gyro 0.11 

MRU Align StdDev Roll/Pitch 0.11 
 

Table 1: Patch Test Bias Results 
 

Offsets: 
 
Launch 1010 was initially leveled and a full survey was conducted by NOAA personnel in 2004.  
The full survey included several benchmarks welded to the launch, the GPS antennas, the 
phase center of the transducer, and the IMU.  Coordinates for all of these items were 
determined and recorded in the 1010 Offsets and Measurements Spreadsheets as an appendix 
in the NOAA Ship FAIRWEATHER Hydrographic Systems Certification Report 2005. 
 
The distances in three dimensions from the phase center of the transducer to the nearest 
benchmark, benchmark H, were measured.  From these measurements, the coordinates of the 
phase center were calculated to determine if the coordinates had changed when the transducer 
was removed and reinstalled. 
 
The measurements were taken with a steel tape to the nearest millimeter while Launch 1010 
was secured in its davit.  The Launch does not sit level in the davit; however, the distance 
between the phase center of the transducer and the benchmarks is sufficiently small, that a 
small incline of the vessel will not cause a significant error in the measurement.   
 
Table 2 displays the measured values and calculations of the coordinates. 
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Table 2: Calculating measured coordinates of the phase center of the transducer
BM H 

Coordinates
Measured Distance from H to Phase 

Center (m)
Phase Center Measured 

Coordinates (2005)
Phase Center 2004 
Survey Coordinates Difference (m)

x 3.271 0.113 3.384 3.365 0.019
y 0.426 -0.160 0.266 0.273 -0.007
z -1.377 -0.349 -1.726 -1.729 0.003  

 
The “BM H Coordinates” column is the surveyed position of the benchmarks closest to the 
phase center of the transducer.  The “Measured Distance” column is the distance measured 
with steel tape between the benchmark and the phase center of the transducer.  The “Measured 
Coordinates” column describes the coordinates of the transducer as determined by the 
measurements taken.  The “2004 Survey Coordinates” were the originally surveyed in 
coordinates based on the complete survey conducted in 2004.  Finally, the “Difference” column 
is the difference in coordinates between the 2004 surveyed coordinates, and the 2005 
measured coordinates.   
 
The coordinates are in the theodolite coordinate system, as described in the 1010 2005 Offsets 
and Measurements Document. 
 
Offsets to equipment are required to be known within 3 cm for the functionality of the Applanix 
POS M/V, version 3, installed on Launch 1010. 
 
Because the differences in the 2004 surveyed position and the 2005 measured position were 
smaller than the required 3 cm position and the differences were likely due to the launch not 
being level, the 2004 surveyed positions are the best positions for use in the CARIS Hips Vessel 
File for Launch 1010. 

Recommendations: 
The patch test calibration results from October 4 & 5, 2005 (DN 277 & 278) should supersede 
prior bias determination values and should be used until such a time or event warrants a new 
calibration.  Values are entered under Dn 277 in the 1010_8101.hvf. 
 
TPE values – StdDev row three should supersede prior TPE standard deviation values, so that 
the new “MRU Align StdDev Gyro” and “MRU Align StdDev Roll/Pitch” values are included.  All 
other TPE values should remain the same. 
 
The offset values from the 2004 survey should be retained as the most accurate position, as 
there is no indication the equipment has moved, and the measured values contain a known 
slight error from the launch not being level when the measurements were taken. 
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ADDENDUM 4 
NNOOAAAA  HHYYDDRROOGGRRAAPPHHIICC  SSUURRVVEEYY  LLAAUUNNCCHH  11001100  

VVEESSSSEELL  RREEPPOORRTT  22000055 
 

Background 
On October 24, 2005 (DN 297), Launch 1010 was conducting multibeam acquisition on project 
OPR-O119-FA-05, survey H11507.  During the course of the day, the key way on the transducer 
arm, which connects the swing arm to the transducer mount, gave way.  This failure caused 
severe roll bias in the data, and resulted in the transducer not being able to be raised. 
 
Manual examination of the data in CARIS subset mode allowed the exact time of the key way 
failure to be determined (it occurred when the transducer was raised, the vessel transited, and 
the transducer was lowered again).  The data on DN 297 following the failure was rejected and 
recollected. 

The key way was repaired on board the FAIRWEATHER, and Launch 1010 was patch tested on 
October 26, 2005 (DN 299).   

Additional Patch Test 
The patch test data was collected in the vicinity of Madan Bay in Eastern Passage, AK by ST 
Kellner and PS Herzog.  The procedure as outlined in Addendum 2 was followed. 
 
The patch test was independently analyzed in CARIS Hips Calibration mode by SST Froelich, 
SST Abrams, LT(jg) Higgins, and ST Keene.   

Patch Test Results 
The results of the patch test for Launch 1010 on October 26 are summarized in Table 1, below. 
 

Patch Bias Bias value 
Pitch -0.69° 
Roll 3.08° 

Heading 0.42° 
MRU Align StdDev Gyro 0.26 

MRU Align StdDev Roll/Pitch 0.09 
 

Table 1: Patch Test Bias Results 
 

All of the bias values are based on averages of the evaluators.  Navigation time latency was not 
calculated because the system configuration did not change. 

Roll Issues: 
 
Data was collected on DN 299 and DN 300 and an HVF based on the above patch test results 
were applied.  However, further examination of the transducer swing arm revealed that although 
the transducer rested against the hull stop, there was some play in the transducer swing arm.  
After this was determined, data collection with Launch 1010 was discontinued for the remaining 
few days of the 2005 field season. 
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Recommendations: 
The patch test calibration results from October 26, 2005 (DN 299) should supersede prior bias 
determination values and should be used for data collected after that date.   
 
The data collected on and following DN 299 has been examined and meets NOS specifications. 
However, because there was still some doubt regarding the stability of the transducer arm, 
Launch 1010 was removed from surveying status until the keyway issue can be resolved during 
the winter import repair period. 
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SeaBat 8111 Noise Analysis 

1.0 Overview 
 
For mid and deep water sonar systems, noise emanating from the vessel on which the sonar is 
mounted is a major determinant in the performance of the sonar.   In addition to sources such as 
echosounders and other acoustic devices, such as doppler logs, mechanical noise from the 
engines and drive trains, and flow noise will also affect performance, with the magnitude of the 
noise varying with vessel speed. 
 
This document describes the noise analysis test done on the RESON SeaBat 8111 installed on 
the NOAA S/V Fairweather, on 11 October 2004. 

2.0 Test Conduct 
 
The following is a description of the system setup and test protocol used to test the SeaBat 8111 
multibeam sonar. 

2.1 Sonar Setup 
 
To determine the amount of in-band noise seen by the sonar, the system was configured as 
follows: 

 
Setting Value 
Power Off 
Gain Manual Fixed 20 
Range  100 meters 

 
Data collection was done using a RESON engineering utility, which collects the full amplitude 
and phase time series data from the sonar.  Figure 1 shows a sample screen capture, in this case 
one of the data sets taken at six knots, with a shaft speed of 140 RPM.  At least ten (10) 
collections were done for each test case, and the results for first 10 measurements each test case 
were averaged for the report. 

2.2 Vessel Operation 
 
Normal survey speed for the vessel is approximately 10 knots.  To bracket this range, and to 
check at possible lower survey speeds, the test protocol was defined to cover the range of 2 to 12 
knots, in 2 knot steps.  The tests were conducted at shaft speeds of 120 to 170 RPM, in 10 RPM 
steps, with the speed adjusted by changing the pitch on the propellers.  For each RPM value, the 
speeds that could be achieved at that shaft speed were tested.  A log of data collections for the 
tests is provided in Appendix A. 
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All the underway data collections were done in water depths of 120 to 160 fathoms.  The zero 
speed data collections, with the engines on, were done at anchor in about 30 meters of water, and 
out in the bay, at water depths of about 130 fathoms. 
 

 
Figure 1 - Snapshot Utility Screen Capture 

2.3 Data Analysis 
 
The data from each of the test cases were collated in an Excel spreadsheet, shown in Appendix 
B.  A graph of the measured noise levels, as a function of vessel speed and shaft RPM is shown 
in Figure 2.  The noise level is a unitless value that represents the average of all the amplitude 
samples, from all the beams for the sampled sonar ping.  This value represents a combination of 
the electrical noise in the sonar, and the response to all acoustic energy, within the bandwidth of 
the sonar, impinging on the receive array.   
 
For each the tests, the plot shows the noise level as a function of vessel speed.  Again, the tests 
were run at the speeds that could be achieved at the selected shaft RPM. 
 
In an effort to resolve the cause of the high noise levels at anchor seen in the 8160 tests, noise 
tests with the engines at idle (110 shaft RPM, 0 pitch) in both shallow and deep water.  In deeper 



 

 

  
 

 
Fairweather 8111 Noise Analysis Report Page 3 of 6
 

water, much lower noise levels were observed, apparently due to the greater attenuation of the 
noise from the various acoustic sources on the ship over the greater range. 
 

8111 Noise Analysis
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Figure 2 - Noise Plot 

3.0 Conclusions 
 

a. It appears that the best survey speed for the 8111, from a noise perspective, is in the 
range of 8 to 10 knots.  Both lower and higher speeds correlate with higher noise levels. 

b. It would be desirable to use shaft speeds of 140 RPM, or lower, to minimize the noise 
level seen by the sonar. 

c. Significantly increased levels of reverberation from acoustic sources on the vessel are 
seen in shallower water.  If this causes any degradation in the quality of the soundings in 
the 8111, increased power levels, higher than those recommended in the sonar settings 
guide, should be used to compensate. 
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Appendix A – Test Logs 
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Appendix B – Noise Analysis Spreadsheet 
 

 
 



PHB and FA Discussions of H11334 Survey Review 
Meeting Notes 

 
The Survey Certification Memo for H11334 was used as a guideline for discussion 
points.  The following Notes reference the relevant portions of that memo.  The double-
starred items (**) indicate actions to be taken and/ or requests for feedback. 
 

1. Exceptions to NOAA’s standards:   
“The areas addressed in the Descriptive Report referring to data that does not 
meet IHO Order 1 standards should be qualified as IHO Order 2, which for depths 
less than 100 meters does not meet NOS HSSDM requirements.” 

 
This point and the notes from the Survey Review Checklist were discussed and it 
was agreed upon that the BASE Surface should not be regarded as higher quality 
than the data itself, particularly in areas where the coverage contributing to 
computation of the BASE Surface is comprised primarily of outer beam data. 
 

2. PHB’s requests from FA: 
a. HDCS data that was removed from the submitted data set due to 

positioning problems should be submitted, with edits (if available). 
• FA deleted the edited HDCS data with positioning problems.  The 

XTF data still exists, unprocessed, but will have to be re-converted. 
• CST Morgan has agreed to submit the converted HDCS data.  She did, 

however, express considerable concern that the data be separated from 
the rest of the project data and used only to verify that no 
navigationally significant features exist in the areas lacking coverage, 
as stated in the DR. 

• **Further input is requested from PHB with regards to whether or not 
the HDCS data should be edited, prior to submission.  

• ** The HDCS data will be copied to a CD and I will submit it, upon 
returning from the FA to the office. 

b. The following remarks are in response to the detailed summary of 
discrepancies between the .hvf and the DAPR in the Survey Review 
Checklist, Comment 2. 
• The following Checklist comments relate to differences between Day 

Numbers, in the DAPR vs. .hvf’s:   
o 101_8101, comments a & d;  
o 1018_8101, comments a & b;  
o S220, comment a; 

In each of these cases, the .hvf Day Numbers were earlier than the 
patch test acquisition dates listed in the DAPR.  Both the CST and 
FOO confirmed that the acquired patch test values were used in .hvf’s 
that were defined with earlier dates so that the patch values could be 
applied to data that was acquired prior to the patch test data (other-
wise known as “back-timing”). 



• The following Checklist comments relate to differences between the 
Time Error as documented in the DAPR and the corresponding    
Swath 1 values in the .hvf’s: 

o 1010_8101, comment b; 
o 1018_8101, comment c; 
o S220, comment b; 

Both the CST and FOO explained that the Time Error can either be 
entered in the Swath 1 Time Error or the Time Error data fields in the 
Navigation, Gyro, Heave, Pitch and Roll categories, but does not need 
to be entered into all of those fields.  This explanation of the FA’s 
application of the latency correctors is consistent with H11334’s 
submitted .hvf’s.   
**It was agreed that this explanation of the application of their latency 
correctors should be documented in the DAPR. 
 

c. In the .hvf’s for 1010_8101, 1018_8101 and S220, the DAPR indicates 
that the “MRU Align StdDev Gyro” and “MRU Align StdDev Roll/Pitch” 
values are unknown, but these fields are defined as 0.000 in the .hvf’s.  
After discussing this amongst CO, FOO, CST and myself it was decided 
that the values are indeed unknown and, moreover, undocumented in 
Caris’ Vessel Editor Help Manual. 

 
The question of the meaning of these values was posed to Brian Calder 
from UNH, who is currently aboard the FA.  He explained that these error 
values are defined as the standard deviation of the error estimates for the 
“gyro” and “roll/ pitch” patch test values, as calculated from the 
compilation of these values from all of the individuals evaluating the patch 
test data. 
 
**I will email Caris to inform them of their lacking documentation with 
respect to the definition of these values in the Vessel Editor Help Manual. 
**The FA will calculate and enter these values into the .hvf’s, for future 
patch tests. 
 

3. The Survey Certification Memo contains an error that will be confusing to anyone 
reviewing it for future work.  In the section introduced with “Special attention 
should be given to…”, the first bullet contains the following statement: 
“The H11334_Office field sheet should be used by the Cartographers (instead of 
H11334_Final) to generate contours and soundings, since it does contain coverage 
for areas omitted due to positioning error (section B.2 of the DR).”   
Not only is this a double negative (as pointed out by the CO), but it implies the 
exact opposite action that the statement is intended to propose.   
 
**I will replace the statement with the following: 
“The H11334_Office field sheet should be used by the Cartographers (instead of 
H11334_Final) to generate contours and soundings, since the BASE surfaces in 



the office generated field sheet only contain coverage from data with acceptable 
positioning.” 
 

4. The second bullet point in the “Special Attention” section of the memo (and 
comment 5 in the Checklist) pertains to the version of the chart that was used for 
the Chart Comparison.   
 
This comment brought up concerns about the availability of charts that are 
updated mid-field season, and whether arrangements can be made for HSD to 
provide these to the field units throughout the field season.  Currently, the field 
uses the most updated charts that are available, as provided by HSD at the 
beginning of the field season.  The following suggestions were made, to remedy 
the problem of chart comparisons with outdated charts: 
 

• Could HSD make a formal request to receive the most up-to-date 
charts from MCD, and then send those updates out to the field, as they 
become available? 

• Should the field units consider going outside HSD to find an 
alternative chart updating service? 

• Should the question of which chart was used for the Chart Comparison 
continue to be addressed in the Survey Review process, if the ship 
does not have access to the most recent chart updates, but continues to 
adhere to the policy of using the most updated chart that is available? 

 
**Additional suggestions/ recommendations from PHB would be appreciated.   

 
The rest of the comments made in the Survey Certification Memo and the Checklist were 
noted and generally agreed upon. 

 
 



Subject: [Fwd: [Fwd: DGPS: P-checks & Nav DQA]] 
Date: Mon, 12 Sep 2005 18:22:20 -0800 
From: "foo fairweather" <foo.fairweather@noaa.gov> 
To: chiefst.fairweather@noaa.gov 
 
    --------------------------------------------------------------------- 
 
Subject: [Fwd: DGPS: P-checks & Nav DQA] 
Resent-Date: Mon, 12 Sep 2005 20:17:27 GMT 
Resent-From: FOO.Fairweather@noaa.gov 
Date: Mon, 12 Sep 2005 20:29:01 +0100 
From: "FOO Rainier" <foo.rainier@noaa.gov> 
To: _NMAO MOP FOO Fairweather <FOO.Fairweather@noaa.gov>, 
     abigail higgins <abigail.higgins@noaa.gov> 
 
Abigail, 
 
I assume you're checking FOO-FA now, so sorry if you get this twice. 
Anyway, here's the email from Gerd from the spring about P-checks.  Looks 
like it was a question from Lynn which prompted it in the first place. 
 
Ben 
 
-------- Original Message -------- 
     Subject: DGPS: P-checks & Nav DQA 
        Date: Wed, 25 May 2005 17:01:38 -0400 
        From: Gerd Glang <Gerd.Glang@noaa.gov> 
Organization: NOAA Hydro Systems & Technology Programs (301-713-2653, x152) 
          To: holly.dehart.atsea@noaa.gov 
          CC: Jack Riley <Jack.Riley@noaa.gov>, "Lynnette V. Morgan" 
              <Lynnette.V.Morgan@noaa.gov>, "Holly A. Dehart" 
              <Holly.A.Dehart@noaa.gov>, Benjamin K Evans 
              <Benjamin.K.Evans@noaa.gov>, Guy Noll <Guy.Noll@noaa.gov> 
  References: <793c68e7.68e7793c@fairweather.nmao.noaa.gov> 
 
Hi Holly (I hear my train leaving), 
 
Your "atsea" e-mail keeps getting bounced back...so I'm copying Lynn on 
this. 
 
Short answer - No. 
 
USCG Beacons are subject to their own rigorous integrity monitoring.  If the 
beacon signal is being received w/ good signal strength, it should be valid 
for correcting your position (simple answer).  The Specs and Deliverables 
requirements assume this. 
 
What we need to do is check that our receivers are working properly and no 
bogus antenna offsets were entered.  Probably adequate to do this once per 
season as part of the system cert, or when you suspect a problem.   Our MB 
data (and side scan data) are spatially dense enough that any problems would 
be apparent in the data right away.  Also, the several GPS failures we've 
experienced this year have all been pretty catastrophic, i.e., there was no 
doubt the POS GPS had failed.  Bottom line, it's not in the current draft 
FPM, its not in the Specs and Deliverables.  Should be a reqt for the System 
Cert process. 
 



So the two things I would require: 
 
1)   During data acquisition, conscientious monitoring of all sensor data 
(POS controller window, POS CPU lights, USCG Beacon Receiver display/lights, 
Isis display, etc). 
2)  During daily post-processing, a systematic and careful review of the 
data - treat as a directed editing problem. 
 
Of course, we often fiddle with acquisition system configurations, both 
hardware and software, for one reason or another (or some gremlin gets into 
the system).  It would be prudent to have a system cert-like checklist to 
run thru on Monday mornings after a long inport to prompt the 
briefly-befuddled or newly-trained OIC and chase Mr. Murphy away.  Sort of 
like a pre-flight checklist.  You may recall, we once had a case on the WH 
where an entire launch day (+4 hrs OT) of data was hosed because the Isis 
config was messed up the night before, and the JO's (who shall remain 
nameless but were nevertheless well qualified) didn't pay attention to #1. 
 
(The complacent hydrographer will soon go aground - GFG). 
 
BTW - RA has SonarPro for SSS (haven't used it much lately).   NRTs use 
SonarPro. 
 
G2 
 
Holly DeHart atsea wrote: 
 
> Hi Gerd, 
> 
> Lynn was asking me about comparing differential beacons, where you 
> take coincident positions w/ two systems on different beacons.  Sounds 
> like WH's old p-check system.  Do we still need to do these?  If so at 
> what frequency?  They've been doing it weekly all season w/ no errors, 
> is this still necessary? 
> 
> Holly 
> 
> 
 
-- 
LT Ben Evans, NOAA 
Field Operations Officer 
NOAA Ship RAINIER (s221) 
NOAA Marine Operations Center, Pacific 
1801 Fairview Ave. E 
Seattle, WA  98102 



1-Apr-05 cleaned 4616 and 4617 w/ Triton X-100

9-Apr-05 cleaned 4616 and 4617 w/ Triton X-100

10-Apr-05 performed DQA 4987 (MVP 200) and 4585

15-Apr-05 cleaned 4616 and 4617 w/ Triton X-100

1-May-05 cleaned 4616 and 4617 w/ bleach and Triton X-100

10-May-05 performed DQA 4585 and 4616 w/in specs.

13-May-05 cleaned 4616 and 4617 w/ Triton X-100

14-May-05 performed DQA 4585 and 4617 w/ in specs. 
cleaned 4585 w/ Triton X-100

24-May-05 cleaned 4616 and 4617 w/ Triton X-100

31-May-05 cleaned 4616 and 4617 w/ Triton X-100, performed DQA 4616 and 4987 w/ in specs

13-Jun-05 performed DQA 4585 and 4987 w/ in specs

16-Jun-05 cleaned 4616 and 4617 w/ Triton X-100, performed DQA 4616 and 4617 w/ in specs

26-Jun-05 cleaned 4616 and 4617 w/ Triton X-100

28-Jun-05 performed DQA 4987 and 4585 w/ in specs

18-29-July-05FOCI project nothing conducted

5-Aug-05 cleaned 4585 w/ Triton X-100 and bleach, performed DQA 4616 and 4617 w/ in specs

13-Aug-05 cleaned 4616 and 4617 w/ Triton X-100

14-Aug-05 performed DQA 4616 and 4617 w/ in specs, performed DQA  4585 and 4987 w/ in specs

14-Sep-05  cleaned 4585 w/ Triton X-100

16-Sep-05 cleaned 4616 & 4617  Triton X-100; note Launch 1018 was down for two weeks, CTDs were swapped out of Launch 1010, performed DQA 4616 and 4617 w/ in specs

23-Sep-05 cleaned 4616 and 4617 w/ Triton X-100

10-Oct-05 performed DQA 4585 and 4987 w/ in specs

11-Oct-05 cleaned 4617 w/ Triton X-100

27-Oct-05 cleaned 4616 and 4617 w/ Triton X-100, performed DQA 4616 and 4617 w/ in specs

5-Oct SV Measurement Comparison between Brooks Ocean Technology MVP 200 and Seabird SBE19+, see Oct-05 Report

5-Nov-05 cleaned 4617 w/ Triton X-100 (1018 is the only active launch)

6-Nov-05 performed DQA 4616 and 4617 w/ in specs

Fairweather CTD Maintenance 
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Sound Velocity Measurement Comparison 
Brooke Ocean Technology MVP 200 vs. Seabird SBE19+ 

ST Jennifer Keene, October, 2005 
 

Purpose: 
While in the Shumagin Islands project area 
during the summer of 2005, sound velocity error 
was noted in data acquired by the NOAA Ship 
FAIRWEATHER.  The water column in the area 
was extremely dynamic, so casts were taken at 
regular intervals using the Brooke Ocean 
Technology Moving Vessel Profiler 200.  Cast 
data were applied to the multibeam data using 
the method of Nearest in Distance within Time.  
Despite the number of casts applied, sound 
velocity error of up to 1.5m, in 60 to 90 meters of 
water, was still apparent in the outer beams of 
the data, as shown in Figure 1.  The vertical 
exaggeration is aproximately 251 times normal.   
 

 
Figure 1:  Sound velocity error in ship's data from Shumagin 

Islands project area. 

 
The source of the sound velocity error was 
believed to be inaccurate measurements made 
by the MVP 200.  To test this hypothesis, an 
experiment was designed to compare sound 
velocity measurements made with the MPV 200 
and a Seabird SBE19+. 
 
Equipment: 

• Brooke Ocean Technology MVP 200 
with AML Smart SV+P Sensor 

• Seabird SBE19+ CTD Probe 
• Velocwin Processing Software 
• Reson 8111ER Multibeam Echosounder 
• CARIS HIPS & SIPS v.5.4  

 
Procedure: 
While in Bradfield Canal in October, 2005, the 
FAIRWEATHER acquired a line of multibeam 

data with a Reson 8111ER at the normal survey 
speed of ten knots.  Three casts were taken with 
the MVP 200 without ceasing survey operations. 
Positions of the casts were noted by bridge 
personnel.  At the end of the survey line, the 
ship turned around and went back to the MVP 
cast sites, acquiring data during the transit.  The 
ship was stopped at each cast site and a 
stationary cast was done with the SBE19+, as 
well as a simultaneous cast with the MVP 200 
for comparison.  Track lines and cast sites are 
shown in Figure 2. 
 

 
Figure 2:  Ship track lines and sound velocity cast sites. 

 
Sound velocity data were processed with 
NOAA’s Velocwin software.  Three separate 
concatenated .svp files were created for the data 
sets; one for the MPV 200 casts taken while the 
ship was moving at 10 knots, another file for the 
stationary MVP 200 casts and a third file for the 
SBE19+ stationary casts. 
 
Multibeam echosounder (MBES) data were 
processed in CARIS HIPS & SIPS v.5.4.  The 
concatenated .svp file for the moving MVP casts 
was applied to the first line of MBES data, using 
the method of Nearest in Distance within Time.  
A copy of this line was created, and sound 
velocity correctors from the SBE19+ casts were 
applied by the same method.  This allowed 
different sound velocity correctors to be applied 
to identical MBES data, eliminating other factors 
affecting data quality.  For further comparison, 
the concatenated file from the stationary MVP 
casts was applied to the MBES data acquired 
while the ship transited in the reverse direction, 
going back to the cast sites.   

1 2 
3
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Results: 
The MBES data sets are shown in Figure 3, 
where the tan data points have sound velocity 
correctors from the moving MVP casts applied, 
the green data points use the SBE19+ 
correctors and the stationary MVP casts were 
applied to the blue data points. 
 

 
Figure 3:  Multibeam data with various sound velocity 

correctors applied.  

   
There is some roll error evident in the data set, 
but it is also apparent that the data in the green 
and tan lines, which should be identical, do not 
match up in the outer beams.  There is a 
difference of approximately one meter in 280 
meters of water. 
 
Cast data were imported to Excel, where 
comparison graphs were created.  Sound 
velocity profiles were created at the three cast 
sites for each insturement. For  comparisons 
shown in Figures 4 through 6, the blue line is 
data from the MVP 200 at 10 knots, the pink line 
is data from the stationary MVP 200 cast and 
the yellow line represents the SBE19+ data. 
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Figure 4:  Sound velocity profiles from Position 1. 
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Figure 5:  Sound velocity profiles from Position 2. 
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Figure 6:  Sound velocity profiles from Position 3. 

 
The SBE19+ and stationary MVP 200 casts 
were performed simultaneously and were 
separated in time from the moving MVP 200 
casts by no more than two hours.  The profiles 
were not identical, but agreement appeared to 
be good. 
 
Further comparison was made between the 
MVP 200 and the Seabird SBE19+.  The sound 
velocity measured by the SBE19+ was 
subtracted from the values measured by the 
MVP 200 at 10 knots over a depth range of 
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three to 100 meters.  The comparison results for 
each cast site are shown in Figure 7. 
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Figure 7:  Difference between sound velocities measured by 

MVP 200 at 10 knots and stationary SBE19+. 

 
The greatest differences between the profiles 
occur near the water’s surface.  During normal 
survey operations, the MVP 200 is generally 
operated from a depth of three to four meters 
below the surface.  The SBE19 is capable of 
acquiring measurements much nearer the 
surface. 
 
Conclusions: 
During this experiment, sound velocity 
measurements made by the MVP 200 at 10 
knots were compared to data acquired with a 
SBE19+.  The sound velocity profiles generated 
by each instrument for three different cast sites 
were in good agreement.  Sound velocity error is 
not readily apparent in MBES data. 
 
The sound velocity error noted in the Shumagin 
Islands project area may have been 
exaggerated by the dynamic water column and 
flat bottom topography.  Automatic vertical 
exaggeration in CARIS subset editor may have 
caused the error to appear more substantial.  
However, there was error present in the data 
and it is believed that the high density of sound 
velocity casts should have minimized this error. 
 
It is possible that there is some surface effect 
causing problems in the data, due to the fact 
that the MVP 200 is not configured to get sound 
velocity data above three to four meters depth 
while the ship is moving at survey speed.  
However, the ship’s draft puts the transducer at 
a depth of approximately four meters.  Data 

should not be affected by missing sound velocity 
measurements above this depth. 
 
SST Grant Froelich believes that there may be a 
calibration problem with the MVP 200, due to 
rust on the calibrated spacers.  Figure 8 shows 
the current state of the MVP 200 sensor, 
compared to the new sensor shown in Figure 9.  
It should also be noted that sound velocity 
problems were not seen in ship’s MBES data 
until after the sensor struck the hull.  Unseen 
damage or misalignment may have occurred. 
 

 
Figure 8:  Rusted MVP 200 sensor. 

 

 
Figure 9:  New MVP 200 sensor. 

 
Results of this experiment are inconclusive.  The 
area where this experiment was performed was 
not ideal, due to the extreme bottom topography.  
Further testing should be done in an area with a 
flat bottom during system certification for the 
2006 field season. 
 
It is recommended that the MVP 200 AML SV+P 
sensor be cleaned and calibrated during the 
winter inport.  Also, a CTD sensor should be 
purchased for the MVP 200 when funds allow, 
as CTD sensors have been shown to provide 
more accurate sound velocity measurements 
than direct sound velocity probes. 
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Survey Management 
 

0.0 Document Scope 
 
This document is meant to be used as a guideline for survey managers to insure that surveys are 
completed properly.  There is a general order to this list.  Some things have to be done in order, 
while others, like the Coast Pilot, DR and Final Fieldsheet prep can be started in advance.  This 
document can be used in conjunction with the R:\Utilities\II_Forms_Lists_and_Templates\ 
4_Quality_Control\QC Checksheet.  Copy and rename to H#####_QC_Checksheet and put it into 
your Survey_Files\Quality_Control folder.  This document and the QC_Checksheet should match 
fairly closely, beginning with the Post Acquisition section.  
 
1.0 Survey Planning 
 
Survey planning begins before arriving at the survey area and continues throughout the project. 
 

1.1 Letter Instructions 
 

Read and understand the project letter instructions, located here: H:\OPR-XXXX-FA-
Project\Project_Reports\I Letter_Instructions. 

 
1.2 Manager Responsibilities 

 
The survey manager is responsible for creating polygon files, a shoreline workspace, 
boat sheets, setting up projects on the launches (including suitcase shoreline and ship if 
necessary for your survey).  In addition, the Survey Manager is responsible for directing 
the daily work schedule (polygon plans and chartlets) of launches assigned to acquire 
data on the survey.  See: 
R:\Utilities\FA_SOP\0_Management\File Management\Survey File Management  
R:\Utilities\I_FA_SOP\1_Presurvey\Shoreline\Shoreline_Presurvey.doc 
R:\Utilities\FA_SOP\1_Presurvey\AWOIS_Presurvey\ AWOIS_Setup.doc 
R:\Utilities\FA_SOP\1_Presurvey\Creating_DelphMap_Projects_SOP.doc 
R:\Utilities\FA_SOP\2_Acquisition\Shoreline\Shoreline_Guidelines 

 
2.0 Acquistion 
 

2.1 Planning Multibeam Polygons 
 
To convert Notebook polygons to shape files for DelphMap, see: 
R:\Utilities\FA_SOP\1_Presurvey\Notebook Polygons to DelphMap.doc 
 
The purpose of drawing polygons is to guide the launch crew acquiring multibeam data.  
Try to set them up in such a way that turns are minimized and lines are manageable 
length for processing.  Be aware of any possible sources of fresh water, or other factors 
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that will affect the water column and make smaller polygons in these areas.  Ask the 
launch crew to do more CTD casts in these areas. 
 
Remember to update your near shore polygons using the shoreline buffer, shoreline 
updates and new features to determine the inshore limit of hydro.  Review polygons with 
shoreline data so you don’t accidentally send a SWMB boat over a new rock, or into an 
area that is too shoal.  Also, use the Buffer Lines that were collected to edit your near 
shore polygons. 
 
DO NOT send multibeam boats inshore of the eight meter curve until shoreline 
verification has been run in that area.  Once shoreline has been run, export your new 
features from Pydro to be brought into DelphMap for use by the multibeam boats during 
near shore acquisition. 

 
2.2 Data Cleaning 
Any time multibeam data is acquired on your sheet, check in with the evening processors 
at the end of the day.  Ask if they noticed any problems in the data, such as sound 
velocity or excess noise.  Use this information when planning the polygons for the next 
day.  It’s also a good idea to keep on top of the data cleaning.  This will make 
assessment of coverage more accurate. 
 
2.3 Cross Lines 
 
Cross lines are necessary for quality control checks of data.  Looking at nadir beams 
from cross lines with outer beams of mainscheme lines, errors in the data such as sound 
velocity problems become much more apparent.  Plan to get enough linear nautical miles 
of cross lines to equal 10% of the total linear nautical miles acquired on the sheet.  This 
will insure that the specified 5% is met. 
 
2.4 Shoreline 
Keep on top of it!!!  When you get back from an early morning out in the cold rain, all you 
want to do is take a hot shower and a nap.  Don’t give in to the temptation.  Bring the DPs 
into Pydro and transfer remarks from the boat sheets to Notebook layers as soon as 
possible.  Otherwise, you will forget what you meant in those cryptic notes and cartoon 
drawings.  This will also help insure that everything gets addressed.  Stay on top of it.  
Don’t put it off! 
 
Insure that shoreline verification is conducted in accordance with the Letter Instructions 
and that adequate annotations are made in the field to allow for complete description of 
the shoreline environment. 
 
2.5 Survey Log 

 
Keep a survey log in addition to the daily acquisition and processing logs to note any 
problems during the survey, or deviations from the DAPR.  This will be useful when 
writing the DR. H#####_Survey_Log.doc should be in the Survey_Files\Quality_Control 
folder.  Update the log on a daily basis when data is being acquired on the sheet, 
whether it be multibeam or shoreline.  It is also a helpful place to put processing notes 
and screen grabs of problem data for possible use in the DR. 
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3.0 Post Acquisition 
 
These steps are intended to be followed both during acquisition and immediately after data 
acquisition has been completed for the survey.  The order should be generally the same as that 
of the QC Checksheet, offering more detail for following those steps. 
 

3.1 Quality Control and Assessment of Soundings 
 

During acquisition of data, the Sheet Manager is responsible for analyzing the quality of 
the soundings and insuring coverage and sounding density.  Before leaving the survey 
area, the Sheet Manager must review the BASE child layers, using subset mode to check 
for sound velocity and tide problems, as well as checking for ample coverage, especially 
over navigationally significant areas.  Unverified observed tides are usually available 
within a day or two and can then be applied to the data.   
 
It may be beneficial to create a subset tile layer in CARIS to keep track of areas that have 
been reviewed.  This review is not cleaning in subset.  It’s just a quick look in subset 
mode for lines that may not have been cleaned properly, holidays, SV, tide and other 
problems with the data.  Have the BASE surfaces open in CARIS and use different sun 
illumination angles.  Problem areas will look suspect. 

 
3.2 Check for Immediate DTON’s 
 
Look for any items in the bathymetry which are extremely navigationally significant.  
These items should be brought to the attention of the FOO and the CO immediately, so 
they can be added to the relevant charts as soon as possible.  Otherwise, the regular 
DTON review occurs at the end of post processing. 
 
3.3 Document Deviations from DAPR 
 
Be familiar with the System Certification Report for the year and DAPR for the project.  
Any deviations from the aforementioned reports should be recorded in the survey log, or 
the acquisition and processing logs for possible inclusion into the DR if necessary.  
Changes to the HVF, or other unusual steps taken during data acquisition or processing 
should be noted and explained in the DR.   
 
 
3.4 Shoreline Data Review 
 
Review Pydro and Notebook sessions, photos and DP forms for completeness prior to 
leaving the survey area.  Pydro PSS features should be completely addressed, with the 
Chart, Significant, Primary and Report flags checked where applicable.  See: 
R:\Utilities\I_FA_SOP\3_Processing\Shoreline\Pydro_Shoreline_Processing.doc 
R:\Utilities\I_FA_SOP\3_Processing\Shoreline\Notebook_Shoreline_Processing.doc 
R:\Utilities\FA_SOP\3_Processing\Pydro\Pydro Logic_SOP.doc & Pydro Editor Notebook_SOP.doc 

 
3.5 AWOIS Items 
 
Insure that all AWOIS items listed for the survey are either verified or disproved through 
methods listed in the AWOIS database technique section, provided from the AWOIS 
database.  Refer to the AWOIS section of the Field Procedures Manual v1.1 for further 
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information.  Update the AWOIS database using Pydro.  If there are questions about 
which method is best for a particular item, consult the FOO, CST or an SST. 
 
3.6 Coast Pilot Updates 
 
The Coast Pilot should be updated while still in the survey area.  Don’t put it off!  If a 
Coast Pilot exists for the survey area, the Coast Pilot officer will place a copy of the 
relevant section in H:\OPR-XXXX-FA\Surveys\HXXXXX\Survey_Files\Coast_Pilot.  Read 
through the section and verify the existing text.  Reference depths, bottom samples and 
shoreline information as needed to update relevant paragraphs.  See: 
R:\Utilities\FA_SOP\4_Deliverables\Coast_Pilot\Coast Pilot Survey PIC Instructions.doc 
 
The HXXXXX _CP_Update.doc should be saved in:H:\OPR-XXXX-FA-Project 
\Project_Reports\IV Coast_Pilot 
 
3.7 Smooth Tide Request 
 
Request for Smooth Tides letters should be drafted and submitted as soon as all survey 
acquisition is completed.  These requests do not need to wait until all data processing is 
complete or the DR has been written.  See: 
R:\Utilities\FA_SOP\4_Deliverables\SmoothTides\Smooth Tides Request.doc 
 
All of the files should be saved in: H:\OPR-XXXX-FA-Project\Surveys\HXXXXX\ 
Descriptive_Report\Appendices\III Smooth_Tide_Request 
 
3.8 Create Survey Outlines 

 
For step by step instructions on creating the survey outline and appropriate MapInfo 
tables, see: 
R:\Utilities\I_FA_SOP\4_Deliverables\Survey_Outline\Creating_Survey_Outlines_in_CARIS.doc 
 
All of the outline files should be saved in: H:\OPR-XXXX-FA-Project\Surveys\HXXXXX\ 
Descriptive_Report\Appendices\II Survey_Outline 
 
3.9 Apply Observed or Verified Tides to HIPS Data 

 
Using CARIS HIPS, open the file in Tide Editor to insure that it looks OK.  Look for fliers 
and for problems with the data, such as a shift up or down in one section of the data, or 
any discontinuities.  Make sure that all acquisition days are included in the tide file.  Be 
sure that there is a buffer of one extra day at the end of the file, or before any gaps in 
acquisition days.  This will cover any data collected after midnight GMT.  Alert the tides 
people if you see a problem, so it can be corrected.  If you can’t find, or don’t know which 
tide file to use, check with the tides people. 
 
At the end of acquisition, load the observed or verified tides with the zone file to all lines 
and DPs, then remerge the data. 

 
3.10 Review Sound Velocity Files 
 
1) Check all SVPs, using CARIS Sound Velocity Editor to look for any fliers or other 

problems with the cast.   
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2) Display SVP Positions in CARIS with the MBES data open to look for any gross 
positioning errors.   

3) From the HDCS_Data folder, select the folder for one line from each boat day.  Use a 
text editor to compare the SVP file listed to the cast that the acquisition log query lists 
as being applied.   

4) Make sure that all casts listed in the acquisition logs have been copied to the 
appropriate folders to be applied to the data. 

5) Insure that the master concatenated file contains all SV files for that vessel. 
6) If discrepancies are found, assess whether SV should be re-applied.  
 
3.11 Query All Lines and Features 
 
The data query is a mechanism to check all your HDCS lines for SV casts, tide file 
application, vessel speeds, etc., as well as # of Raw files compared to # of HDCS folders. 
Getting them to match is the tricky bit.  In addition there is a format for checking Pydro 
files to raw files and ensuring the number of features match in Pydro and Notebook.   
 
Check the CARIS H#####_QC session to make sure that it contains all MBES lines.  
There should not be any DP files in the subset cleaning session.  Query all HDCS lines 
and save the results in the H#####_Data_Query.xls, which can be found in the 
Survey_Files\Quality_Control folder.  If it’s not there, the blank data query form to use is 
located in: 
R:\Utilities\II_Forms_Lists_and_Templates\4_Quality_Control\HXXXXX_Data_Query.xls. 
The (QCCheck) MBES QC Ssn Date and (QCCheck) DP-GP-BS Date tabs are to be 
completed by the Survey PIC as part of the QC Check.   
 
Use Notebook shoreline session and Pydro PSS to complete the DP-GP-BS query tab. 
 
Check that the appropriate tide file has been applied and that the SV profile makes sense 
as far as time and position.  Compare this query with the original queries recorded in the 
acquisition and processing logs and investigate any discrepancies.  
 
3.12 Review Acquisition and Processing Logs 
 
Go back through all the daily acquisition logs.  Look for notes from the acquisition crew 
and night processors regarding any possible problems with the data.  Check the affected 
lines or areas in CARIS HIPS.  Be familiar with your data set and know what’s going on.  
Discuss any problems, such as not meeting IHO spec, in the DR. 

 
4.0 Post Survey 
 
These steps outline the process for final review of data before submission, continuing to follow 
the QC Checksheet. 
 

4.1 Quality Control and Data Review 
 
The Survey Manager must review the entire survey area in subset mode, using the 
H#####_QC session in CARIS HIPS.  Refer to: 
R:\Utilities\\FA_SOP\3_Processing\CARIS HIPS\Bathy_Processing_SOP.doc 
 
It may be helpful to create a subset tile layer for the entire survey to keep track of which 
areas have been checked.  This requires a surface that is up to date and contains all 
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MBES lines.  The CARIS session should not include any DPs or BSs.  The 
recommended tile size for a 1:10,000 scale survey is 20m.  Bigger than that causes 
overlap between subsets to be too large and smaller is not necessary. 

 
4.2 Designate Soundings 
 
Use CARIS Subset Editor to review the data with a BASE surface in the background.  
Designate soundings in areas where the surface doesn’t match the highest point of the 
data.  Refer to: R:\Utilities\\FA_SOP\3_Processing\CARIS HIPS\Bathy_Processing_SOP.doc 

 
Depth Threshold BASE Surfaces must be finalized in H#####_QC session for designated 
soundings to take effect and become critical soundings that will be submitted with data.  
 
If you make a mistake in designating soundings or remove/add critical soundings after 
you have displayed the critical soundings in CARIS, you must delete the .hcsidx file that 
resides in your HDCS_DATA folder and then redisplay critical soundings to get them to 
display in CARIS.   

 
4.3 Depth Checking for Flyers 
 
Using CARIS Fieldsheet Editor, create contours and soundings in the H#####_QC 
session.  Review the entire survey area and check areas with bulls eye contours or 
questionable depths using subset or line mode.  Also use the BASE surface child layers 
to look for problems in the Shoal, Deep or Standard Deviation layers. 
 
4.4 Chart Comparisons 

 
New Method: From Fieldsheet Editor in HIPS, export soundings (contours can be helpful 
too) from BASE surface (2m or 5m resolution) to S-57.  In Notebook, open the .000 file 
with the applicable charts.  To have the soundings display in fathoms, go to 
Tools/Options/Units, click Depth Units as US Survey Fathoms and Sounding Display 
Units as Fathoms.  Compare the surveyed depths to the charted values.  Note any areas 
of discrepancy in the DR.  Otherwise, give a general degree of agreement between the 
survey and charts. 
 
Old Method: Make sure the BASE surface has been recomputed in CARIS HIPS.  In 
Pydro, select appropriate units (FATHOM), insert BASE/weighted grid, select appropriate 
surface (2m or 5m), and review depths (PVDL, BASE/WGRID needs to be 
BASE/WGRID) with the appropriate chart in the background.   
 
Write up results in the DR.  Also, check the latest Local Notice to Mariners for the most 
recent updates to the chart. The .kap file header will tell you the NTM that has been 
applied to it if you open it in Wordpad. 
 
4.5 DTONs 
 
For information on selecting DTONs, refer to: 
R:\Utilities\FA_SOP\4_Deliverables\DTONs\Selecting DTONs.doc 
 
Select any possible DTONs in CARIS and mark soundings as outstanding or designated.  
Insert the item as a HIPS/SIPS Line Feature in Pydro and check the DTON flag.  Also, 



 

Process Owner: Lynn Morgan 
Updated: 10/11/2005 
Location: R:\Utilities\FA_SOP\0_Management 

Approval: CST FAIRWEATHER 
Approval Date: 12/23/04 Page 8 of 12 

  

FAIRWEATHER SURVEY 
 

Doc No. 
SOP-6XX PROCEDURE 

 

Document Title 
SURVEY MANAGEMENT  

Version 
1 

Effect Date: 
Dec 23, 2004 

new DPs/GPs can be possible DTONs, so review the new features and check the DTON 
flag if applicable.  E-mail the FOO to review the possible DTONs in the PSS. 
 
Once the DTONs have been approved by the FOO, continue with the instructions given 
in: R:Utilities\FA_SOP\4_Deliverables\DTONs\DTONS_Procedure_XML.ppt 

 
In Pydro, make sure all Remarks and Recommendations tabs have been filled in and 
then export an .xml of the DTONs.  This is easily done through Pydro, from the Reports 
menu, choose Danger to Navigation.  Have the FOO review the .xml and e-mail it to 
MCD, CC-ing the Sheet Manager.  A digital copy of the e-mail should be kept in the PSS 
folder.  This PSS folder should also include the H#####_DTON.xml and the 
H#####_DTON_Report. 
 
4.6 Field Products 
 
A CARIS Notebook session should be created for the survey, which includes all shoreline 
and bottom sample data.  For the proper procedures, refer to: 
R:\Utilities\FA_SOP\3_Processing\Notebook_Shoreline_Processing.doc 
R:\Utilities\FA_SOP\3_Processing\Pydro_Shoreline_Processing.doc 
R:\Utilities\FA_SOP\3_Processing\CartoAction_Flagging.doc 

 
4.7 Create Depth Threshold BASE Surfaces 
 
The H#####_QC session should contain all SWMB lines, but none of the DP or BS files.  
The fieldsheet can contain any BASE surfaces used during processing, but should also 
contain finalized BASE surfaces, with the appropriate depth thresholds.  It could also 
contain soundings and contours to be used for review.  Refer to the Digital Submission 
Checksheet for required depth ranges and resolutions of BASE surfaces. 
 
The H##### session should contain a field sheet with non-finalized BASE surfaces.  
These surfaces should be named to reflect the resolution and depth ranges used for the 
finalized surfaces in the QC session. 
 
4.8 Preliminary Smooth Sheet (PSS session in Pydro) 
 
Open the PSS in Pydro.  Use the Data Stats function to make sure that the data is not 
stale or outdated.  Check the shoreline and bottom sample DPs to insure that the 
appropriate flags are checked, the Remarks and Recommendations tabs are filled in as 
necessary and that correctors have been properly applied.  Everything should be 
Resolved.  If you didn’t complete the data query above, do it now.  Check to make sure 
everything matches in Pydro and Notebook.  Scan the DP forms and save them to the 
DP log folder.  Finally, generate a Features report as described in: 
R:\Utilities\I_FA_SOP\4_Deliverables\Shoreline Report\Generating a Shoreline Report.doc 

 
4.9 Descriptive Report 
 
In the DR, the Survey Manager describes what, where, why, when, how and with whom 
the survey was conducted.  The DR is a legal document and can be brought up in court 
to prove (or disprove) the accuracy of the survey.  Go to the template: 
H:\OPR-XXXX-FA-Projects\Surveys 
 
Save a copy to the survey folder: 
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H:\OPR-XXXX-FA-Project\Surveys\HXXXXX\Descriptive_Report 
and name it H#####_Descriptive_Report.  Use the survey log and acquisition and 
processing logs to write about any issues encountered, or deviations from standard 
procedures. 

 
4.9.1 Cross Line Analysis 
 
Review crossline areas in subset mode.  Discrepancies need to be investigated 
and written about in the DR if necessary.  
 
With all MBES lines inserted into Pydro by type (Mainscheme or Checkline), use 
the built in function in Pydro to determine the mileage, or the Data Query mileage 
from CARIS could be utilized. Calculate the percentage of cross lines to 
mainscheme and report it in the DR.  If requirements were not met, be sure to 
include an explanation.  

 
4.9.2 Junction and Prior Survey Comparisons 
 
Examine Junctions and Prior surveys in CARIS subset mode or Fledermaus (if 
possible).  Measure the distance for a general difference range and note if 
agreement was good or not.  Major discrepancies should be investigated and 
addressed in DR. 

 
4.9.3 Discussion of Issues and Deviations from Standards 
 
It is important to discuss any problems with the data, or processes that were 
done differently than those described in the DAPR. 
 
4.9.4 Shoreline 
 
Disprovals and anything ambiguous, about which further information would be 
helpful to the cartographer, should be flagged for Report in Pydro.  Most 
shoreline discussion items will be in Pydro, if something was not positioned or 
could not be brought in as a GP, it will need a paragraph in the DR to address 
the item.  A general write-up on how shoreline was conducted, what programs 
and processes were used, and any deviations from shoreline procedures outlined 
in the DAPR should be included in the shoreline section of the DR. 
 
4.9.5 Cover & Title Pages / Approval memo 
 
Copy the Excel/Word templates from the Project survey folder into the DR folder 
for the survey.  Fill in all fields with information from the project letter instructions 
and acquisition and processing logs. 
 
4.9.6 Digital Images 
 
Limits of Hydrography.jpg and Junctions.jpg are created in MapInfo with the 
survey limit displayed.  These images should be saved to the survey Misc folder, 
NOT in the Descriptive Report folder.  Insert the images directly into the DR.  The 
digital images do not get submitted separately. 
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4.10 DR Appendices 
 
4.10.1 Shoreline and AWOIS Item(s) Report 
 
From Pydro, generate a Survey Feature Report, as described in: 
R:\Utilities\I_FA_SOP\4_Deliverables\Shoreline Report\Generating a Shoreline Report.doc 
Save the report to Appendix I. 

 
4.10.2 Survey Outline 
 
Refer to the Survey Outline section (2.8) above. 
 
4.10.3 Smooth Tide Request 
 
Refer to the Smoot Tide Request section (2.7) above. 
 
4.10.4 Supplemental Correspondence 
 
This appendix should contain copies of any additional correspondence, such as 
e-mails, relating to the survey. 
 
4.10.5 Geographic Names 
 
The Geographic Names form 76-155 will only need to be filled out if there are 
new geographic names in the survey area. Copy the form from: 
R:\Utilities\II_Forms_Lists_and_Templates\3_Deliverables\Appendices\Geograph
ic names form 76-155.xlt  
 
Name the file H#####_Geographic_Names and save it to the Appendix V - 
Geographic Names. 
 
The names will also need to be added as marker text in a new edit layer in 
CARIS Notebook, named H#####_GeoNames.hob.  This will go into the Final 
Fieldsheets\Notebook Files folder. 
 
Make a note in the DR referring to the Geographic Names form in the Appendix.  
Also note that the names were included in the CARIS Notebook session. 

 
4.11 DR Separates 
 

4.11.1 Logs 
 
Templates are located in 
OPR_XXXX_FA\Surveys\HXXXXX\Descriptive_Report\Separates\I Logs 

 
4.11.1.1 Acquisition and Processing Logs 

 
The digital folder should contain only the master logs for each vessel.  
Any daily logs should be removed from the submission folder.  You can 
keep them in the Survey Files\Misc folder if you don’t want to delete 
them entirely. 
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Clean up the binder with the hard copies.  It should contain only official 
paperwork, boat sheets, and DP forms.  Remove any personal items and 
unnecessary paperwork, such as polygon plans, PODs, etc.   
 
4.11.1.2 Detached Positions 

 
Check that all DP forms are in the binder, completely filled out, match the 
Pydro session entries and are properly labeled. Scan the DP forms and 
combine them into a single .pdf called HXXXXX_DP_Forms. Save the 
file to the folder: 
H#####\Descriptive_Report\Separates\I_Logs\Detached_Positions 

 
4.11.2 Side Scan Contacts  
 
Not applicable at this time. 

 
5.0 Submission 
 

5.1 Check Coverage and Accuracy Requirements 
 
The coverage requirements for the survey are specified in the project letter instructions.  
Check the data to make sure the requirements were met.  The BASE surface depth 
ranges and resolutions are helpful for this task.  If requirements were not met, be sure to 
make a note in the DR about what kind of coverage was achieved and why letter 
instructions could not be followed. 
 
The accuracy standards are as stated in the Specifications and Deliverables, unless 
otherwise noted in the project letter instructions.  Be sure the data meets standards and 
discuss any problems in the DR. 

 
5.2 File Management 
 
Please remove/delete all extraneous files from the I: drive.  This includes temp files, 
delete_me files, etc, which were used during processing but are no longer needed once 
the survey is approved.  Once the necessary files are copied into the Field Products 
folder, the survey files folder and its contents can be deleted.  Delete any non-official field 
sheets, surfaces and sessions from the CARIS folders.  It should contain two sessions:  
H#####_QC and H##### for each survey.  The H##### session should contain an 
H##### fieldsheet, and include the official non-finalized depth threshold & resolution 
BASE surfaces.  The H#####_QC session & fieldsheet can contain any surfaces, 
fieldsheets, contours, depths, etc. that were used during the processing & QC of the 
survey, please have soundings, contours and finalized surfaces available for the QC 
Review.  All other sessions & FS should be deleted.  Please note that the H & I drives will 
be cleaned up after data has been submitted. 
 
5.3 Quality Control Review 
 
Once all of the above processes have been completed, a reviewer (FOO,  CST, SST) will 
be assigned to go through the QC Review portion of the checksheet 
 
The (QCReview) MBES Final Ssn Date will be completed by a reviewer, who will 
compare this to the QC Ssn query.  The two should match.  If not, the Survey PIC should 
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be notified of any discrepancies. The reviewer also checks the (QCCheck) DP-GP-BS 
Date.  Boxes of the same color should have the same number, DPES DP files need to 
have SV, tide and merge, DPNE only need tide and merge.  CARIS lines should not be 
outdated.  Notify the Survey PIC of discrepancies. 
 
5.4 Submit to FOO 
 
Submit the survey to the FOO for review and approval. 
 
5.5 Paper Separates compiled 
 
Use a brown or blue folder to compile your paper separates.  These should include DP 
forms, boat sheets and paper acquisition logs if produced for this survey. 
 
The folder should be labeled, using the Smart Labeler, with Project, Sheet, and 
Separates to be Included with DR, as shown below. 
 

OPR-XXXX-FA-0X 
HXXXXX 

SEPARATES TO BE INCLUDED WITH 
THE DESCRIPTIVE REPORT 
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0.0 Document Scope 
 
Before sending boats out in the field, it is important to know where to send them and what needs to 
be verified.  This document is intended to guide sheet managers through setting up a shoreline 
project in CARIS Notebook.  Other SOP’s will be referenced for further guidance. 
 
1.0 Setting the Directories 
In order for CARIS Notebook to communicate properly with CARIS HIPS, the directories have to be 
properly set.  This only has to be done once. 
 

1. From the Tools menu, select Options. 
2. Click on the Directories tab in the pop-up window. 
 

 
 
3. Set the Root Path to: 

I:\200#_Processed_Data\ 
4. The Projects directory should point to the CARIS HDCS folder. 
5. The Session directory should point to the CARIS Session folder.  This will allow HIPS 

sessions to be opened into Notebook for reviewing shoreline data with a BASE surface in 
the background. 

6. The Fieldsheets directory should point to the CARIS Fieldsheets folder.  Individual 
fieldsheets can be opened in Notebook for review. 

7. Once all directories have been properly set, click Apply and then OK. 
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2.0 Editing Files 
2.1 Source Shoreline Files 
Source shoreline files will be provided to the sheet manager in Notebook’s .hob format with 
S57 attribution.  Any additional items from the chart that should be addressed during 
verification will need to be digitized in Notebook. 
 

Mapinfo Setup  
 
Copy your Mapinfo survey limit from H:\OPR_XXXX_FA\Project_Files\FA_Layout\MapInfo into 
H:\OPR_XXXX_FA_Cordova\Surveys\H11XXX\Survey_Files\Shoreline\MapInfo.  
 
Copy the Mapinfo XXXX_CFF_Shoreline.TAB and legend from H:\OPR_XXXX_FA_Cordova\Project 
Files\FA_Shoreline\Mapinfo, rename 
with H#  and put in H:\OPR_XXXX_FA_Cordova\Surveys\H11XXX\Survey_Files\Shoreline\MapInfo.  
 
You can but don't have to edit your copy of the CFF shoreline in mapinfo to fit your survey, remember these 
files are only for Pre-Survey and 
are not a deliverable.  IF you don't edit it, just deal with what is in your survey limit.  
 
Digitize charted features in Mapinfo as necessary into separate tables sorted by S-57 object type, i.e. 
Chd_UWTROC for rocks, 
Chd_DEPCNT_0 for LW, Chd_OBSTRN for foul, Chd_SBDARE for ledge and reef, and Chd_COALNE for 
HW.  These files should also 
be in your Survey_Files\Shoreline\MapInfo folder. (This will make the importation into Notebook easier and 
also make sure tables all have the 
same projection of LLNAD83.)  
 
In Mapinfo, have all of your newly copied and renamed tables open and then save workspace called 
HXXXXX_Shoreline in your Survey_Files\Shoreline\MapInfo 
folder.  This session is only used for pre-survey shoreline setup.  
 
Adjust CFF/chd parts of your copy of the legend as necessary.  CFF items should be bright green (blue/black 
features distinguished for 
reference only), Charted items should be red. 
 
Print atleast 2 sets of boat sheets and save digital files for Terra Sync as before. 
 
Notebook Setup  
 
CFF_Shoreline and survey limit hobs are provided as before. (Copy  O119_CFF shoreline.hob from 
H:\OPR_XXXX_FA\Project Files\FA_Shoreline and rename.   
Copy HXXXXX_survey_limits.hob from H:\OPR_XXXX_FA\Project Files\FA_Layout\hobs.  
 
The Chd Mapinfo files will be used and imported into Ntbk with the Object Import Utility.  Templates have 
been created for you to use to import the charted shoreline tables.  
 
In an Explorer window create a new folder in H:\OPR_O119_FA \Surveys\HXXXXX\Survey_Files\Shoreline 
called Shape Files.  
 
Open Mapinfo, go to Tools/Universal Translator. Translate only your Charted Mapinfo TABs to ESRI Shape. 
Put the new shape files in your new folder.  
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That's it for Mapinfo, now open back to Notebook.  
 
Check out R:\Utilities\I_FA_SOP\3_Processing\Shoreline\Importing Shapefiles in Notebook.doc.  
 
Open atleast your HXXXXX_survey_limits.hob, make a new editable layer covering your whole survey area 
called HXXXXX_Charted_Shoreline.hob  
 
Go to Tools/Object Import Utility/ don't worry if you get an error message, if you do in OIU go to 
Tools/Options and  
Browse to R:\Utilities\VI_CARIS\Notebook Import Scripts\Charted Shoreline.  From here click on pertinent 
object type (ie Chd_UWTROC), then clck on Modify, Shape File 
should be checked. ****IMPORTANT - Browse to your charted shape file. In the next windows, check to make 
sure the correct Object Class is selected and the Caris Key, 
Lat and Lon are mapped correctly then click Finish. Then Highlight the template you just modified and clck 
Execute.  Check for errors in the log and close OIU.  
 
In Notebook select all from the new OIU Import Layer and Tools/Import Selection into the Chd Shoreline hob.  
Continue untill allcharted features imported.  If you have a 
object type that does not have a template and need help let me know.  
 
New helpful Notebook functionality -  
Mass attributing:  
To change one common attribute for a large number of objects from the same  
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object class (for example, UWTROC), the procedure to follow is the  
following:  
a) Select all in the Edit layer (HOB file) in which you want to change the  
attribute for a given object class.  
b) In the Worksheet window's query box, click on the Acronym column header  
to sort by Acronym. (double clicking will toggle between alphabetical and  
reverse alphabetical)  
c) Select all the relevant Acronyms in the list (for example, all UWTROC):  
highlight using CNTRL or SHIFT key to add to the highlighted selection  
d) right click to get the right-click pop-up menu  
e)Select the right-click menu option : Remove Others from Selection  
f) Once you have isolated the target Object class Acronym in the query, the  
next step will be to use the Edit tool to change the common attribute for  
all objects selected  
g) Click on the menu item:  Edit > Change All  
h) The Change All dialog box appears. It works only for common Attributes.  
i) left click inside the white box under the Acronym column header, a drop  
down menu will appear with all the valid attribute acronyms  
h) Select the Attribute to change from the list and enter its common  
replacement value.  
 
If you need assistance with the mass attributing, please see Gonsalves.  
 
Attribution for charted features should be as listed below.  Use the mass attribution functionality when possible.  
Also you can use mass attribution for adding info to remarks like Chd (16709) rk.  
 
COALNE has no necessary attribution  
 
For UWTROC  
VALSOU = -8888.88  
QUASOU = depth unknown  
WATLEV = covers/uncovers or submerged, etc  
 
For DEPCNT_0 (LW)  
VALDCO = 0  
VERDAT = Mean Lower Low Water  
 
For OBSTRN (Foul)  
CATOBS = foul area  
 
For SBDARE (ldg/reef)  
NATSUR = rock 

 
2.2 Creating New Edit Layers 
Editable layers are used for digitizing charted items or adding new shoreline features. 
 
1. From the File menu, select New Edit Layer, or click on the New button in the toolbar. 
2. Browse to the Notebook_Files folder and create a new .hob file, named 

H#####_CHD_Shoreline.hob 
3. Digitize any items from the chart to the CHD_Shoreline layer, such as rocks or AtoNs that 

need to be addressed in the field and are not represented in the source shoreline files. 
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If the chart scale is 1:40,000; do not digitize the  rock that is within 40 meters of a CFF rk. 
4. After acquiring shoreline data, addrtional layers named H#####_Add_Notebook, 

H#####_Modify_Notebook,and H#####_Delete_Notebook  will need to be created. 
 

2.3 Digitizing Features 
 
1. In the Layers tab, select the layer to be edited, right click and Set As Active Digitize 

Layer, or do this from the Edit menu.  When digitizing to a layer, that layer must be 
selected in the Layers tab. 

2. Select the appropriate digitizing tool from the toolbar (point, line or area). 
 

  
 
3. When a digitizing tool is selected, a Select Object Acronym window will appear.  Choose 

the appropriate acronym from the list (UWTROC, $CSYMB, WEDKLP, etc), then click 
OK. 
Attribute a ledge or reef as SBDARE with NATSUR as 9:rock 
Attribute foul areas as OBSTRN with CATOBS as 6:foul area 
 

 
 
4. An Attributes window will appear.  Fill in any required fields, which will appear red, and 

any desired optional fields, then click OK.  If a depth or VALSOU is required for 
something digitized off the chart enter -8888.88 with the WATLEV as 4:covers and 
uncovers. 
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5. The cursor symbol will change.  Click on the desired position for the digitized object, line 

or area. 
6. To end a digitized line or area, right click on the last point dropped and select End Line, 

or Close Line. 
7. Digitized features can be moved or edited using the Edit Feature tool in the toolbar, but 

be sure to save often!  
 

2.4 Turning on Text Display 
Some text from Object ID, Inform and Remarks fields can be displayed with the digital data.   
 
1. Go to the Tools menu and select Options. 
2. Select the S52 tab. 
3. There are several check boxes at the bottom of the window.  Turn on the Text option, 

then click OK.  The Notes check box refers to Marker Text, which is discussed below. 
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4. Text can be added to a feature by selecting it, then adding the desired comment to the 

remrks field. 
 

 
 
2.5 Marker Layers 
Marker layers are not stand alone layers. They must be attached as a child layer to an Edit 
layer.   
 
1. Highlight the parent layer to which a marker layer will be added (e.g. CFF or Lidar). 
2. From the File menu, select New Marker Layer, or simply click the M icon in the tool bar. 
3. A new Marker layer will appear  in the Layers tab, with the same name as the parent 

layer.  Select the Marker layer and Set As Active Edit Layer.  It must be highlighted 
before digitzing. 

4. Right click on the associated parent layer and Set as Snap/Grab Target. 
5. Choose the appropriate digitizing tool (usually point).  Even when digitizing a Marker for a 

line feature, a point Marker is generally used for simplicity. 
6. An Attributes window will open and comments can be entered in the Marker text field. 
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ATTRIBUTES OF THE MARKER: 
mk_tim: Marker timestamp  Displays the date and time captured automatically from the 
computer 
mk_txt: Marker text  User text, description, recommendation, comment, etc., populated during 
entry 
mk_sta: Marker Status  Value is a number: 1. Active, 2. Dismissed, 3. Closed, 4. Unknown 
mk_unm: Marker User Name  Capture of the user account id.  Can be changed later 
mk_rel: Related feature ids  Capture of the FOIDs when objects on the parent layer are 
selected 
mk_pic: Marker picture file  A multi-media file can be attached to the marker 
7. Once the text has been entered and other fields set as desired, click OK and the 

digitizing tool will appear. 
8. Position the mouse over the desired location, hold down the “s” key, then left click and 

release.  This will snap the marker to the object being marked. 
9. To display the text of the markers in the Display window, follow the steps for Turning on 

Text Display above, but check the Notes box in the S52 window. 
 
2.6 Capturing a FOID 
If a marker layer is attached to a parent layer that contains S-57 objects, it is possible to 
capture the Feature Object Identification (FOID), which is the S-57 worldwide unique ID, and 
snap to the source object. A reference FOID can only be captured on the parent layer of a 
marker.  This is not a necessary procedure, but if you need to do it, here’s how. 
 
1. From the Edit menu, select New Feature. 
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2. Choose Create Marker Reference from Superselection when using just a single object 
highlighted in the worksheet window, or Create Marker Reference from Selection for 
several objects, or the entire parent layer. 

3. Follow Steps 1-4 above, to create a new Marker layer for the desired S-57 layer. 
4. Highlight the parent layer in the Layers window, then select the desired object 

(superselection) or objects (selection) from which to capture the FOID. 
5. Follow Steps 5-8 above to complete the marker.  

 
 
3.0 Generating GeoReferenced TIFFs 
 
1. In the MapInfo display window, zoom in on the newly colored shoreline layers. 
2. Right click in the window and choose Change View. 
3. Set the Map Scale to between 1:10,000 and 1:15,000.  (It may be necessary to change 

the distance units of the display from the Map, Options menu.) 
 

 
 
4. Start at one end of the sheet and center the shoreline data in the display window. 
5. From the WorldReg menu, select Save Window as TAB. 

If the WorldReg menu is not visible, it can be added from the Tools menu, by selecting 
Tool Manager > Add Tool.  On the local drive, navigate to the WorldReg tool. 
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6. In the WorldReg pop-up window, make sure the projection is correct and check the 
Create World File checkbox. 

 

 
 
7. Click the Create Table button and save the files to the Misc folder.  Naming convention is 

H#####_1, etc. 
8. Repeat this process as many times as necessary to get images of the entire shoreline 

area.  It is a good idea to have some overlap between the edges of the images. 
9. It may be helpful to draw a rough delineation on the legend of where each background 

image ends. 
 

3.0 Printing Boat Sheets 
Boat sheets will be used to make notes in the field regarding shoreline features. 
 
1. Print a color copy of the Shoreline Legend for each shoreline boat on 8 ½ “ x 11” paper. 
2. Print color copies of each of the TIFFs on 8 ½ “ x 11” rite in the rain paper. 
3. Make sure all paper copies are clearly labeled with project and sheet information. 
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0. Document Scope 
 
This document describes the process that the CARIS Notebook user should follow in order to 
successfully import ESRI Shapefiles into Notebook using Notebook’s built-in Object Import Utility. The 
objective is to convert Shapefiles containing feature and attribute information into an editable S-57 
compliant format in Notebook. It is intended to supplement existing Notebook Standard Operating 
Procedures so it is therefore assumed that the user of this document has a working knowledge of 
Notebook. 
 
General notes, advanced tips, and troubleshooting are discussed at the end. 
 
Specific notes for current buffer line import are highlighted in blue. 
 
At time of writing this only works on CARIS Ntbk 2.2beta2 that is on FA_CST & FA_Process1. 
 
1. Shape File Import 
 
Importing ESRI Shapefiles in Notebook was previously a lengthy and cumbersome process as the 
Object Import Utility (OIU) did not support the direct importing of Shapefiles. In order for this 
procedure to work, you must be using a version of Notebook with the Shapefile import feature 
available in the OIU. 
 
The overall procedure to import the Shapefiles is as follows. 
 
1. Create/open an edit layer into which you will import the Shapefile features. 
2. Create the OIU scripts that will convert the Shapefiles. 
3. Execute the import scripts. 
4. Import the temporary import layer into the edit layer. 
 
1.1 Create/Open an Edit Layer 

 
Create a new edit layer or open an existing one into which you would like to import your 
Shapefile. 
 
To create a new edit layer, use the extents of the Shapefile you will be importing as the extents 
of the edit layer. 
 
1. Open the Shapefile you will be importing. (File → Open) 
2. Zoom to the extents of the Shapefile. 
3. Create a new edit layer and use the current display or window selection tool when defining 

your extents. NOTE: Remember to use Geographic when defining the edit layer. 
 
For buffer lines the file should be located in H:\OPR-XXXX-FA\Surveys 
\HXXXXX\Survey_Files\Survey_Planning and be called HXXXXX_Buffer_Lines.hob. 
 
Alternatively, you can open an existing .hob file into which you would like to import your 
Shapefile, but be certain that the extents of the edit layer includes the geographic extents of 
the Shapefile features. 

 
1.2 Use the Object Import Utility to Create Import Scripts 
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Creating the OIU conversion scripts is the most important part of the import process. First the 
OIU environment must be setup. Then the scripts can be created. 

 
1.2.1 Object Import Utility Setup 

 
First you need to open the OIU and set up the scripts directory. 
1. Highlight the edit layer you just created or opened and select the Object Import Utility 

from the Tools menu (Tools → Object Import Utility…) or click the OIU button . The 
Object Import Utility window should appear. 

 
NOTE: The first time you do this an error message will pop up. Click OK. 

 

 
 
2. When the OIU window appears, select Tools → Options. Set the Object Import Scripts 

Directory (R:\Utilities\VI_CARIS\Notebook Import Scripts) then click OK.  
 
For Buffer lines use Line_Generic Buffer Line and skip to 1.2.2 #3 
 
You are now ready to create your script(s). 
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1.2.2 Import Scripts 
 
You must create one script for every different S-57 Object that you will be importing. For 
example, if you are importing one Shapefile with pontoon information and another with 
shoreline construction information, you will need to create two different scripts. Similarly, you 
will need to create different scripts if you intend to import different S-57 Objects from one 
Shapefile. 
1. Click the Create button in the OIU main window (or Action → Create). 
2. Enter a script name. Choose a script name that is reflective of the feature type you are 

importing and optionally the kind of data. For example, “PONTON” or “Pontoon Shape 
File”. 

3. Select the source Shapefile  
For buffer lines it should be in H:\OPR-O167-FA Cape Decision 2005\Surveys 
\H11469\CARIS\Preprocess\Trimble\Export\Buffer Lines\TRX_XXX_Line_gen.shp. 

 
NOTE: If the OIU does not give you a Shape File data source option to select, as shown 
below, your version of CARIS Notebook does not support this procedure and you cannot 
go on. You must be using a version of Notebook that includes this option. 

 

 
 

4. Click Next. 
5. (OPTIONAL) Apply a data filter to the import. Choose a field (from the .dbf file) from the 

drop-down menu. Enter the field value that you would like to import. The filter will import 
only those features that match the attribute/value you select. Therefore, to ensure that 
the import filter value is entered correctly, open the .dbf file (with, say, Microsoft Excel) 
and verify the value. The filter is very useful for extracting a single feature type from a 
Shapefile containing many different features. 
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6. Select the S-57 Object Class that the feature will be converted to. IMPORTANT: It is 
critical that you choose the correct Object during this step, as this cannot be changed 
later.  

 
As an example for buffer lines Object Class should be $LINES – Cartographic line. 

 
NOTE:  The File Contents: Object Type shows the geometric type (point, line, or area) of 
the data you are importing. This cannot be changed. 

 
 

7. Click Next. 
8. Now you must map the Shapefile fields to the appropriate S-57 Class Attributes in the 

resulting window, as explained in the following subsections. 
9. Click Finish when mapping is complete. 
10. Repeat the preceding steps as necessary for the various S-57 Object Classes for which 

you have Shapefiles. 
 

NOTE: To modify an existing script, select the script to be modified and click Modify. 
Nothing in the script will change unless you change it. 

 
1.2.2.1 Map Shapefile Fields to S-57 Class Attributes 

The Shapefile fields are listed on the left. Map either a Caris Keyword or a Class Attribute to 
a Field as follows: 

1. Select the Shapefile field to be mapped. 
2. Double-click the Keyword or Attribute to be mapped. Alternatively, select (single-

click) the Field and Keyword/Attribute in any order and click the double-left arrow 
button ( ). 
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IMPORTANT: At a minimum, the following must be mapped: CARIS_KEY (to 
“Index”), LATITUDE or NORTHING (to “Y”), and LONGITUDE or EASTING (to “X”). 
(See figure below.) Then skip to steps 1.3 through 1.4.2. 
 
NOTE: Only those Class Attributes relevant to the Object Class selected earlier are 
listed in the class Attribute list. 

 
 

3. For list type field values only: Map the Field values to the Attribute values (see 
next subsection). IMPORTANT: If the Shapefile fields contain the code values 
instead of text (e.g. “6” instead of “yellow”), then this step can be skipped. 

4. (OPTIONAL) To remove a mapping, double click the Attribute you wish to remove. 
5. Click “Finish” when mapping is complete. 

 
1.2.2.1.1 Map Shapefile Field Values to S-57 Class Attribute Values 
 

If the Class Attribute contains fixed value choices (e.g. COLOUR: 1: white; 2: black; 3: red; 
etc.) then the Shapefile field values must be mapped to the S-57 Class Attribute values. 
 
As mentioned above, if the field values include the associated S-57 code values instead of 
the actual text values (e.g. “6” instead of “yellow”), then this process is not needed. 
Otherwise, it must be done manually, as follows: 

 
1. Double-click the empty box in the Mapping column in the row containing the field 

whose values will be mapped. The Mapping Editor will appear, as shown below. 
2. Give the mapping scheme a name. 
3. Map the values as appropriate. 
4. Click “OK” when finished. 

MANDATORY

OPTIONAL 
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Double-click here 
for Mapping Editor
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1.3 Execute the Import Scripts 
 

Once the scripts have been created or modified, they can now be executed. 
 

1. Select the script(s) to be executed (use Ctrl to select more than one) 
2. Click Execute. 
3. Review the log that appears at the bottom of the window. 
4. If there are no errors, click Close. If there are some errors, it is likely that your script was 

not set up correctly. See below for some explanations of and solutions to common 
problems and errors. 

 
1.4 Import Temporary Layer into Edit Layer 

 
The Shapefiles have now been imported to Notebook. However, they have been imported into 
a temporary non-editable layer called OUI.Import #1 (or #2, etc.). This allows you to review 
your imported data to make sure everything in the data looks good before finalizing the import 
into your Notebook Edit Layer. 

 
1.4.1 Review Temporary OIU Import 

 
To review the data, select the OIU Import layer and Select All. The imported features and 
their attribute fields/values should appear in the Worksheet Window. 

 
1.4.2 Finalize the Import 

 
1. Select the OUI Import layer and Select All. 
2. Choose Tools → Import Selection…. 
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3. Select the Edit layer into which you would like to import your data. 
4. Choose other options as desired. 
5. Click OK. 
6. Your Shapefile has now been successfully imported to an editable S-57 layer in 

Notebook. Click OK again. 
7. Close the temporary OIU Import layer. 

 
 
2. General Notes, Advanced Tips, and Troubleshooting 
 
2.1 General notes 

 
File naming 

 
Every time you execute the script you are creating, you will need to ensure that the data source 
filename is set correctly. To save time in the future, you might maintain a consistent file naming 
scheme so that the files associated with the respective import scripts are the same as the 
previous import and in the same folder. The scripts, once created, would then not need to be 
modified, only executed, thus saving time. 

 
Field naming 

 
The field names, strictly speaking, do not need to be identical to the built-in S-57 Class 
Attributes in Notebook. However, as a practice it is a good idea to name the fields identical or 
very similar to their S-57 counterparts. They must be the same if they are to be imported into 
Pydro at any time. For shoreline collection these fields names are defined in the Data 
Dictionary Editor via GPS Pathfinder. 

 
 
 
 

2.2 Advanced Tips 
 

Mapping multiple-object, single position Shapefiles 
 

Because a Shapefile can have many user-defined fields and because these fields are manually 
mapped in the OIU in multiple parallel scripts, several objects can be imported from one single 
feature (i.e. one single position) from one single file. 
 
This is useful if you have, for example, a lateral beacon, a light, and a topmark (multiple 
objects) that share the exact same position. You can record attribution information during field 
data collection for each of these objects as attributes/fields of the same feature (this would 
need to be planned and set up before data collection, e.g. in the Data Dictionary Editor if using 
TerraSync/GPS Pathfinder). 
 
The resulting Shapefile/feature would then have: 1) BCNLAT attribution fields/values, 2) 
LIGHTS attribution fields/values, and 3) TOPMAR attribution fields/values, this file can be 
imported into three separate objects (BCNLAT, LIGHTS, TOPMAR) using the OIU by creating 
three separate scripts as follows: 
 
1. In the first script, you would set the Object Class to BCNLAT and map the lateral beacon 

fields in the Shapefile accordingly; you would simply ignore the light and topmark fields. 
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2. In the second script you would select the exact same Shapefile, set the Object Class to 
LIGHTS, and map only the light fields. 

3. In the third script you would set the Object Class to TOPMAR, and map only the topmark 
fields. 

 
Upon execution of all three of these scripts (each drawing information the same data source, 
just mapped differently), you will have three different objects in Notebook that share the exact 
same position. 
 
The figures below show basic mapping schemes from the same file/feature: the one on the left 
has fields mapped to a S-57 BCNLAT while that on the right shows the mapping for a S-57 
LIGHTS. 

 

   
It is important to note, however, that you should be certain that a feature actually exists before 
executing the script for that feature using this method. In other words, if you execute a topmark 
script using this approach (with lateral beacon position information in the Shapefile) then a 
topmark object will be created whether or not you collected data on it (there may have only 
been a light on that beacon). 

 
NOTE: In this multiple-object import method, there may have been more than one field with the 
same name in the original Data Dictionary used when gathering the data. If so, duplicate fields 
have been renamed during the GPS Pathfinder export process by appending sequential 
numbers to the fields (e.g. COLOUR, COLOUR2, COLOUR3). 

 
2.3 Troubleshooting 

 
Object Import Utility Message Log Errors 
 
The OIU Message Log appears upon execution of a script. Listed below are some error 
messages you may encounter. 
 
119025: Failed to create feature object.  The attribute data does not match the type 
specified in the object catalog.  Record 0 will be skipped. 
 

For each S-57 attribute the OIU expects a certain attribute value type such as text, 
numeric, or one of a predefined list of integers that correspond to menu values. This 
message will most likely occur if the OIU is expecting one of several integer values but 
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does not encounter it. Specifically, if attribute list values are identified by their text 
value instead of their numeric value, this message may occur. For example, if the 
COLOUR attribute values are “white” or “green” instead of their integer counterparts “2” 
or “6”, respectively, then this error would appear. 
 
Solution: 
 
First, you can manually map the values using the procedure described herein. 
 
Second, you can re-export the source data to ensure that the numeric code value is 
exported instead of the text value. This assumes that numeric codes are associated 
with the list values in during the data collection process, which must be set up in the 
Data Dictionary, for example, if using TerraSync/GPS Pathfinder. 
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0.  Document Scope 
 
This document outlines the standard operating procedures for creating a data dictionary 
and creating and configuring a project in TerraSync with the necessary settings for 
efficient and S-57 compliant shoreline data acquisition. 
 
1.  Data dictionary 
 
The data dictionary is a customized list of features that allows the user to assign feature 
attribution directly in the field that can later be readily converted to a S-57 data format 
during processing back on the ship or in the office.  The data dictionary itself does not 
contain positions or feature-specific information, but rather structures data collection in 
the field and prompts the user to enter relevant information.  NOTE: Check your data 
logger under C:\MyDocuments\TerraSync for an existing data dictionary and verify it is 
the approved version (Fairweather_DD.ddf). If the data dictionary is created and up-to-
date you can skip ahead to section 2: TerraSync Configuration. 
   

1.1.  Pathfinder Office 
You will use GPS Pathfinder Office throughout the suitcase shoreline process, for 
everything from creating a data dictionary to processing GPS data and exporting 
shapefiles to Pydro.  Upon opening GPS Pathfinder Office, a dialog box will prompt 
you to select a project.  Later in the process you will create a new project; for now 
select Default. 
  
1.2.  Data dictionary creation to S57 standards 
To create a new data dictionary, choose Data Dictionary Editor from the Utilities 
menu in Pathfinder Office.  When the Data Dictionary Editor opens, select File → 
New.  Fill out the Name and Comment fields.  Give data dictionary a descriptive 
name and save (File → Save) to the ship’s designated network folder (2005 
Fairweather data dictionary: R:\Utilities\Shoreline_S57\Trimble\Data 
Dictionary\Fairweather_DD.ddf).  Alternatively, select File → Open to modify an 
existing Data Dictionary.  Eventually, the final data dictionary will be transferred to 
the TerraSync folder of the acquisition laptop or handheld data collector. 

 
1.2.1.  Add new features 
Now that the dictionary has been created, it must be populated with the potential 
features (S-57 objects) and attributes you will want to record in the field.  Consult 
the CARIS S-57 ENC Catalogue (C:\Program 
Files\Python23\Pydro\S57\S57cat\frames\S57catalog.htm) for a list of S-57 
objects, attributes, and coding information.  The NOAA point features file 
(C:\Program Files\Python23\Pydro\forms\NOAAHydroS57PointObjects.xls) is a 
good resource to help determine which features and attributes are necessary to 
include. The Data Dictionary Record, an Excel spreadsheet 
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(R:\Utilities\IV_Trimble\Data Dictionary\Data_Dictionary_Record.xls), has been 
created and should be used to keep track of the Data Dictionary features and 
attributes and their relation to S-57 requirements. 
 
To add a new feature, click the New Feature button at the bottom of the left-hand 
(Feature) column. 
 

 
 
Click on the Properties tab and fill in the Name and Comments fields for your 
new feature: name the feature after the S57 feature object acronym, and use the 
comment field to describe what the code represents. It is recommended that you 
add a letter to the name to identify whether the feature is a point, area, or line. For 
example, OBSTRN_L for a line obstruction.  This will maintain future filename 
uniqueness and avoid confusion. 
 
NOTE: Non-S-57 Fields may be used for the Feature Name if the feature is only 
for field/office use. For example, UserID is used to give the feature a unique 
identifier, but is not a S-57 object. 
 
Under Feature Classification, select either Point, Line, or Area. 
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 In the Default settings tab, set GPS logging preferences: 
 

 
 
Set the time interval to one (1) second for point features and five (5) seconds for 
line and area features.  Leave Minimum Positions set at 1 (for point feature). 
Leave the default Offset settings as is. 
 
NOTE: Carrier phase logging can be collected, but requires a minimum lock of 10 
minutes which is generally impractical and unnecessary for shoreline acquisition. 
 
For a point feature, change the symbol style by clicking on the Symbol tab; these 
can be edited later as well. For line and area features, the line style can also be 
changed via the Line Style tab. 
 
NOTE: To edit an existing feature, highlight the desired feature and click Edit 
Feature.  Likewise, a feature is easily deleted by selecting the feature to be deleted 
and clicking Delete Feature. 
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1.2.2.  Add new attributes 
Each feature must have certain pieces of descriptive 
information, or attributes, attached to it in order to be 
useful.  Highlight the feature you wish to add an 
attribute to, then click New Attribute in the right-hand 
(Attribute) column.  Select attribute type, as shown.  
Most of your attributes will be Menu, Numeric, and 
Text types, but for each detached position (DP) you 
will also need Date and Time attributes.  Refer to the 
Pathfinder Office help menu for more information on 
the different specific attribute types. 
 
Each attribute allows for Attribute Name, Comment, attribute-specific values, 
Field Entry permissions and requirements, and an auto-increment option (numeric 
and text only). 
 
For each attribute, fill in Attribute Name with the corresponding S-57 attribute 
name (e.g. “COLOUR”) and the Comment field.  
 
You must decide whether you want this feature to be required for entry in the 
field.  If you do not want this attribute to be required, leave the On Creation: 
Normal option selected in the Field Entry section at the bottom, otherwise choose 
Required.  For On Update, select Normal. 
 

 
 
Note the distinction between a mandatory S-57 attribute and a required data 
dictionary attribute.  In general, mandatory S-57 attributes should be required in 
the data dictionary, but sometimes the mandatory S-57 attributes can be assigned 
during office processing.  The Data Dictionary Record spreadsheet should be used 
to keep track of what is mandatory per S-57 versus what is required in the Data 
Dictionary. 
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1.2.2.1.  Add “menu” type attributes 
  
After filling in the standard fields, click New.   
 
Fill in Attribute Value (e.g. “Green”) and check the Default box if you want to 
set this value as the default for the attribute, otherwise leave it unchecked.  In 
order for Pydro to recognize the S-57 assignment, each menu-type attribute 
value must also have a code attached.  Consult the attribute’s entry in the S-57 
catalog and fill this into the Code Value 1 field, as depicted below. 
 
After you click Add, the New Attribute Value window will stay open for you 
to insert remaining attribute values.  Close the window after all values have 
been added. 
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1.2.2.2.  Add numeric, text, time, and date attributes 
 
For numeric attributes (e.g., LENGTH), enter the number of decimal places 
allowed or required, the minimum and maximum values (the range), and the 
default value, using the S-57 catalog and experience as guidance. 
 
For text attributes (e.g., INFORM), enter the maximum string length and the 
default value, if any. 
 
For both date and time attributes (e.g. RECDAT and Time), Auto Generate on 
Creation should be checked.  The date format should be Year – Month – Day 
and the time format should be 24 Hour. Refer to the screen shots below. 
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1.2.3.  Organize features and attributes 
Arrange features and attributes in a convenient order for field acquisition.  The 
more efficient you are when collecting positions, the more data you will be able to 
gather.  Using the up and down arrows on the toolbar at the top of the Data 
Dictionary Editor, arrange features so that the most commonly used ones are at 
the top of the list.  In the attributes column, move required attributes to the top of 
the list for each feature.  You may want to consider consistently putting a 
common attribute (e.g. Remarks) as the last required field so that, at a glance, you 
can tell which attributes are required and which are discretional (see below). 
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Recall, however, that the data gathering program (TerraSync) will prompt you for 
required fields. 
 

 
 
2.  TerraSync Configuration 
 
TerraSync, the GPS logging interface you will be using during feature collection, has five 
modes: Map, Data, Navigation, Status, and Setup. The mode you’re in is determined by 
which of these options is selected in the uppermost left-hand menu.  When you switch 
modes, the display windows and menu options will automatically change.   

 
There are two ways to change TerraSync GPS Settings.  The first method will work in a 
pinch; the second is recommended.   

   
2.1.  Change GPS settings in TerraSync 
In Setup mode, click on each of the different buttons (Logging, GPS, Real-time, 
Coordinates, Units, and External) and set your preferences. 
 
2.2.  Change GPS settings by creating a Configuration File 
You can save your desired settings by creating a configuration file in Pathfinder 
Office Configuration Manager (located in Pathfinder Office folder from Windows 
Start menu, or Utilities→ Other→ Configuration Manager, if Pathfinder Office is 
already open).  Through File→ New, choose TerraSync Configuration in the next 
window, and say OK.  If multiple data collectors may be used, it is a good idea to 
save the configuration file in an accessible location 
(R:\Utilities\Shoreline_S57\Trimble\Configuration Files) rather than just the C:\\ 
drive of one computer or datalogger.  This file can be referenced or updated easily for 
future projects. 
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NOTE: Creating a new configuration file for each project is recommended since the 
DGPS beacon frequency will change for each area.  Each file should be well labeled 
with the project name and/or date.  The project configuration file may have already 
been created so it is a good idea to check for an existing configuration file on the data 
logger under C:\MyDocuments\TerraSync\Configuration and verify if it is correct. 
 
To create a new configuration file, click on each tab and set according to your 
preferences, or follow the examples: 
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NOTE: In the Real-time tab, Frequency must be determined prior to configuration 
and entered manually.  The frequency you will enter depends on which U.S. Coast 
Guard DGPS base station in the area is being utilized, which will vary by project and 
location. 
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NOTE: While it is possible to configure a laser range-finder or other external sensor 
to feed directly into the GPS log, this capability is not part of the Fairweather’s 
procedure as of 2004.  Thus far, the laser has not been accurate or consistent enough 
to warrant automatic association with GPS positions without first passing through a 
human filter.  A digital camera with the proper functionality can also be connected to 
a laptop or data collector and set up as a sensor. 
 

 
 

 
 
When all properties are set as desired, choose a descriptive name and File→ Save the 
configuration file to the data logger in the folder C:\My 
documents\TerraSync\Configuration. 
 

3.  Project and data file setup 
 

3.1.  Transfer data dictionary to datalogger 
In order to use the data dictionary to collect and attribute positions in the field, you 
will need to transfer the data dictionary into TerraSync on a GPS data collector or 
field PC.  If using a computer as the data logger, files can be transferred directly by 
connecting to the network.   
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NOTE: If your datalogger is a separate device from your processing computer, you 
will need to utilize some type of data transfer software.  If no such program is 
included with your datalogger, download Microsoft ActiveSync to your processing 
computer: www.microsoft.com/windowsmobile/resources/downloads/default.mspx. 
Connect handheld unit and processing computer via serial port, USB, or infrared port 
(refer to device’s User’s Guide for details). 
 
Under the Utilities menu in Pathfinder Office on your processing computer, select 
Data Transfer.  If using the handheld unit, it will be necessary to connect the device to 
your processing computer using appropriate serial and/or USB cables.  Choose a 
device from the pull-down menu, or add a new one by clicking the Devices button; 
then press New. 
 
If you plan to use a Trimble data collector as your field device, choose GIS 
Datalogger on Windows CE.   
 

 
 
The follow-up screens will vary depending on the type of device you select.  Fill in 
the location of your datalogger, enter the correct port when prompted if using an 
outside device, type in a name and click Finish.  Minimize Pathfinder Office. 
 
Turn datalogger on, and open Microsoft ActiveSync.  In the Partnership window that 
pops up, just say No and set up a guest partnership. 
 
In ActiveSync, check to make sure the correct port for your device is allowed, 
through File→ Connection Settings, and say OK. 
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If ActiveSync does not automatically detect your device after this window closes, 
navigate to File→ Get Connected.  After your device is found, ActiveSync should 
indicate that the status is connected: 
 

 
 

Minimize ActiveSync and reopen Pathfinder Office.  The icon in the upper right 
corner of the Data Transfer window (Utilities menu) indicates the status of your 
computer’s connection with the field device.  If “Not connected” is displayed, click 
the button with the green checkmark to connect to the device (the button with the red 
arrow disconnects). 
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Click the Send tab and then press Add; select Data dictionary from the pull-down 
menu.  Navigate to your data dictionary and Open. 
 
In the Data transfer window select Transfer All.  Once the transfer is complete, press 
Close. 

 
3.2.  Create a new project 
If creating a new project, it is best to first use an explorer window to manually create 
new folders with the desired Pathfinder project name 
(OPR_OXXX_FA_04\HXXXXX) in the Pathfinder local drive (C:\Pfdata\). 
 
In Pathfinder Office, select File→ Projects.  Choose a project from the drop-down 
menu or click New. 

 
Type in desired project name and click Browse to find the folder you just created. 
Accept default settings for Backup, Base and Export folders. 
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Click OK in the Project Folders window, and again in the Select Project window. Exit 
Pathfinder Office. 
 
NOTE: You are now ready to acquire shoreline data!  Before actually venturing out in 
the field, you may want to set up a TerraSync data file and load it with the correct 
configuration settings so that you don’t have to waste any time during your shoreline 
window.  To create TerraSync data and configuration files, proceed on to Shoreline 
Acquisition SOP. 
 
Back to top 
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0. Document Scope 
 
This document outlines the standard operating procedures for acquiring shoreline data 
and logging detached positions to meet S57 standards, as well as transferring that data 
back to the ship for processing.  Effectively, this SOP outlines everything that needs to be 
done immediately before collecting data, in the field and immediately after collecting 
data. 
 
1. Set up TerraSync for GPS logging  
Everything in this section should be done in preparation for a specific survey, but should 
be set up before actually going out in the field. 
 
NOTE: The setup procedures for a field PC and the handheld datalogger vary slightly.  
The primary difference is the screen size on the different platforms; there is no space on 
the handheld for multiple windows.  Operational differences are noted where applicable. 
 

1.1. Create a new TerraSync data file 
 

1. In TerraSync, enter Data mode (select “Data” in the upper 
left-hand menu). 

2. In the menu directly below it, choose New File (If you are 
resuming work from an old file, choose Existing File).  All 
the data you acquire in a given session will be stored in the 
file you are now creating. 

3. Name the file after the Trimble unit number and the day number in the form 
of TRXDn.  For example, enter “TR1258” for data from Trimble unit 1 on day 
258. 

4. Select the data dictionary called Fairweather_DD from the pull-down menu 
(the data dictionary must be located in C:\My Documents\TerraSync). 

5. Click Create. 
6. In the following screen, leave Antenna Height and Measure To fields as 

default; these are not necessary as they apply only to vertical GPS positions. 
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NOTE: When the user creates a new TerraSync file, TerraSync creates an associated 
set of files (DD, GIC, GIP, GIS, GIW, GIX, OBS, OBX).  All these must be located 
directly in the TerraSync local drive (C:\My Documents\TerraSync\) in order for the 
TerraSync file to be opened in the future. 
 
1.2. Load background files into TerraSync 
All final background files (TIF, TFW, CS) must be saved into the data logger’s 
TerraSync folder (C:\My documents\TerraSync) to be accessible.  If the datalogger is 
the same machine that background files are currently saved on, simply copy all TIF’s 
and associated files to C:\My documents\TerraSync. 
 
HANDHELD ONLY: If background files are located on a separate machine, these 
will need to be transferred in ActiveSync.  Open ActiveSync and connect to 
datalogger and transfer the files with the procedure outlined above in Section 3.2 of 
the Trimble_Pathfinder_Setup SOP, substituting file type “Background” for “Data 
Dictionary.” 
 
Open TerraSync on your datalogger and select Map mode.  From Layers→ 
Background File, navigate to your file.  Select File Type→ Background, find the 
desired image, and click OK. 
 

 
 
The first time you load a background image you will get this message (select yes): 
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If the image does not immediately appear in the map window, try pressing the Zoom 
Extents button (equal sign with a circle around it in the lower left-hand corner of the 
map window). 
 
NOTE: Upon transfer of the georeferenced TIF file to TerraSync, a CS (coordinate 
system) file will be created, among others.  If the coordinate system of the image is 
changed and then reloaded into TerraSync, the original CS file must be deleted before 
TerraSync will acknowledge the new coordinate system. 
 
1.3. Load configuration file into TerraSync 
Even if the correct configuration file is already listed, you may need to reload it if the 
GPS is not connecting: from Setup mode, press the Change button, and then Load.  
As long as it was saved directly into your datalogger’s local TerraSync folder (C:\My 
documents\TerraSync\Configuration), the configuration file you created for the 
current project should be listed as an option.  Select the file and then press Load. 

 
1.4. Customize TerraSync Display 
Immediately before going out to survey, open TerraSync and the project you created. 
If it is not already open, choose Existing File from the second menu in the Data 
window and select the file you created.  If prompted for antenna height, leave as 
default; antenna height does not matter unless you are using GPS for vertical heights. 
 
FIELD PC ONLY: There are three different windows that can simultaneously display 
different sections, or modes (i.e. Map, Data, and Status); set them up the way you 
want them to be when you start collecting points.  Note that there is only space for 
one window on the handheld datalogger. 
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2. Collect GPS positions 
 

2.1. Connect to GPS in TerraSync 
Make sure your GPS receiver is connected to the data logger through the appropriate 
COM port (specified under GPS Settings in Setup mode).  From Setup mode, Click 
on the Options button and choose Connect to GPS, or simply click the “GPS” button 
in the upper right-hand corner of the window.  Icons on left-hand side of the upper 
toolbar display current status, as shown below; clicking on each icon provides 
additional details. 

 
 

In Data mode, choose Collect Features from the second pull-down menu, then Log 
Later from the Options menu.  This setting is recommended for logging precise 
positions from a launch because the time required for S-57 attribution is most likely 
longer than the boat can stay still.  Choosing Log Later allows you to enter feature 
attributions at a leisurely pace, and to acquire a GPS signal only when you are ready.  
Select Collect Features from the Data menu to prepare for acquisition. 
 
2.2. Collect GPS data with S-57 attribution 
Features in TerraSync can collected as points, lines, or areas.  In the feature list, these 
are represented as follows: 
 
 Point:  Line:  Area:  
 
The Data Dictionary is set up to indicate a point, line, or area in the feature name (e.g. 
MORFAC_L for a line mooring facility), as shown.  The data collection procedure 
differs for each of point, line, or area, as described below. 

Connecting to receiver 

Connected, no coverage 
(no satellites, no DGPS) 

Connected, good coverage 
(6 satellites, DGPS) 

Number of satellites

DGPS status 

Battery life 
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When you are ready to begin taking a position, highlight the desired Feature Name 
(corresponding with the desired Type) from the list in TerraSync’s Collect Features 
mode, and click Create (this will not begin logging). 
 
NOTE: It is important to enter the correct feature type before beginning to log; as 
attribute fields are specific to feature type you won’t easily be able to change feature 
type in Pydro.  Attributes can easily be altered in Pathfinder or Pydro, so it is fine to 
take more detailed notes by hand and electronically update attribute fields later. 
 

 
 
Fill in all required fields (TerraSync will inform you if you are missing any required 
data) as well as any desired optional fields; click OK.  To abandon the feature or 
switch feature types, click Cancel and start again. 
 

2.2.1. Log Point data 
 

To begin logging, click the Log button in the upper right hand corner of the Data 
window in Collect mode.  The pencil icon on the left-hand side of the upper 
toolbar indicates that positions are being logged and displays the number of 
positions recorded for this point feature.  The logging interval is predefined in the 
Data Dictionary, but may be changed by selecting Logging Interval from the 
Options menu.  The default logging interval for point features is one second. 



 

Procedure Owner: David Rheinheimer 
Updated: 11/16/2005 
R:\Utilities\FA_SOP/2_Acquisition\Shoreline 

Approval: CST FAIRWEATHER 
Approval Date: 06/30/05 Page 7 of 16 

 

FAIRWEATHER SURVEY 
 

Doc No. 
SOP-6XX PROCEDURE 

Document Title 
SHORELINE ACQUISITION 

Version 
2 

Effect Date: 
June 30, 2005 

 

 
 

After several positions have been logged (if the boat is drifting it is better to get 
just a few localized points than many spread-out ones), press Pause to end logging 
for this feature. 

 
NOTE: It is possible to add more positions to the feature by hitting Resume and 
then Pause, but this option should be used with discretion and not while drifting. 

 
2.2.2. Log Line and Area data 
To begin logging a line or an area (polygon), click Log, wait until one position is 
logged, then click Pause.  Repeat this process for each line segment of the 
segmented line or area.  The default logging interval for lines and areas is 5 
seconds (as defined in the Data Dictionary) to allow sufficient time to pause 
between vertices. 
 
NOTE: Alternatively, TerraSync allows you to collect multiple positions for each 
line or area vertex.  This feature is located in the Options menu by clicking New 
Vertex. 
 
2.2.3. Account for offsets 
Often, a feature will be at some distance and bearing from the actual GPS antenna 
when a position is logged.  Offsets can be accounted for during creation of a new 
feature: from Data mode, choose Collect, and then click the Create button.  From 
the Options menu select Offset.  The simplest way to measure offset from a 
shoreline vessel is through the Distance - Bearing technique; select this option, 
then Next. 

 

 
 

Positions recorded 
for current feature 
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While logging the position, another person should determine range (visually or 
with a laser rangefinder) and bearing (with a compass adjusted for true North) 
from the Trimble antenna to the point of interest of the feature.  After logging but 
before closing the position, follow instructions on the Offset screen to enter 
Bearing (T) and Horizontal distance in the blank fields.  Vertical distance does not 
need to be entered.   
 

 
Press OK to return to the feature attributes; press OK when values have been 
filled in and you are ready to record the position. 
  
NOTE: It is possible to connect external sensors (i.e. a laser rangefinder or 
camera) to the GPS unit so that data transmitted by the sensor will automatically 
be recorded and associated with a DP.  However, the laser rangefinder has not 
been consistently accurate enough in moving seas to make this option desirable. 
 

3. Complete Detached Positions (DP’s) form 
To log a detached position (DP), fill out all information on the DP form: DP 
Form_FA_05.xls. 
 
A system should be set in place in order to keep track of all the positions that are logged 
and to ensure that no positions with duplicate names are recorded.  For example, use a 
Unit #, Day #, DP# format, where 12581 represents Trimble Unit 1, Day 258, DP 1, and 
225913 represents Trimble Unit 2, Day 259, DP 13.  This is the same unique number that 
is entered as OBJNAM attribute when entering information in the data logger.  
 
For each DP, make sure to record the position number (i.e. 12581), feature type 
($CSYMB, UWTROC, BCNLAT), and geometric type (point, line, area) as well as the 
position of the actual feature in relation to the GPS antenna.  It is also important to record 
how the depth or height was determined.  Range may be determined visually or with a 
laser rangefinder; use the “remarks” field to note any other relevant pieces of 
information. 
 

3.1. Associate photographs with DP’s 
If possible and desirable to take photos, keep track of how many photos were taken of 
each feature or make some sort of notes to indicate which pictures correspond to each 
DP so they can be correlated back on the ship.  It is helpful to mention any other 
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relevant information as well, such as the direction the picture was taken toward or the 
water level at the time. 
 

4. Transfer data from field datalogger back to ship 
 

4.1. Boat sheets and DP forms 
Boat sheets and DP forms are valuable pieces of data and must be kept track of and 
submitted as part of the DR.  Completed DP forms should be filed in the appropriate 
sheet binder, and boat sheets should be stowed in a plastic sleeve in the back of the 
binder. 
 
4.2. Data transfer 
In GPS Pathfinder Office, select Data Transfer from the Utilities menu.  Select a 
device from the pull-down menu.  The icon in the upper right corner of the window 
indicates the status of Pathfinder’s connection with TerraSync.  If “Not connected” is 
displayed, click the button with the green checkmark to connect to TerraSync; the 
button with the red arrow disconnects. 
 
Click the Receive tab and then press Add and select Data File from the pull-down 
menu.  Navigate to your data file.  Click Browse in order to find your project folder; 
set this as your destination location.  Click Open. 
 

 
 
In the Data transfer window select Transfer All.  Once the transfer is complete, press 
Close. 
 
After transferring data into Pathfinder, a duplicate of the additional TerraSync data 
files (DD, GIC, GIP, GIS, GIW, GIX, OBS, OBX) will be created in the Pathfinder 
project’s Backup folder.  Save these files from the Backup folder to the following 
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network folder:  
H:\[OPR#]\Surveys\HXXXX\CARIS\Preprocess\Trimble\Backup\TRXDn\. After the 
files have been successfully reproduced in Pathfinder and copied onto the network, 
the files can be deleted from TerraSync. 
 
4.3. Open Data 
Go to File→ Open.  Navigate to your project folder, find your file, and click Open.  
You can now view and manipulate your data in three different windows: Map, 
Feature Properties, and Position Properties.  If these windows are not open, make sure 
the buttons encircled in below are selected. 
 

 
 

5. Edit attribution information in Pathfinder 
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Before exporting the Shapefiles for use in Pydro, check to make sure that all information 
is correct, and that it matches any notes on the DP form.  Scroll through all attribute 
fields for each point, line, and area and make sure all information is correct. 
 
Clicking on a feature in the Map window will automatically select it and bring up its 
attribution information in the Feature Properties and Position Properties windows.  In 
each of these windows, the forward and back arrows can also be used to scroll between 
features.  Double-clicking an Attribute Name in the Feature Properties window will 
automatically bring up its Attributes tab and allow you to edit the field.  Make sure to 
save any changes you make. 
 
 
 
6. Prepare for Pydro 
 

6.1. Export Shapefiles to Pydro 
To export Shapefiles to Pydro, choose Export from the Utilities menu in GPS 
Pathfinder Office.  Click Input Files: Browse in order to select the raw SSF Trimble 
data file(s) you wish to export.  The default output folder is defined in the GPS 
Pathfinder project setup.  Click Output Folder: Browse to change the output folder. 
 
If an export setup has already been created, select it from the pull-down menu.  
Otherwise, select Sample ESRI Shapefile Setup from the pull-down menu and click 
New.  Give the new setup a name (e.g. “Shoreline ESRI Shapefile”) and click OK. 
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Click Properties and make sure all tabs are set according to the following examples. 
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In the Attributes tab, Code Value 1 must be checked in the “Export Menu Attributes 
as” field so that Pydro (and Notebook if not using Pydro) can correctly interpret their 
S-57 attribute values. 
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Change the coordinate system by clicking Change and set up the system as shown. 
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NOTE: If there is more than one feature with the same name the features after the 
first will be renamed (e.g. MORFAC to MORFAC2).  This would occur if both a 
point and line feature share the same name and can be avoided by the naming scheme 
suggested in Section 2.2. 
 
NOTE: One set of files (DBF, SHP, SHX) will be created per feature type ($CSYMB, 
UWTROC, WRECKS, etc.) so each file may contain one or many points/lines/areas, 
depending on how many DP’s were given this feature name in the field. 
 
After exporting, open the export folder in Windows Explorer, and find the files you 
just created.  Rename each file, giving it the Trimble GPS unit and day number 
(TR1XXX_ or TR2XXX_) as a prefix.  Files must be uniquely identified in this 
manner before transfer into Pydro, otherwise the next DP of the same feature type 
will repeat the file name. 
 
Transfer the exported files to 
H:\[OPR#]\Surveys\HXXXXX\CARIS\Preprocess\Trimble\Export\TRX_Dn. 
 
NOTE: Buffer lines will be named “Lin_gen” upon export. These files should also be 
renamed as per the other files and transferred to H:\...\Export\Buffer_Lines\. 
 
6.2. Transfer Photos for DP’s 
Upload any photos from the field to H:\[OPR#]\Surveys\HXXXXX\PSS\Photos\ then 
erase them from the camera to avoid any future confusion.  Name photos by their DP 
numbers and any other notes that will help the sheet manager and cartographers 
understand what the picture represents (i.e. the cartographer could interpret 
“12583_hp_toE” to mean that the photo is of the high point of DP 12583, and was 
taken towards the East). 
 
If the subject of a photo is unclear or if multiple features are represented in the same 
picture, it may be useful to crop or label the picture with text and arrows in a photo 
editor.  Save final copies of DP photos in a subfolder of the survey’s PSS folder.  It is 
fine to have multiple pictures for one feature, but any “fun” pictures from the day 
should be saved elsewhere. 
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0.0 Document Scope 
This document is intended to guide sheet managers through shoreline processing in Pydro.  It should 
be followed by Notebook_Shoreline_Processing.doc. 
 
1.0 Import Features 
Positions recorded in the field must be imported into Pydro for processing.  The boat crew will be 
responsible for transferring the Trimble files to the appropriate folder, then the sheet manager should 
bring the features into Pydro.  Open the PSS for the survey, or create a new one if one does not exist.  
Be sure all metadata is entered and correct. 

 
1.1 Insert DPs and GPs  
1. From the Pydro Data menu, select Insert > Generic GPs/DPs. 
2. In the pop up window, go to the File menu and select Open template. 
3. Browse to R:\Utilities\III_Pydro\ Parser Templates and open the appropriate template file 

(e.g. $CSYMB or UWTROC).  Some fields in the Import window will be filled in 
automatically.  (If a template does not exist for the feature to be imported, refer to the 
procedure for creating a parser template described below.) 

 

 
 
4. From the File menu, select Open data file. 
5. Browse to the folder where the Trimble files were saved. 

H:\OPR-XXXX-FA\Surveys\H#####\CARIS\Preprocess\Trimble\Export\TRX_DDD 
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6. Open the desired .shp file.  Check to make sure that the parser template is correct and 
that fields in the Import window are being filled properly.  This insures proper processing. 

7. From the File menu, select Process file(s) and open the shape file used in Step 6.   
8. When importing DPs, Pydro will ask for an associated CARIS project.  Point to the 

H##### folder within the HDCS Data folder for the project.  When the PSS is saved, a 
new line will be written to the HDCS folder. 

9. Repeat Steps 6 & 7 for all new .shp files. 
10. Fill in the Pydro Feature Log for each file inserted.  The template is located in: 

R:\Utilities\II_Forms_Lists_and_Templates\2_Acquisition and Processing\Shoreline.   
11. A copy of the file, named H#####_Pydro_Feature_Log.xls should be saved in: 

H:\OPR-XXXX-FA\Surveys\H#####\Descriptive_Report\Separates\I_Logs\Detached_Positions 
12. When all features have been imported, close the Import window and save the PSS.  The 

field unit used to acquire the DP’s should appear as a vessel in the associated HIPS 
project HDCS folder. 

 
1.2 Create Parser Templates 
If there are feature types to be inserted which to do not have an existing parser template, it is 
possible to create one.  If a template already exists, skip this step. 
1. From the Pydro Data menu, select Insert > Generic GPs/DPs. 
2. In the pop up window, go the the File menu and select Open. 
3. Browse to the shape file of the feature to be inserted and click Open. 
4. On the left side of the Import window, check the boxes of all rows to be populated. 
5. On the right side of the Import window, use the drop down menus to fill in the attribute to 

be associated with each Data Type. 
6. Once the attribute is set, the Field Delimiter and Field Num columns will automatically be 

filled with the appropriate values. 
7. The Field Num column can also be filled in manually, which is desireable when two 

separate data dictionary attributes (e.g. RECDAT and Time) must be used to fill in the 
Pydro Data Type (e.g. Time). 

8. Use the window at the bottom of the Import window that lists all attributes to find the 
desired entries. 

9. Determine the filed numbers of the desired attributes, counting the blank before the first 
semicolon as one. 

10. Check the S-57 Data box at the bottom of the window and choose the appropriate 
acronym for the features from the drop down menu. 

11. Check the Point, Lines, Polygons box. 
12. Check the appropriate box to Insert as:  GPs, DPs, Chart GPs, or Checkpoints. 
 

 
 
13. Most features are classified as DPs.  Check with the CST if there is a question. 
14. From the File menu, select Save Template. 
15. Give the template a name identifying the type of feature it is to be used for and save it in 

R:\Utilities\III_Pydro\Parser Templates. 
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2.0 Process Features 
  

2.1 Apply Correctors in CARIS HIPS 
1. Open CARIS HIPS. 
2. From File > Open, browse to the project folder and open the DPs.  The vessel name will 

begin with TRB1 or TRB2 for the Trimble units used during acquisition. 
3. Apply observed tides to all items.  If the observed tide file is not yet available, predicted 

tides can be applied.  Observed or verified tides must be applied before submission. 
4. Skip this step if no echosounder was used for DPs.  Apply SVP correctors to any 

echosounder DPs.  If necessary, use a nearby cast taken during hydrography. 
5. Merge all data and update the Pydro Feature Log.  Depth values will automatically 

update in Pydro. 
 

2.2 Review Features 
1. Compare the items inserted in Pydro with the HXXXXX_Pydro_Feature_Log.xls.  The log 

should be completely filled out and up to date. 
2. Check the comments in the Remarks tab for each feature against the DP forms and boat 

sheet.  Edit and clarify if necessary. 
3. If depth values show a value followed by a question mark, remerge the features in CARIS 

HIPS. 
 
2.3 S57 Attribution 
1. Under the Details tab for a feature, click the S57 button to open the S57 Editor. 
2. A window will open with the information for the selected item. 
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3. Check that the Object Instances displays the correct object type (e.g.  UWTROC, 

$CSYMB, etc). 
4. Left click on the appropriate object type in the Object Classes box to select it.  There 

should be a check mark in the box next to the object type. 
5. Information will appear in the Mandatory Attributes tab.  Fill in the appropriate 

information, in Mandatory and Additional Attributes. 
6. Select the appropriate CartoAction.  Refer to CartoAction_Flagging.doc for guidance. 
7. Click Apply. 
8. Repeat this process for all features in the PSS. 

 
2.4 Add Images 
1. Photos taken in the field should be saved in one Photos folder, within the survey PSS 

folder.  Do not make separate folder for each day. 
2. To associate a photo with a DP, select the feature and click on the Cur Feature tab below 

the chart. 
3. Right-click in the blank space and choose Add Image(s).   
4. Navigate to the Photos folder, highlight the appropriate image(s), and select Open.  Once 

an image is displayed under the Cur Feature tab, the paths of all images can be 
displayed under the Cur Path tab.   

 

 
 

5. Alternately, images can be added by having the Photos folder open and dragging and 
dropping the images into the Cur Feature window.   
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6. To toggle between images, right click in the image window with either the Cur Path or Cur 
Feature tab activated, and choose Next Image.   

7. To remove an image, right click and select Remove Image. 
8. To designate an image as the S-57 PICREP, choose the best photo representation of the 

feature, right click in the image and choose Set S57 PICREP. 
 
3.0 Sheet Manager Review 
 

3.1 Check for Completeness 
1. Clarify and update Remarks with notes and survey methods.  Add Recommendations as 

necessary. 
2. Add chart numbers anywhere the chart is referenced (e.g. CHD (17424) RK DSP). 
3. Add Light List numbers to ATONs 
4. Address and update AWOIS items using the Pydro Editor function. 
5. Make sure that the appropriate Carto Action, Add, Modify, Delete or None, is selected. 
6. Use the Pydro logic tree to edit flags.  Flags should be updated to Chart, Significant.  

Check the Report flag if an item needs to be addressed in the DR.  Refer to 
R:\FA_SOP\3_Processing\Pydro\Pydro Logic_SOP.doc   

7. Any item flagged as Report should have the surveying information in the Remarks tab. 
Necessary recommendations should be entered under the Recommendations tab.   
NOTE: Complete disprovals and changes to HW must be marked report and have a 
recommendation.  Other instances are at the Hydrographers discretion.  An item CAN be 
marked report and not have a recommendation.  This is useful in instances where 
additional information would be useful to the cartographer but a recommendation is not 
warranted. 

8. Check the DP Forms in the project binder.  Make sure they are completely filled out and 
match the information entered in Pydro. 
NOTE:  The distance and bearing entered in TerraSync as noted on the DP form will not 
appear in Pydro.  The position is automatically updated. 

9. Scan the finalized DP forms and save as a single PDF called HXXXXX_DPforms.pdf 
located in: H:\OPR_XXXX_FA\Surveys\H#####\Descriptive_Report\Separates\1_Logs\Detached_ 
Positions. 

10. Mark a feature as Resolved once everything has been checked and finalized. 
11. Generate a Shoreline report as described in: 

R:\Utilities\I_FA_SOP\4_Deliverables\Shoreline Report\Generating a Shoreline Report.doc 
 
3.2 Export XML Data 
Features will be imported to CARIS Notebook for further processing, so it is necessary to 
export the .xml data from Pydro. 
1. From the Data menu, select Export > XML Feature Data. 
2. Set the filter to export only Primary features, as well as CartoAction, Add. 
3. Click OK and save the file as H#####_Add_Pydro.xml in the PSS folder for the sheet. 
4. Repeat steps 1-3 for the remaining Carto Actions Modify, Delete and None.  Name the 

.xml files appropriately. 
NOTE:  It is not necessary to export an .xml file for a CartoAction for which there are no 
features.  In fact, an empty .xml file will crash Notebook, so know what is being exported. 

 



DRAFT CartoAction Flagging 
 

ADD, MODIFY, DELETE None, Designations 
 
 
 
ADD 
A new feature was identified during survey operations.  The hydrographer recommends adding 
the feature to the chart. 

• New features (hp or ext new reef or ldg, new rk, etc)  
• Bottom Samples  

 
 
 
MODIFY 
The feature was found to be positioned or portrayed (e.g.) incorrectly on the chart.   
The hydrographer recommends removing feature A and replacing it with feature B.   
(Positions of both old and new features must be indicated.)  
Or, The feature was found to be attributed incorrectly or insufficiently.  The feature now reflects 
the additional or corrected attribution. 

• DP’d for height  
• new pos chd or CFF rk  
• chd rk is ldg (reclassification) 
• visible wreck is clearly a submerged wreck 
• new ldg found, chd rk disproval 

(DP/GP on rk would be delete, the DP/GP on ldg would be modify) 
• *CFF rk is Lidar islet (choosing Lidar or chart over CFF is modify)  
• *ATON, significant differences in location/attribution from chart or CFF 

 
 
 
DELETE 
The feature was disproved using approved search methods and guidelines.  The hydrographer 
recommends removing it from the chart. 

• complete disprovals 
• anything that you don't want on there anymore (even if it is associated with a modify item) 

 
 
 
NONE (aka Retain) 
The feature was found during survey operations to be positioned correctly or was not 
investigated.  The hydrographer recommends retaining the feature as charted. 

• verified item without additional attribution, but not DP’d for height 
• *Lidar rk verified (still a question if Lidar can be consider a source or it’s considered new) 
• *ATON that serves it’s intended purpose 

 
 
 
 
 
 
* These definitions are questionable, need feedback on whether this is the best approach.  
Additional source, like LIDAR, adds confusion. 
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0.0 Document Scope 
This document is intended to guide sheet managers through shoreline processing in CARIS 
Notebook.  It should be used after the processing in Pydro has been completed.  Refer to the 
Pydro_Shoreline_Processing and Shoreline_Presurvey SOPs for further information. 
 
1.0 Import Pydro Features 
CARIS Notebook can read features directly from the Pydro .xml file, exported as described in the 
Pydro_Shoreline_Processing SOP.  If some features do not import, it is possible that they do not 
have the correct S57 attribution.  Check the attribution in Pydro and try re-exporting the .xml. 
 

1.1 Create Add, Modify, Delete, Retain Layers 
1. From the Tools menu in Notebook, select PYDRO Data Import. 
2. In the PYDRO data file name field of the pop-up window, browse to the location of the 

exported xml files.  There should be separate files for Add, Modify, Delete and possibly 
Retain. 

3. In the HOB data file name field, browse to the Notebook_Files folder for the sheet and 
create a new .hob file called H#####_Add_Pydro, etc. 

 

 
 

4. Click OK.  A new layer should appear in the Layers tab and the features should appear in 
the Display window of CARIS Notebook. 
NOTE:  Bottom samples will not appear unless the text is set to display. 

5. Repeat this process to create layers for all features exported from Pydro. 
 
2.0 Shoreline Updates and Notes 
  

2.1 Adding New Line Features 
If there are new line features found during field verification, it will be necessary to create a 
new edit layer for digitizing the features. 
1. Create a new layer named H#####_Add_Notebook.hob and save it to the 

Notebook_Files folder for the sheet. 
2. Digitize any new line features to this layer, such as fouls, ledges, shoaling or new high 

water lines which are not on the current chart, or in the source files.   
3. Use the boat sheet and DP forms for sizes and extents of new line features.  Buffer lines 

may also be helpful.  Refer to the Importing Shapefiles in Notebook SOP for buffer lines. 
4. Do not add new point features to this layer.  These should have DP’s associated with 

them and brought into the H#####_Add_Pydro layer using the Pydro Data Import 
described above. 

5. Use the remrks field to add comments to digitize features, such as, “NEW LDG.  USE DP 
22562 FOR SWM EXT.” 
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2.2 Modifying Source Features 
If there are features in any source layers that are identified during field verification that need 
modification, it will be necessary to create a new edit layer for them.  Prior to making any 
edits to the source layers make sure the you have an unedited version of the source files as a 
backup.  Remember to SAVE OFTEN! 
1. Create a new layer named H#####_Modify_Notebook.hob and save it to the 

Notebook_Files folder for the sheet. 
2. Move any source items into this layer that need modification either in position, height, or 

classification.  
3. Highlight the source layer and select the item to be moved.   
4. From the Tools menu, select Import Selection and import the feature into the 

H#####_Modify_Notebook.hob layer 
5. Check the Use Existing Identifiers button, accept all other defaults then click OK. 
6. Once the item is in the modify layer, SAVE, then delete it from the source layer.   
 
2.3 Removing Source Features 
If there are features in any source layers that are identified during field verification to be 
deleted, it will be necessary to create a new edit layer for them.  Once again, prior to making 
any edits to the source layers make sure the you have an unedited version of the source files 
as a backup. 
1. Create a new layer named H#####_Delete_Notebook.hob and save it to the 

Notebook_Files folder for the sheet. 
2. Move any source items into this layer that are to be deleted, such as rock disprovals.  
3. Highlight the source layer and select the item to be moved. 
4. From the Tools menu, select Import Selection and import the feature into the H#####_ 

Delete_Notebook.hob.   
5. Check the Use Existing Identifiers button, accept all other defaults then click OK. 
6. Once the item is in the delete layer, SAVE, then delete it from the source layer.   

 
2.4 Adding Field Notes 
Any notes made on the boat sheet in the field referencing source features will need to be 
added to the Notebook session. As a reminder, any charted item must have the chart number 
added in parathesis, i.e. CHD (17324) RK NTD. 
1. To add remarks to features, highlight the source layer containing the object. 
2. Select the feature to be commented.  The feature will appear in the Selection tab at the 

bottom of the screen. 
3. Scoll down to the remrks field in the Attributes tab and add any relevant notes from the 

boat sheet, such as CFF RK NTD. 
 

 
 
4. If a feature cannot be verified in the field, do not just leave the remrks field blank.  Add a 

note such as, “Unable to verify due to shoaling.” 
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5. Source features that could not be addressed in the field should be flagged with a Marker 
point for easy review by the cartographer. 

6. Everything in the source layers must have a remark for the deliverable product.  A good 
way to check that everything has been addressed is to choose a layer, then click on the 
“Select All” tool. Every feature in that layer will appear in the Selection tab.  Scroll through 
the features to make sure each has something in the remrks field. 
NOTE:  It is especially important to check line features such as COALNE or DEPCNT, as 
they may be segmented lines, where one part has a remark, but another section in the 
same area was skipped.  Check everything in every layer. 
 

2.5 Adding Pictures to Features 
Pictures are currently being added using a Marker point snapped to a feature.  This is useful 
for source features that do not have an associated DP.   
IMPORTANT NOTE:  In order for pictures to remain associated with features in the 
deliverable product, it is important that the file path remain the same.  Do not move the 
pictures when cleaning up folders for submission. 
1. Create a Marker layer for the desired source layer.  The Marker layer should be the 

active edit layer and the source layer should be the Snap/Grab target.  
2. Choose the New Point Feature tool and click OK in the first pop up window. 
3. Click the button in the Marker picture file value field. 

 

 
 

4. In the next pop up window, use the Files bar to browse to the picture to be added and 
open it.  The path should appear in the Files bar. 

5. Click the Add button.  The picture name should appear in the window. 
NOTE:  Multiple photos can be added to the same Marker point by repeating these steps. 
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6. When all desired pictures have been added, click OK in all the pop up windows. 
7. Hover the digitizing tool over the desired feature, hold down the “s” key to enable the 

snap function, then left click and release.  The Marker point with the pictures is now 
snapped to the feature. 

 
3.0 Final Review 
 

3.1 Review with BASE Surface 
1. CARIS HIPS fieldsheets can be opened directly into Notebook.  From the File menu, 

choose Open and browse to the folder containing the appropriate fieldsheet. 
2. Make sure that the Files of type: drop down menu is set for All Supported Formats. 
3. Select the appropriate BASE surface for review.  These are the files with .hns extension. 

NOTE:  Notebook tends to choke on the large amount of data in the BASE surface.  For 
faster refresh rates, it is recommended that a mid-range resolution BASE surface, such 
as the 5m BASE, be opened instead of the highest resolution. 
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4. Open all Notebook files necessary for review. 
5. Review shoreline remarks and features with BASE surfaces to make sure there are no 

conflicts (i.e. SWMB over CHD (17324) RK NTD). 
6. CARIS HIPS sessions, with contours and soundings can also be opened into Notebook 

following the same procedure.  This may be another useful reviewing tool. 
  

3.2 Finalizing 
1. Check that the H#####_Add_Notebook.hob, H#####_Modify_Notebook.hob and 

H#####_Delete_Notebook.hob  files are correctly attributed and complete. 
2. Make sure all notes, shoreline additions and edits have been entered from the boat sheet 

to the appropriate layer. 
3. Make sure all deliverable hob files are in the Notebook_Files folder and delete any 

outdated or extra layers. 
4. Save a session that includes all relevant files to the Notebook_Files folder for the sheet 

named H#####_Shoreline.  The session should not contain any charts or BASE surfaces. 
 



PYDRO 
 
• CFF rk vrd, DP’d for height, use CFF position (that is the remark in Pydro) 

1. In Notebook, move CFF rk to MODIFY_Ntbk layer, take attribution from 
UWTROC DP that was acquired in the field and add it to the CFF rk. 

2. In Pydro, change the DP from UWTROC to CSYMB, so that there aren’t 
two rk symbols for the item in Notebook.  At this point the DP is only 
useful for height info and is awaiting smooth tide application.  DP’s carto 
action should be MODIFY. 

 
• ATONs  

remark in Pydro should be based on Light list if possible and look something like: 
AIRPORT RUNWAY ROCK LIGHT, FL W 6s, LL#22687 
 
if static position taken, remark should refer to it, such as, see DR for HORCON 
position. 

 
Recommendations (and therefore must be marked report) in Pydro are required for: 

o Complete disprovals (NOT rk is ldg) 
o Changes to MHW 
o Anything the Hydrographer decides may need a recommendation 

 
Report should be checked in Pydro for: 

o Anything that requires a recommendation  
o Anything that is ambiguous and requires further explanation  

(these can have but do not require a recommendation) 
 
• DTONs should be flagged designate to ensure they are referenced by the BASE 

surface after smooth tide application. 
 
• DTONs and other designated soundings should not be exported out to Notebook, filter 

appropriately using the deliverable treetemplates 
 
• check that all mandatory attributes are entered in Pydro 
 
Notebook 
 
• Ledges/Reefs should be SBDARE to easily distinguish them from DPTCNT 0 for LW. 

(Ldg -> sbd area rk) 
 
• WEDKLP - eelgrass attributed as CATWED 3 (sea grass) with eelgrass ntd or vrd in 

remark 
 
• Attribute Foul area OBSTRN w/CATOBS - foul area 
 
• Remarks in Edited CFF Shoreline.hob file or other source file should be 
  CFF rk ntd 
 
  rk.awash 



where the top remark is Hydrographers and the bottom remark is from the source file 
and there are two carriage returns between the comments. 

 
• If item is moved to HXXXXX_Delete_Notebook and it is associated with a DP, add see 

DP# to the HXXXXX_Delete_Notebook item’s remark. 
 
 
• CFF rk vrd, DP’d for height, use CFF position (that is the remark in Pydro) 

1. In Notebook, move CFF rk to MODIFY_Ntbk layer, take attribution from 
DP that was acquired in field and add it to the CFF rk. 

2. In Pydro, change the DP from UWTROC to CSYMB, so that there aren’t 
two rk symbols for the item in Notebook.  At this point the DP is only 
useful for height info and is awaiting smooth tide application. 

 
• Unable to verify  

In Notebook, items need to have marker text pointing to them with remark such 
as, unable to verify rk due shoaling. 
 

• Markers should be in marker layer. 
 
• Add picture in Marker not as PICREP 
 
• If the layer is empty, remove or do not create, ie if you don’t have any Add Notebook 

items you don’t need an HXXXXX_Add_Notebook.hob 
 
• At this time, do not digitize areas if possible, they do not display correctly, ie OBSTRN 

areas. 
 
• You should have _Pydro draw on top of _Ntbk 
 
• When digitizing ledges, MLLW, etc. cross over the MHW line (ie overshoot) 
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1 FAIRWEATHER Operational Survey Speeds 
1.0 COMMENT 
High quality hydrographic data collection is the reason FAIRWEATHER exists.  The 
following speed guidelines have been determined through a noise analysis conducted 
onboard the NOAA Ship FAIRWEATHER on October 10-11, 2004.  Pls see the reports 
SeaBat 8111 Noise Analysis and SeaBat 8160 Noise Analysis for additional details. 
 
From these reports, it is generally desirable to use lower shaft RPM, combined with a 
higher pitch setting to minimize the noise level seen by the sonar systems.  Significantly 
increased levels of reverberation from acoustic sources on the vessel are seen in 
shallower water. 
 
In order to reduce emanated noise from the ship, the following RPM/Pitch combinations 
shall be followed. 
  

1.1 REASON SeaBat 8111ER 
Based on the referenced report, it appears that the best survey speed for the 8111ER 
system, from a noise perspective, is the range of 8 to 10 kts.  Both lower and higher 
speeds correlate with higher noise levels.   
 

10 kts – Any combination of RPM and Pitch with RPM not to exceed 160 RPM 
8 kts – Any combination of RPM and Pitch with RPM not to exceed 140 RPM 
6 kts or below – Any combination of RPM and Pitch with RPM not to exceed 130 

1.2 RESON SeaBat 8160 
Based on the referenced report, it appears that the best survey speed for the 8160 system, 
from a noise perspective, is at 10 kts.  Both lower and higher speeds correlate with higher 
noise levels.   
 

10 kts – Any combination of RPM and Pitch with RPM not to exceed 160 RPM 
8 kts – 130 RPM with required pitch setting 
6 kts or below – RPM not to exceed 130 and required pitch 
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0.0 Document Scope 
 

This is a step by step guide to acquiring RESON data. 
                                                  
1.0 Start-up Procedure      
 

1.1 Turn on ISIS computer.                                
                                                                  
1.2 Make Day Number Folder on the Isis machine under appropriate project 

and sheet in Windows Explorer. It is also helpful to have this folder open 
and visible in Windows Explorer somewhere on screen to make sure that 
the lines are being recorded and saved correctly. 

 
1.3 Launch Isis Sonar from the desktop.  An empty shell will come up. 
 
1.4  Turn on RESON machine. 
 
1.5 On the upper left hand corner of the ISIS screen, hit “REC” (RECORD).  

 
 

1.6 Three important image screens will come up in the Isis Main Window: 
 

   3-D Screen     2-D Screen 

 
            Vertical Waterfall/Sidescan 
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The Isis Seabat 81xx Server menu will come up that will allow you to change the 
settings that affect these three ISIS image screens as well as the RESON  screen—i.e. 
general data quality of the sonar itself.   
               
           Isis Screen                                       Reson Screen 

     
 
 
 
2.0 Isis Seabat 81xx Server 

 
2.1 ON-LINE 

 
This box should be checked all the time except to playback lines 
(See the Acquisition Tools section on page 12 for this procedure). 

 
2.2      Tx Power  

 
This controls how much power is going to the sonar.  The power 
settings for the 8101 ranges from OFF to FULL with 1 to 7 in 
between.  The power setting should be set as low as possible 

BITE

       Range:    250m 
  MaxRate:    16.0 Hz 
  TxPower:     4 
    TxPulse:    117 us 
    RxGain:    4                 

GainMode:    TVG 
 AutoGain:     3 
       Menu:    Main 

RESON 
SeaBat 8101-150 

17:26:22  04-JUN-2003 
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without getting too many flyers.  When the power is set too high, 
often there will be a glow or a halo around each ping (this can be a 
result of other settings being too high also), as well as flyers.  Do 
what you can to prevent this from happening.  

 
2.3      Gain Type  

 
Gain type should always be TVG (Time Varied Gain). 

 
Auto Gain – Auto Gain is an automatic gain function that can be 
used instead of Rx Gain, which is where the gain can be set 
manually.  The setting for this ranges from Auto 1 to Auto 10.  This 
will analyze the bottom return to increase or decrease the receiver 
gain.  Auto 2 through 4 are the typical settings for acquisition.  
Again, try and set this as low as possible to prevent possible flyers 
and the “power glow” that will be seen if any setting is too high.  To 
run the gain manually, hit “Off” on the drop down menu. 

 
Rx Gain – Gain is the “ears” of the sonar.  The Gain function 
controls the amount of receiver gain to be applied to the returned 
sonar signal.  If you are using manual Gain mode, keep the number 
as low as possible, ranging from about 4 to 12 for best results. 

 
2.4      Range  

 
The Range setting determines ping rate and how far down the  
sonar will “see”.  The 8101 minimum range is 0 (though the setting 
will never be seen so low) and maximum is 400. This will be the 
setting that will most likely be changed the most because it is so 
closely linked with water depth.  The 8111 minimum range is 5 and 
maximum is 1400. The 8160 minimum range is 5 and the maximum 
is 5000. The Range should be kept above or even with the widest 
part of the wedge on the RESON computer screen, as in the first 
illustration below.  
 
 

 
1                                      2                                        3 
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Good                            Too Low                                Bad 
Outer Beams are Lost 

 
 

2.5      Max Ping Rate   
 

This will be already be set 20.0 Hz for the 8101.  For the 8111 it is 
set at 20.0 Hz. For the 8160 it is set to 15.0 Hz. The only reason to 
change these values is if the vessel is in shallow water and moving 
very slowly and you wish to reduce superfluous data.   These 
values should never be changed without approval of the FOO. 

 
2.6      Tx Pulse Width  
 

Pulse Widths on the 8101 ranges from 21µs to 225 µs, but keep 
these numbers within 70µs to 120µs for best results during 
acquisition.  On the 8111 this value ranges from 50 µs to 670 µs, 
the recommended/minimum value for the 8111 is 225 µs.  Donot go 
below 225 µs, nothing is gained by going lower.  On the 8160 this 
value ranges from 0.2 ms to 10 ms.  For the 8160 the pulse width is 
range dependent. At 750m, the minimum is 150 micro sec, at 
1000m  the minimum 300 micro sec, and at 1750 the minimum is 1 
milli sec (the minimum is listed here, pulse width can be set higher 
but resolution decreases).  The smaller the number, the narrower 
the pulse width.  A narrow pulse width means higher resolution 
while cutting back on range capabilities; likewise a larger pulse 
width lowers the resolution while increasing the range (better outer 
beam response.  Therefore, in sloping areas, increasing the pulse 
width will increase how much slope the Reson can acquire.   

 
2.7       Filter  

 
There are two types of filters that can be used during acquisition: 
The “Auto Depth Filter from Isis Attitude” and the Filter based on 
“Depth”, “Range”, or “Both” for depth and range together.   

 
2.7.1 Auto Depth Filter  
 
Percentage ranging from 1% to 100%.  This filter is most helpful in 
sloping areas, i.e. the steeper the slope, the better the sonar will 
pick it up when the percentage is set high.  However, a high 
percentage on a flat area will create flyers, so keep the percentage 
low in these cases.   
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2.7.2 Filter based on Depth or Range  
 
Auto Depth Filter must be unchecked.  To select between Depth, 
Range, or Both, simply click on the drop down menu to highlight 
your choice.  For multibeam, utilize only the Depth option.  Under 
Min (m); and Max (m); set depth values appropriate to the depth of 
water that you are working in, keeping in mind that any depths 
outside of this minimum and maximum will not be acquired.   
 
2.7.3 No Filter 
 
It is also possible to run with no filter by selecting “None” in the drop 
down menu. 

 
2.8      Apply All  
 

This button is inessential because every change made in the 
Seabat Server is immediately applied.  Another reason it is not 
recommended to use this is it can cause the system to crash. 

 
2.9    More Options 

 
These are mainly configuration options. It is important to know 
where they are found, however these options should not be 
changed without FOO or CST approval. 
 

 
 
 

 
3.0 Reson Display Screens 

 
The Main Sonar Display Screen, which is used for acquisition, is shown below. 
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                                                                                               Sonar ping 
 
                                                         20 
                                                                                                                                                                 
 
                                                          
                                                                                                     40 
 
 
                                                         60 
                                                          
 
                                                         80 
 
                                   
 
 
 
                                            -14.54    -23.57      81.63    
                                               X             Z             R 
 
 
 
 
 
 
Date and Time                   Cursor X, Z, R, Position              Operation Menu 
 

 3.1 Cursor Position  
 

 When the cursor is within the wedge, its position is  
 displayed.  X = Across Track, Z = Depth, R = Range. 
 
3.2 Operation Menu  
 

There are four different menus, Main, Ocean, Filters, and Display. 
There is also the Menu Off option. To change between menus, 
simply click on Menu to scroll to the menu you need. 

 
 

BITE 

       Spread:   30 
Absorption:   110 
     Velocity:   1480 
         Menu:   Ocean 

RESON 
SeaBat  8101-150 

20:26:48   21-JUN-2003 
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3.2.1 Main Menu  
 
The Main Menu shares the same information that is found in 
the top half of the Isis Seabat Server: Range, Max (Ping) 
Rate, Tx Power, Tx Pulse (Width), Rx Gain, Gain Mode, and 
Auto Gain.  These numbers should mirror the numbers in the 
Isis Seabat Server.  If for some reason this is not the case, 
and changing settings in Isis has no effect on the sonar, the 
settings in the Main Menu can be changed by using the 
three-button trackball.  The three buttons function as so: Left 
button—down, Right button—up, Middle button—speeds up 
the direction when held with the right or left button. 

 
 

3.2.2 Ocean Menu  
 
There are three options: Spread, Absorb, and Velocity.  
Spread and Absorption are linked together, where the 
numbers represent the amount of spreading and absorption 
loss that can be expected. These values will factor into the 
TVG, which in turn affect the return signal.  For the 8101, 
keep these numbers at 30 and 70 in salt water and 30 and 
20 for fresh water for the spread and absorption respectively.   
For the 8111, keep these numbers at 30 and 30 for salt 
water and 30 and 5 for fresh water.for the 8160 keep these 
numbers at 30 and 13 for salt water and 30 and 2 for fresh 
water.  Velocity is the speed of sound for the area.  This only 
applies for the 8160 which receives surface sound velocity 
via the SBE 45 TSG.  This value should roughly correspond 
to the sound velocity seen during the last CTD cast. If it 
differs greatly then you should consider taking a new cast. 
  

 
System Spread Absorb 

(sea) 
Absorb 
(fresh) 

8101 30 70 20 
8111 30 30 5 
8160 30 13 2 

  
 

3.2.3 Filters Menu 
 
Found in the bottom half of the Seabat Server, namely Filter, 
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Min Range, Max Range, Min Depth, Max Depth, and Head 
Tilt.  Head Tilt has to do with if the transducer had been 
mounted with a roll offset, which does not apply to our 
Reson transducers. 

  
3.2.4 Display Menu  

 
Color, Contrast, Dots, Grid, and Freeze. This menu has to 
do with how objects on the Reson screen are being 
displayed.  These options do not need to be changed. 

 
3.3 BITE Menu  

By clicking on “BITE” in the upper left-hand corner, the Built-In Test 
Environment (BITE) Screen opens up.  This  menu is available for 
viewing diagnostic and configuration  information—like some of the 
information found in More  Options of the Isis Seabat Server.  The color of 
the BITE  button shows if the Reson system is operational or not: 
 GREEN = System is operational;  

YYEELLLLOOWW = System is operational but some areas are not working 
properly or are out of sync;  
RED = System is not operational—there is a malfunction 
somewhere. Inside the BITE menu, the text will also be in one of 
three different colors depending on the status of each particular 
setting.  The color code is same as above except that text will also 
be WHITE to show that the system is operating OK 
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The BITE Menu Screen looks something like this below: 
 
                                       BUILT- IN TEST 
 
Wet-End Status            Commuication 
          Leak: +5.0V           Uplink: Good 
HeadTemp: +18.4°C   Downlink: Good 
            -5V: -4.8V          Internal: Good 
         +12V: +12.0V     Ethernet: 00E0CB030498 
          -12V: -12.0V           Local: 192.168.195.101 
 DipSwitch:  50               Remote: 192.168.195.102 
                                        Gateway: 192.168.1.1 
Firmware Version            Subnet: 255.255.255.0 
    Dry: 8101-2.09-E34D 
    Wet: 8101-1.08-C215   Sensor Inputs 
                                              Pitch: 
                                                Roll: 
                                             Heave: 
                                          Velocity:      Uplink: 
                                       UTC Date:      Format: 
                                      UTC Time:              Sidescan: 
                                                                      TestPtrn: 
             Receiver Gain Offsets:                        Output: 
+3db                                                              ProfilBd:  
+0db                                                              TimeBd: 
 
- 3db                                                              ContrlBd: 
                                                                    MotionBd: 
            Receiver Phase Offsets:              VeloctyBd: 
 +45°                                                                                                        UDP Base: 
  +0°                                                               Oriented: 
  
- 45°                                   HeadSync: 
                                                                                                                     Projectr: 
                                                                                                                      MENU: 
Config 
 
 
In the upper right hand corner, the BITE menu displays the sonar data wedge, so that it 
can still be viewed while in this menu. 
 
 

BITE CALIB RESET 
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3.4 Sensor Inputs   

Here are where the numbers are found for Heave, Pitch, and Roll for 
the Reson system. Next go to Window\Graph\Pitch, Roll, Heave  

 
 
The window that pops up will only show Pitch values.  In order to view Roll and Heave 
as well, right click inside the graph box and under “Which Motion to Display?” check 
each of the boxes for the other sensors. 
 

3.4.1 Good motion sensor data will look like this 
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3.4.2 Parameter Display  
Sensor data for heading in the parameter display is not correct (raw navigation 
packet is usually selected during processing- which comes from the posmv)   
   .   

 
 
 

   
 

3.4.3 ISIS Shutdown 
 
 If any or all of these sensors values are not changing or flat-lining in  
 the Pitch, Roll, and Heave Motion Window, the ISIS computer   
 must be shut down—DO NOT RESTART, SHUT DOWN.  After,   
 beginning again with the start-up procedure; make sure that the   
 RESON has been turned off before the Isis is brought up again.  
  

A possible reason for this communication error is if the Isis computer was never 
shut down.  Check to see if the Isis computer is on upon first getting in the 
launch.  If it is, log in and shut down.   

 
  3.4.4 Altitude 
 

Another value to monitor is the Altitude.  It is found in the Parameter Display 
under Sensor Data. To see it displayed larger, simply click left of the Alt button:  

 
                                                                              This is what will pop up: 
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0.0 Document Scope 
 
The scope of this document covers setting up and acquiring multibeam data 
using TEI Isis and TEI DelphMap/DelphNav/RT Bathy Programs.  
 
1.0 RT Bathy Set Up 
 
Currently you need a very high end computer to record multibeam data and have 
RT Bathy in operation.  On the FA we are using dual 2.8 GHz processors with at 
least 1 GB of RAM and a Seagate Cheetah Ultra SCSI hard drive.  You will also 
need two high end video cards to display all the information on 3 screens.   
 
2.0 Setup 
 

2.1 Isis Sonar 
1. Open Isis 
2. Tools→Realtime BathyPro Map→Multibeam Bathymetry 

 
2.2 BathyPro Real Time 

1. Open Project (HXXXXX.dmp) in DelphMap from C:\Project\OPR-
XXXX-FA-XX\HXXXXX\RT_Bathy\. If you do not have DelphMap 
open, BathyPro will open it for you.   

2. Set the DTM File settings. Under Encoding Type choose 
“Average”.  Save the DTM to the correct folder. 

3. Set the Map Projection and Settings.  You must uncheck the Set 
Default Limit Box. 
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4. Under Boundaries in the Map Projection and Settings menu, 
enter a bounding box for the area you wish to create the DTM for.  
Use a reasonable resolution for the DTM size (i.e. don’t use 1m 
resolution for a 10,000m x 10,000m box). 

5. Enter the North-West corner of the bounding box for the area you 
wish to create the DTM for. 

6. The input projection is Not Projected (Lat/Long) (using NAD83 as 
datum) 

7. The output projection is UTM with the correct zone (using NAD83 
as datum)  

8. Click on START 
9. The box next to START should switch to “Waiting…” 
10. Turn off the “Fill Gaps filter”, so holidays will be visible. 
 

2.3 DelphMap 
1. Right click on Background 
2. Import a Background Image 
3. Browse to the folder where the coverage map is located and select 

it. 
4. Click on “Change...” to change the projection of the chart.  It should 

be in UTM with the correct zone number (using NAD83 as the 
datum). 
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3.0 Recording data 

1. Click on Switch button 
2. Click on Record data to File Name radio button and browse to 

correct storage location 
3. When ready to start recording, click on the Switch Now! button. 

This will start logging data. 
4. When getting close to end of line click on the Display Only radio 

button 
5. When ready to stop logging, click on the Switch Now! button. This 

will end data logging. 
 

 
Figure 1. RT Bathy Window 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
Figure 2. Setting grid type and location 

 
 

 
Figure 3. Setting Bounding box and grid 

projection 

Will switch to Waiting.... 
when you click START 
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4.0 BathyPro Real Time Display 
 

4.1 Real Time Bathy 
1. The box next to START should be counting up.  The number should 

correlate to the ping number in the Isis parameter display.  If the 
box says “Outside”, then Isis thinks your bounding box coordinates 
are off.  Double check to make sure that they are correct. 

4.2 DelphMap 
1. Click on the center Plug in the upper left hand in the Survey Control 

Panel Window to display boat navigation. 
2. Click on arrows to bring up Left/Right indicator  
 
Boat Shape 

1. Click on the far upper left hand plug in the Survey Control 
Panel Window to bring up the Serial Port data acquisition 
settings. 

2. Select the Com 05 tab (for ship Com 06). 
3. Select the Shape tab and then the modify button to change 

the length and width of the boat display. 
 
 
 
 
 

 
Figure 4. Click on Switch to open recording 

dialog 

 
Figure 5. Switch File Dialog 
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5.0 Issues/Things to watch for  
1. The Isis parameter display must display Lat/Long in Decimal 

Degrees (i.e. 34.9827271 -120.12891717) for navigation to display 
correctly. 

2. Telemetry output must be on Form 2.  Nicole Stagner (TEI Rep) 
thinks that Form 1 may not know how to correctly output at 1 Hz.  
Problems seem to arise. 

3. The POS/MV Controller software must be started after you hit the 
record button in Isis.  If this is not done, the POS/MV controller 
software will take control of the socket and Isis will not receive any 
navigation data. 



Fixing Data with Incorrect Date on Time Stamp 
Written by SST Froelich 

 
 
Problem: 
  
An error can occur due to unknown reasons during acquisition when data is 
logged through and past midnight.  The error places the wrong day in the time 
stamp for the Raw Nav and Attitude packets.  These packets have the correct 
time, but the date is incorrect.  All other packets (Bathymetry, Side Scan, 
Snippets) have the correct date on the time stamp.  Jack Riley was contacted for 
help and he provided a Pydro macro that creates a copy of the file and then 
changes the date in the Raw Navigation packet to whatever date is specified by 
the user.   
 
Procedure: 
 

1) The SetXTFRawNavYMD.py macro sent from Jack Riley is located under 
python23\Pydro\Macros folder 

2) Run Pydro and run SetXTFRawNavYMD.py macro from Misc. menu 
3) Entered the correct date for the line(s) (ex. 2005-05-17)  
4) Copy lines with adjusted dates which are automatically named  

DDD-HHMM_dt.xtf (ex. 137-1754_dt.xtf) 
5) HDCS data with the bad dates is not retained (XTF was retained) 
6) The new lines (DDD-HHMM_dt.xtf) are converted as usual 

 
Figure 1. Conversion Settings 

 
 
 



Discussion: 
 
The Raw Navigation date was changed to the correct day, but the Attitude date 
was not changed. This is not a problem because attitude information is 
converted from the Raw Navigation packet. No change needs to be made to 
conversion process therefore.  Upon conversion, CARIS HIPS reads navigation 
(speed, CMG and distance), attitude (heave, pitch and roll) and gyro from the 
Raw Navigation packet (now with the correct date and time) (see figure 1). 
 

Sensor Packet read from Correct date in packet?
Speed Raw Navigation Yes, after macro applied 
CMG Raw Navigation Yes, after macro applied 
Distance Raw Navigation Yes, after macro applied 
Heave Raw Navigation Yes, after macro applied 
Pitch Raw Navigation Yes, after macro applied 
Roll Raw Navigation Yes, after macro applied 
Bathy Gyro Raw Navigation Yes, after macro applied 
Bathy Bathy Yes 
SSS SSS Yes 
Snippets Snippets Yes 
SSS Navigation SSS Sensor Yes 
SSS Gyro Attitude No* 

Table 1. Summary of Sensor Data 

* Because it appears the Side Scan is getting the date and time stamp from the 
Side Scan Sensor packet, which has the correct date, and is just taking the 
gyro field from the attitude packet (with no date value from the attitude 
packet, just a time value and a gyro value) the Side Scan gyro matches the 
Bathy gyro for a given time stamp (see figures 2 & 3).   
 

  
Figure 2. Bathy Date/Time & Gyro 

 
Figure 3. SSS Date/Time & Gyro 



Hydrographic Survey Quality Control Checklist
Survey: Project: Survey PIC:

Bold underlines require a date and initials of when item was completed.
Refer to Survey Management SOP for detailed instructions to complete these steps.

Post Acquisition - review of data
Quality Control of survey area in subset prior to departure from field (SV, Tide, Holidays, Noise) 

BASE surfaces reviewed
Survey area reviewed in subset mode
Review Acquisition and Processing logs for issues/problem data

Check for immediate DTONs
Immediate DTONs submitted

Document special circumstances/problems and HVF changes/deviations from DAPR as occurred for DR
Issues listed in HXXXXX_Survey_Log.doc
Issues explained in DR

Shoreline Data Review
Pydro

DPs/GPs & Bottom Samples reviewed/flagged/S57 attributed/Add, Modify, Delete Selected
Pictures labeled correctly, in one folder, & inserted
AWOIS.mdb inserted
Tide and SVP correctors applied where necessary

CARIS Notebook
All Pydro features imported
Features reviewed with DP forms and boat sheet
All items addressed (all data including CFF, Chart, Lidar, and new items)
AWOIS investigations complete

Coast Pilot review & write up with edits completed 

Smooth Tides Request (*.mif/mid and times of Hydro)
Produced, Submitted, Archived [Digital-copy (letter, times, & mif/mid) in Appendix VI Smooth Tide Req fldr]

Survey Outline
Produced, Submitted, & Archived (digital-copy in Appendix I Survey Outline folder)

Additional (Observed, Verified or Smooth) Tides applied
Tide file reviewed & checked for gaps/flyers (txt in Notepad, .tid in Caris Tide Editor)
Applied to lines
Applied to DPs
Data re-merged in CARIS after tides have been re-applied. 

Verify Sound Velocity files
SVP files compared in digital acquisition logs vs. I drive – all should match
Each cast profile reviewed individually in CARIS 
SV cast positions displayed in CARIS (check for gross error)
SV cast list produced (digital copy in Separates III SV Profile List folder)
SV acquisition/processing deviations from the DAPR are noted in the DR.

Data queried in CARIS (compare to digital acquisition logs)
Query all lines in CARIS 

Save query to H#####_Data_Query log
Compare query to SVP file in HDCS line directory (random sample)
Tide and SVP files applied are correct and most current (observed or verified)                

Problems/discrepancies investigated
Vessel speeds queried in CARIS and reviewed

Vessel speeds meet object detection requirements for relevant depths

Logs reviewed
SV method documented
If true heave not able to be applied, noted in logs and discussed in DR

HXXXXX OPR-XXX-FA



Post Survey - post spatial (subset) review of data

Quality Control of cleaning performed by others and general QC of survey area
All lines re-inserted into HXXXXX_QC session, for BASE/subset review (not DP lines)
Complete Subset Review (include looking at rejected and BASE child layers)

Subset tiles created for review process
Review all examined soundings (to designate, mark outstanding, or reaccept)
Data checked for systematic errors (Std deviation child layer especially useful) 
Data issues discussed in DR if present

Designate soundings in areas where surface does not accurately represent the bottom 
# of Designated Soundings

Depth checking for flyers (CARIS Field Sheet Editor)
BASE Surfaces reviewed
Contours & Soundings generated (CARIS Field Sheet Editor) 

Chart comparisons completed and documented in DR
Local Notice to Mariners checked for recent updates
Chart edition & date corrected through included in DR

DTONs (Dangers to Navigation) 
Select DTONs (marked outstanding in CARIS and inserted as CARIS Line Feature)
Notify that they are ready for review 
Pydro session updated/.xml produced 
Once actual DTONs chosen they should be marked Designated in Pydro or CARIS
Submittal email/DTON Report archived (digital copies in PSS folder)

CARIS Fieldsheets & Sessions review and submission ready
HXXXXX_QC Fieldsheet & Session contains soundings, contours & Finalized surfaces for review

Depth Threshold BASE surfaces finalized to produce critical soundings
Use Finalized (clipped by depth range) surfaces to assess if coverage requirements were met

Non-Finalized BASE Surfaces produced (in HXXXXX Fieldsheet & Session)
BASE surfaces include Depth Threshold ranges and resolutions

Pydro
PSS data IS NOT Stale or Outdated
All features resolved
DP forms match PSS & scanned into DP Log folder
Correct Vessels were selected for all data
Correctors were applied properly
Remarks/Recommendations completed in Pydro
AWOIS items finalized
Features Report produced and archived (digital copy in folder)

Descriptive Report completed
Cross-line (SWMB) comparisons completed and documented in DR

Required quantity of XLs met.  If not, addressed in DR.
Junction comparisons completed and documented in DR
Prior surveys were reviewed because of special issues 

Did the issues require an explanation in the DR
Special circumstances/problems/issues/HVF changes/deviations from DAPR documented in DR

Does the data meet specifications?  Discuss in DR.
Shoreline Processes described in DR
Cover & Title sheets produced (digital copy in folder)
Appropriate Appendices completed and included with digital data
Separates completed and included with digital data



Submission
Coverage requirements were met.

If not, addressed in DR.

Accuracy requirements were met.
If not, addressed in DR

Digital folders cleaned up
HXXXXX Fieldsheet folder contains only official Non-Finalized BASE Surfaces
Sessions & Fieldsheets open in CARIS and are not outdated
All .hob files are in the Notebook session, named properly, & are in the Field Products/Notebook folder
Extraneous files are removed from the Field Products folder

Content of all submission folders (CARIS, DR, Field Products, & PSS folders)
checked for completeness and suitability

Data checks
HVFs match current DAPR 

If not, addressed in DR.

The quality and completion of all tasks are the responsibility of the Sheet Manager (OIC) (meaning if someone 
else completed a task, the OIC has verified the accuracy).  

Standard field surveying and processing procedures were followed in conducting the above mentioned survey.

The digital data and supporting records have been fully reviewed and are considered complete and adequate for 
review and approval.

Sheet PIC Name Date

Reviews

Hydrographic Survey Quality Control Review Checklist completed
List name of reviewer

Date completed 

All data and DR submitted to Final Review for approval

Data and DR are approved
Descriptive Report & Appendices reviewed

Shoreline Report reviewed
Pydro/Notebook Sessions reviewed
Data reviewed in Fledermaus

Final Review Name Date



Survey: Project: Survey Reviewer:

Bold underlines require and date and initials when item is completed.

Logs reviewed
Digital Acquisition & Processing Logs
Pydro Feature Log
Survey Log

HXXXXX_Data_Query
DPES lines are SVP/Tide/Merged, DPNE lines are just Tide/Merged
DP GP BS Query reviewed
Final Session Query

Outside Review of Shoreline & Pydro session
All features resolved
Remarks/Recommendations make sense
AWOIS Items resolved sufficiently
Files in Notebook folder open in CARIS Notebook
Review Notebook shoreline files with Caris Map .des from BASE surface for survey 

Quality and flyer check of depths/surfaces (review in CARIS w/ HXXXXX_QC Session & Fieldsheets)
Subset (include looking at rejected) – just need to look at around 10% of area

Shoals and Navigationally Significant areas reviewed 
Contours & Depths checked
Designated soundings reviewed
Errors discussed in DR if present

DTONs (Dangers to Navigation)
Reviewed/Verified

Chart comparisons reviewed
Ensure chart edition and date corrected through included in DR

Coverage and accuracy requirements were met
If not, addressed in DR.

Descriptive Report reviewed
Special circumstances/problems/issues/HVF changes/deviations from SysCert/DAPR documented in DR

Were data requirements met?

Quality Control Checklist reviewed

Check that all lines are in HXXXXX_FINAL CARIS session
Session & Fieldsheet open correctly
HXXXXX_FINAL Fieldsheet folder contains official Depth Threshold BASE surfaces
Depth Threshold BASE surfaces open correctly and are not outdated

Hydrographic Survey Quality Control Review Checklist



OPR-A###-FA-##

HXXXXX Survey X

CARIS
Fieldsheets

HXXXXX  (Non-Finalized BASE Surfaces)
HXXXXX__0to35_0p8m Naming convention: HXXXXX_DepthRange_Resolution(m)

HXXXXX__25to70_2m
HXXXXX__60to170_5m
HXXXXX__150to300_12m
HXXXXX__280to550_22m
Critical Soundings

HXXXXX_QC (Working fieldsheet used throughout the survey for coverage and QC.)
(The following are examples of possible files)
Preliminary Finalized BASE Surfaces
Subset Tiles
Depths and Contours

HDCS_Data 
HXXXXX  (processed CARIS HDCS data)
VesselConfig  (only vessels that apply to this survey)
DeviceModel.xml  (DeviceModel used for processing this survey)

Preprocess
ISIS (raw XTF data and True Heave from ISIS)
SVP_raw (raw SV data from Velocwin)
Trimble (raw data from TerraSync & exported SHP files from GPS PathFinder)

Session
HXXXXX.hsf  (CARIS session)
HXXXXX_QC.hsf  (CARIS session)

SVP (processed CARIS SVP data files separated by vessel)
1010
1018
S220

Tide
Observed or Verified .tid and .zdf (Tide files applied to the data at the time of submission) 

DESCRIPTIVE REPORT
HXXXXX_Descriptive_Report.doc

Appendices
I.    Survey Feature Report

HXXXXX_Survey_Feature_Report.pdf  (report produced in Pydro)
II.   Survey Outline

HXXXXX_Survey_Outline.tab  (survey outline of hydrography)
III.  Smooth Tide Request

HXXXXX.pdf (Smooth Tides Request & Abstract Times of Hydro)
HXXXXX.mif/mid files

IV.  Supplemental Correspondence
HXXXXX_Correspondence.xxx (digital copies of emails, request & correspondence)

V.  Geographic Names
HXXXXX_Geographic_Names

Separates
I.   Logs

Acquisition & Processing
HXXXXX_1010_8101_Log.xls
HXXXXX_1010_8101_Log.xls
HXXXXX_S220_8111_Log.xls
HXXXXX_S220_8160_Log.xls

Detached Positions 
HXXXXX_Pydro_Feature_Log.xls
HXXXXX_DPForms.pdf (Scanned  DP forms)

Side Scan Contacts
N/A HXXXXX_Sidescan_Contact_List

Digital Data Submission Checklist

List all Non-Finalized BASE Surfaces - 
the number of surfaces submitted is 
dependent on the depth range of the 
data and the finest resolution the data 
can support.



FIELD PRODUCTS
Final Fieldsheet

Notebook Files
HXXXXX_Edited_CFF_Shoreline.hob
HXXXXX_Charted_Shoreline.hob
HXXXXX_Add.hob
HXXXXX_Modify.hob
HXXXXX_Delete.hob
HXXXXX_Add_Features.hob (hob file created from xml import)
HXXXXX_Modify_Features.hob (hob file created from xml import)
HXXXXX_Delete_Features.hob (hob file created from xml import)
HXXXXX_None_Features.hob (hob file created from xml import)
HXXXXX.hsf (Notebook session)

PR and Constituent Products
Include all products that were provided to constituents

PSS  (Pydro Preliminary Smooth Sheet)
HXXXXX.PSS
Photos (Non-SSS contact images associated with Pydro features, named w/unique identifier )

DTON
HXXXXX_DTON.xml  (XML of DTONs exported from Pydro)
HXXXXX_DTON_Report.pdf  (report produced in Pydro)
HXXXXX_DTON_email.txt (copy of submission email)

HXXXXX Contents
size
number of files
number of folders

Survey data included in transmittal list text file



Analog Data Submission checklist
HXXXXX Sheet X

Digital Data on Hard Drive (listed on Digital Data tab)

Shoreline boatsheets

DP Forms

Daily acquisition forms



Date: Name:

Total Mileage
0

Total Lines in Session  lines in HDCS_DATA folder
0  lines in PreProcess folder

Length Line TideLoaded Project Vessel Day TideFile SVPCorrecte SVPFile Merged Outdated TPE ComputeSpeed Heading SR Corrected TotalTime

Data Query (QC Review MBES Final Session)



Date: Filled out by:
Date: Reviewed by:

List of Acquired GP Files below Total # of Features in Pydro # of DP Files in HDCS_DATA folder
# of Primary in Pydro

# of Add Features in Pydro # of DP Files in PreProcess/Trimble/Export folder
# of Modify Features in Pydro # of GP Files in PreProcess/Trimble/Export folder
# of Delete Features in Pydro
# of None Features in Pydro Total # of Files in PreProcess/Trimble/Export folder

0 # of Digitized ChartGP & Bathy Files in Pydro
# of Secondary in Pydro*
# of Rejected in Pydro* 0 Preprocess + Digitized + Bathy
* Not exported to Ntbk

# of Position Files in Pydro
# of Add Features in Ntbk
# of Modify Features in Ntbk
# of Delete Features in Ntbk
# of None Features in Ntbk

0 Total # of Features in Ntbk

Total Acquired GP Files 0
Total DP Files in CARIS 0

0

CARIS Query
Line Project Vessel Day SVPCorre SVPFile TideLoade TideFile Merged Outdated

Data Query (Features)
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